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Notice 
OMRON products are manufactured for use according to proper procedures by a qualified operator and only for 
the purposes described in this manual. 

The following conventions are used to indicate and classify precautions in this manual. Always heed the 
information provided in them. Failure to heed precautions can result in injury to people or damage to the product. 

DANGER  Indicates an imminently hazardous situation which, if not avoided, will result in death 
or serious injury. Additionally, there may be severe property damage. 

WARNING  Indicates a potentially hazardous situation which, if not avoided, could result in death 
or serious injury. Additionally, there may be severe property damage. 

Caution Indicates a potentially hazardous situation which, if not avoided, may result in minor 
or moderate injury, or property damage. 

 

 

OMRON Product References 
All OMRON products are capitalised in this manual. The word “Unit” is also capitalised when it refers to an 
OMRON product, regardless of whether or not it appears in the proper name of the product. 

The abbreviation “PLC” means Programmable Logic Controller and is not used as an abbreviation for anything 
else. 
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Visual Aids 
The following headings appear in the left column of the manual to help you locate different types of information. 

Indicates information of particular interest for efficient and convenient operation of the product. 

1, 2, 3… Indicates lists of one sort or another, such as procedures, checklists etc. 

 
Represents a shortcut on the Toolbar to one of the options available on the menu of 
the same window. 

Other manual conventions are as follows: 

•  Windows-based applications provide users with a number of different ways to perform one operation. 
These are normally: from the application menu bar; using icons on a Toolbar; using keyboard shortcuts; 
using the right-mouse button to display a context-sensitive menu; dragging and dropping. Whilst 
recognising this, the manual provides user instructions employing the Toolbar and right-mouse button only. 
Use of the application menu bar or keyboard shortcuts are only included if no such alternatives exist. 

•  Access to the CX-Server middleware is normally via other software applications, such as CX-Programmer 
or CX-Protocol. This is noted in the manual by the term “invoking application”. 

•  This manual refers to two distinct types of project: CX-Server projects and application projects. A CX-
Server project is defined in this manual. An application project is defined by the software application 
invoking CX-Server. 

 OMRON, 2005 
All rights reserved. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in 
any form, or by any means, mechanical, electronic, photocopying, recording, or otherwise, without the prior 
written permission of OMRON. 

All copyright and trademarks acknowledged. 

No patent liability is assumed with respect to the use of the information contained herein. Moreover, because 
OMRON is constantly striving to improve its high-quality products, the information contained in this manual is 
subject to change without notice. Every precaution has been taken in the preparation of this manual. 
Nevertheless, OMRON assumes no responsibility for errors or omissions. Neither is any liability assumed for 
damages resulting from the use of the information contained in this publication. 
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About this Manual 
This manual describes the CX-Server application and its ability to control and monitor a range of OMRON 
PLCs. It does not provide detailed information concerning the PLCs themselves, for this information the 
commercial manual for the device must be consulted. 

This manual contains the following chapters: 

♦  Chapter 1 Technical Specification. This chapter describes CX-Server in general terms and introduces the 
user to the relationship between CX-Server and associated products. It also provides details of the 
operating environment, minimum configuration and installation procedures necessary for the satisfactory 
operation of CX-Server. 

♦  Chapter 2 PLC Memory Component. This chapter describes the PLC Memory Component and its ability 
to allow the user to view, edit and monitor PLC Data Areas, bits and symbols. 

♦  Chapter 3 IO Table Component. This chapter describes the IO Table Component and its ability to edit 
PLC IO Table and SIOU Settings on a PLC. 

♦  Chapter 4 PLC Setup Component. This chapter describes the PLC Setup Component and the procedures 
involved in the configuration of PLC settings. 

♦  Chapter 5 Data Trace/Time Chart Monitor Component. This chapter describes the Data Trace/Time 
Chart Monitor Component and the procedures involved when viewing Data Trace and Time Chart 
Monitoring information in either Histogram or Trend Graph mode. 

♦  Chapter 6 PLC Error Component. This chapter describes the PLC Error Component and the procedures 
involved in reading and clearing PLC CPU errors, error log entries and messages. 

♦  Chapter 7 Memory Card Component. This chapter describes the Memory Card Component and the 
procedures required to format, access and edit a PLCs memory card/compact flash and to transfer data 
between the computer or PLC and memory card/compact flash. 

♦  Chapter 8 CX-Net Network Configuration Tool. This chapter describes the procedures for establishing 
communications between PLCs across a network and ensuring that information is routed correctly to the 
target devices. 

♦  Chapter 9 PLC Clock Tool. This chapter describes the PLC Clock Tool and the procedures involved when 
adjusting the PLC clock. 

♦  Chapter 10 Data Links. This chapter describes how the Data Link Editor enables a PLC to be configured 
so that it can participate in one, or more automatic data sharing schemes, over SYSMAC LINK and 
Controller Link networks, without the need for special programming. 

♦  Chapter 11 Routing Tables. This chapter describes how Routing tables allow networked PLCs to be 
configured so that they can communicate with each other via gateways; across remote networks. 

♦  Appendix A Network Availability. The tables in this appendix indicate the network available to each PLC 
device group. FinsGateway has no network availability and is not described.  

♦  Appendix B PLC Memory Area. The tables in this appendix provide memory area details for each device 
group.  

♦  Appendix C Toolbars and Keyboard Shortcuts. The tables in this appendix summarize the toolbars and 
keyboard shortcuts available from each component tool.  

A Glossary of Terms and Index are also provided. 
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 CHAPTER 1 
Technical Specification 

This chapter describes the CX-Server PLC Tools software in general terms and introduces the user to the 
relationship between CX-Server PLC Tools and the associated products. It also provides details of the operating 
environment, minimum configuration and installation procedures necessary for the satisfactory operation of 
CX-Server PC Tools. 

CX-Server PLC Tools Software 
PLC Tools are a collection of utilities and programs that provide configuration and control for OMRON PLCs and 
Networks. 

CX-Server PLC Tools consists of the following components: 

♦  PLC Memory component. This component allows the user to view, edit and monitor either channels (words) 
or individual bits in areas of the PLC. 

♦  IO Table component. This component retrieves and configures PLC rack and address data. 
♦  PLC Setup component. This component retrieves and configures PLC setting data. 
♦  Data Trace/Time Chart Monitor component. This component records and displays data obtained from the 

PLC’s memory areas during program execution. 
♦  PLC Error component. This component displays and manages PLC errors. 
♦  Memory Card component. This component manages the file storage to and from PLC memory cards. 
♦  PLC-Clock component. This component configures and displays the PLC clock. 
♦  Routing Table component. This component manages the routing tables, which allow PLC internode 

communications. 
♦  DataLink Editor component. This component allows configuration and modification of the datalink tables, 

which allows data to be transferred between PLCs without any other programming. 
♦  CX-Net Network Configuration tool. This tool consists of a suite of programs allowing the management of 

Networks for OMRON PLCs. 
CX-Server runs within the Microsoft Windows environment (Microsoft Windows 95 or later, or Microsoft 
Windows NT 4.0 or later) on standard IBM and compatible Pentium-based desktop PCs. 

CX-Server PLC Tools utilities form part of other CX-Automation suite applications (CX-Programmer, 
CX-Server). 

CX-Server PLC Tools have a close relationship with CX-Server Runtime which is the communications middleware 
software for OMRON PLCs. For further information see CX-Server Runtime manual. 

About this Manual 
This User Manual acts as a reference for CX-Server PLC Tools by describing its various concepts and abilities, and 
provides the basics of using its dialogs and supplied utilities. 

Caution: This manual is referred to from other software applications that utilise CX-Server, for instance, 
CX-Programmer, CX-Protocol or SYSMAC-SCS.  Subsequently, some topics contained in this user manual 
may not be relevant. 

The CX-Server PLC Tools come with a context-sensitive online help system which is designed to complement this 
manual and to provide a quick reference at any point while using CX-Server PLC Tools when the manual is not to 
hand. This general help system uses a fast hypertext system which allows progressively detailed information about 
any topic to be obtained by selecting keywords within the descriptive text. 

Throughout this manual it is assumed that the reader has a working knowledge of Microsoft Windows, and knows 
how to: 

♦  use the keyboard and mouse; 
♦  select options from Microsoft Windows menus; 
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♦  operate dialog boxes; 
♦  locate, open and save data files; 
♦  edit, cut and paste text; 
♦  use the Microsoft Windows desktop environment. 
If the installed version of Microsoft Windows has not been used before, it is recommended that the reader spends 
some time working with it using the Microsoft documentation before using the CX-Server PLC Tools. 

CX-Server 3.1 PLC Tools: New Features 
This version of the CX-Server PLC Tools offers significant functionality for communication with OMRON PLCs 
and management of their associated settings information. 

The following list describes important features that are present in CX-Server 3.1 PLC Tools. 

♦  The PLC Tools run under Microsoft Windows 95, 98, Millennium, 2000 or XP and NT4.0 with Service Pack 
5 or later. 

♦  The PLC Tools have support for the following communications connections: 
♦  SYSMAC WAY, Toolbus (Peripheral port connection), Ethernet, Controller Link, 

SYSMAC LINK, SYSMAC NET (for Microsoft Windows NT only) and FinsGateway. 
New PLC support includes CS1-H, CJ1-H and CJ1-M PLCs. 

System Requirements 
The system requirements of CX-Server are the same as those of the CX-Programmer. Refer to page 3 
in Part 1: CX-Programmer for details. 

Communications Requirements  
In order to use serial communication types SYSMAC WAY and Toolbus a RS232 connections via a standard serial 
port on the PC (COM1 etc.) or a RS422 connections to a 422 serial board is required. 

When using SYSMAC LINK directly from a PC, a SYSMAC LINK network service board and FinsGateway 
version 3.12 must be installed. 

To use SYSMAC NET directly from a PC, SYSMAC NET network service board and FinsGateway version 3.12 
are required (Windows NT4 only). 

When using Controller Link, a Controller Link network service board (wired or optical and FinsGateway version 
3.12 are required. 

In order to use an Ethernet net, an Ethernet card, Windows Sockets software and TCP/IP must be installed and 
correctly configured. 

Refer to the appropriate hardware system manuals for detailed information about connecting and configuring these 
devices for the environment. 

Note: If FINS Gateway is to be used with a CLK/SLK PCI board in the Windows 98 or 2000 
operating system the appropriate drivers must be installed. These drivers can be found 
on the CX-Server CD under: CX-Server\WDM\CLK (PCI)\ or CX-Server\WDM\SLK (PCI)\. 

Installation 
CX-Server and CX-Server PLC Tools can be installed from the CX-One Package CD-ROM or the individual 
CX-Programmer CD-ROM. Refer to one of the following manuals for details. 

♦  Installing from CX-One: Refer to the CX-One Setup Manual.  
♦  Installing from the individual CX-Programmer CD-ROM: Refer to page 4 of Part 1: CX-Programmer. 
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Starting CX-Server PLC Tools 
CX-Server PLC Tools components are normally accessed from the invoking application. However, a number of 
tools can be accessed stand-alone from the Start pushbutton on the Microsoft Windows taskbar. 

 
CX-Net Network Configuration tool. 

Help and How to Access it 
The CX-Server PLC Tools come with a detailed context-sensitive help system. At any time while using the 
software, it is possible to get help on the particular point that is currently being worked on, or on general aspects of 
the CX-Server PLC Tools. This system is intended to complement the manual, by providing online reference to 
specific functions of the software and how to use them. The manual is designed to provide more tutorial 
information and discuss the various facilities offered by the CX-Server PLC Tools. 

♦  Context-sensitive help;  
♦  Help Index (available on the Help menu); 
♦  Help Contents (available on the Help menu); 
♦  About (available on the Help menu); 
♦  Status Bar. 

Help Topics 
For any of the PLC Tools select the Help Contents option on the Help menu. The Help system provides a standard 
look-up dialog under the Contents tab showing the contents of the PLC Tools Help file. Click on an item to read the 
associated information. 

Index 
Use the following procedure to retrieve online help from the Index tab of the Help Topics dialog. 

1, 2, 3… 1. Select the Help Index option from the Help menu. 
 2. Enter a text query into the first step field. The second step field is refreshed according to the 

query entered in the first step field. 
 3. Select an entry in the second step field and select the Display pushbutton, or double-click 

on the index entry. 
 4. If an entry is linked to two or more topics, the names of the topics are displayed in the 

Topics Found dialog. Select a topic and choose the Display pushbutton or double-click on 
the topic. 

Find 
Use the following procedure to retrieve on-line help from the Find tab of the Help Topics dialog. 

1, 2, 3… 1. Select the Help Index option from the Help menu. 
 2. Select the Find tab. 
 3. Enter a text query into the first step field. The second step field is refreshed according to the 

query entered in the first step field. Previous text queries can be retrieved by selecting from 
the drop-down list in the first step field. 

 4. Select a word that matches the query – some words may be automatically selected. More 
than one word can be selected by pressing Shift and selecting another word to extend the 
selection, or by pressing Ctrl and selecting another word to add to the selection. The third 
step field is refreshed according to the word or words selected. The number of topics found 
are shown at the bottom of the dialog. 

 5. Select a topic from the third step field and select the Display pushbutton, or double-click 
on the topic from the third step field. Select the Clear pushbutton to restart the find 
operation. 

The Find operation can be enhanced by the use of the Options pushbutton and Rebuild push-button. Refer to 
Microsoft Windows documentation for further information. 
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Context-sensitive Help 
The CX-Server PLC Tools support the use of context-sensitive help. The relevant online help topic is provided 
automatically by selecting the current area of the display responsible for carrying out those actions. Select the F1 
function key to retrieve context-sensitive help. Some dialogs include a Help pushbutton when F1 cannot be 
accessed. 

About CX-Server PLC Tools 
Each CX-Server PLC Tools dialog contains an About option on the Help menu. The About dialog supplies 
technical reference information about that dialog such as version and copyright information. It also contains 
essential version number information that is required for obtaining technical support. 

Use the following procedure to view the About CX-Server dialog. 

1, 2, 3… 1. Select About from the Help menu. 
2. The About box is displayed. It provides a copyright statement and version 

number of the component or tool within CX-Server. 

Status Bar 
The Status Bar is displayed at the bottom of many of the CX-Server dialog and PLC Tool windows. It provides 
several helpful pieces of information while programming: 

♦  Instant Help. A brief message appears in the Status Bar as menu commands and buttons are selected. 
♦  Online Status. The online or offline status of the PLC. (i.e. connected to PLC or not). 
♦  PLC Mode. When connected to a PLC, this shows the current PLC mode. Connection errors are also displayed 

here. 
♦  Connected PLC and CPU Type. The currently connected PLC and associated CPU can always be referenced 

in the status bar. 
The Status Bar can be enabled and disabled from many components and tools by selecting the Status Bar option 
from the View menu. 

Technical Support 
If the installation instructions for this application have been followed (refer to Installation in this Chapter), no 
difficulties should be encountered. However, if there is a problem, contact Customer Services. 

If a problem occurs, check that it does not relate to a fault outside CX-Server or the PLC Tools. Check the 
following: 

♦  The PC is working correctly. 
♦  The PLC is working correctly. 
♦  The communications system is set up correctly. 
♦  The errors are cleared in the PLC. 
When Customer Services need to be contacted, keep the details shown in the following table to hand. A clear and 
concise description of the problem is required, together with the exact text of any error messages. 

Note: Use the About box to obtain the version number of the component. 
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Customer Services Required Information Table 
Version number of CX-Server 
component or tool: 

 

Serial number of the software:  
Operating system and version 
number: 

 

Language of operating system:  
PLC type, model and CPU details:  
Type of communications in use:  
Serial Number  
Toolbus  
SYSMAC LINK  
SYSMAC NET  
Device Net  
Controller Link  
Ethernet  
Nature of the problem:  

Steps taken to reproduce problem:  

Other comments:  
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 CHAPTER 2 
PLC Memory Component 

This chapter describes the PLC Memory component and its ability to allow the user to view, edit and monitor either 
channels (words) or individual bits in areas of the PLC. 

The PLC Memory component allows viewing, editing and monitoring of PLC memory areas, monitoring and 
forcing of bit addresses and symbols and forced status information. 

The PLC Memory component displays the values of the memory area being accessed within the PLC. Areas to be 
monitored are selected from the memory area workspace. The address workspace shows individual bits, individual 
channel symbols and forced status information by selecting or entering specific PLC addresses or symbol names. 
The current values of these areas are displayed in the PLC Memory component. There are no values displayed 
when the PLC is offline. 

The PLC Memory component can be forced to stay as the top window by selecting Always on top from the View 
menu. 

For moving, resizing, tiling, maximising, minimising and closing windows, refer to Microsoft Windows online help 
for further information. 

Access to the PLC Memory component is from the invoking application.  

 To close the PLC Memory window, select the Close button in the title bar.  

 
The left pane, known as the Data Area Workspace, displays the current PLC in terms of its data areas and addresses. 
The data areas that form part of the PLC memory differ depending on the PLC type. The status bar provides instant 
help, displays the PLC and CPU type and describes the operating mode of the PLC. 

 To expand the hierarchy in the left pane, select this icon. 

 To collapse the hierarchy in the left pane, select this icon. 

   To view the content of a particular branch in the hierarchy, double-click on the item in the Data 
Area Workspace: a window is displayed within the PLC memory component. The associated 
icon in the Data Area Workspace changes to denote that a window has been opened. Multiple 
windows can be opened at the same time.  

 Select the Close button in the window’s title bar to close the window. 

 
Columns can be resized using the Resize Column button from the toolbar to fit the visible 
display area. These options are useful when changing data format, for instance to Binary. 

The display of the Data Area Workspace can be controlled by selecting Data Area Workspace from the View menu. 

The toolbar and status bar can both be turned on or off. Select Status Bar from the View menu to control the display 
of the status bar. Select Toolbar from the View menu to control the display of the PLC Memory toolbar. 
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PLC Data Area 
The Memory tab of the PLC Memory component allows monitoring and editing of complete memory areas as 
channel data. 

 

 
When the content of a memory area is opened, a window is displayed. It is possible to Zoom in 
and out of the window by selecting the Zoom In button or Zoom Out button from the toolbar. 
Select the Restore Zoom/Zoom to Fit button from the toolbar to return the window to the 
original zoom setting.  

Editing Data 
Data can be entered or amended in the data area displayed provided the associated PLC or memory area allows 
read/write operations. Use the following procedure to edit data in the Memory tab.  

1, 2, 3… 1. Double-click on the required data area name in the Memory tab of the Data Area 
Workspace to open it. A window containing a grid representing that data area is opened. 

 2. Select an appropriate format for the data to be entered from the associated button from the 
toolbar: Binary, Binary Coded Decimal, Decimal, Signed Decimal, Floating Point, 
Hexadecimal, Double Floating Point or Text. 

 3. Type in valid values directly into the cells and press Return. 
 

Note: Once a format has been selected a keyboard filter is applied so that non-valid keystrokes 
are ignored. 

When in either Debug mode (for CV-series PLCs only) or Monitor mode: it is not possible to edit a read-only value. 

PC to PLC Communications 
The PLC Memory component permits the transfer of data to and from the PLC and allows comparisons to be made 
between data stored on the computer and the PLC. Use the following procedure to retrieve data from the PLC. 

1, 2, 3… 1. Ensure the PLC is online before activating the PLC Memory component. 

 2. Open a data area by double-clicking a data area from the Data Area Workspace in the 
Memory tab. 
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3. Select the Transfer from PLC button from the toolbar to read information from the PLC. 

 4. The Transfer from PLC dialog is displayed. Transfer can be performed on the memory areas 
that have been opened in the PLC Memory component. Select the associated setting to 
monitor that area. 

 5. Select the Visible Area Only option to transfer the area visible to the window, the Selection 
option to transfer the area highlighted by the cursor or the All option to transfer all of the 
selected memory area from the PLC. Alternatively, use the Select All pushbutton to transfer 
all opened memory areas from the PLC. 

 6. Select the Upload pushbutton to accept the settings or the Cancel pushbutton to abort the 
operation. 

Note: By clicking an associated data area’s settings in its greyed state, the PLC Memory 
component automatically identifies the data area words to be monitored. 

Use the following procedure to write data back to the PLC. 

1, 2, 3… 1. Ensure the PLC is online before activating the PLC Memory component. 

 2. Open a data area by double-clicking a data area from the Data Area Workspace in the 
Memory tab. 

 
3. Select the Transfer to PLC button from the toolbar to transfer information to the PLC. 

 4. The Transfer to PLC dialog is displayed. Transfer can be performed on the memory areas 
that have been opened in the PLC Memory component. Select the associated setting to 
monitor that area. 

 5. Select the Visible Area Only option to transfer the area visible to the window, the Selection 
option to transfer the area highlighted by the cursor or the All option to transfer all of the 
selected memory area to the PLC. Alternatively, use the Select All pushbutton to transfer all 
opened memory areas to the PLC. 

 6. Select the Download pushbutton to accept the settings or the Cancel pushbutton to abort 
the operation. 

Note: By clicking an associated data area’s settings in its greyed state, the PLC Memory 
component automatically identifies the data area words to be monitored. 

The PLC Memory component allows the values stored on the PLC and the current displayed values to be compared. 
Use the following procedure to compare PLC and PC values.  

1, 2, 3… 1. Ensure the PLC is online before activating the PLC Memory component. 

 
2. Select the Compare with PLC button from the toolbar to compare information between the 

PC and the PLC. 
 3. The Compare with PLC dialog is displayed. Comparisons can be performed on the memory 

areas that have been opened in the PLC Memory component. Select the associated setting to 
compare that area. 

 4. Select the Visible Area Only option to compare the area visible to the window, the Selection 
option to compare the area highlighted by the cursor, or the All option to compare all of the 
selected memory area to the PLC. Alternatively, use the Select All pushbutton to compare 
all opened memory areas. 

 5. Select the Compare pushbutton to accept the settings or the Cancel pushbutton to abort the 
operation. 

Whilst comparing, all values resident on the PLC that are different to those on the PC are annotated in brackets. 
Further editing to the data area causes further differences between PC and PLC versions, and these are also 
annotated. 

Timer/Counter Memory areas 
Whether online or offline the PLC Memory component enables the data in the Timer (TIM) and Counter (CNT) 
memory areas to be formatted using either Binary Coded Decimal (BCD), Hexadecimal or Decimal data types. 

When an Online transfer to PLC operation is executed, the PLC Memory Component will read the TIM/CNT mode 
setting from the PLC. If the TIM/CNT mode is set to BCD, then the command will be actioned only if the current 
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data type is also BCD. If the data type is not BCD, then a warning message will be displayed, and the commend will 
be aborted. 

If the TIM/CNT mode is set to Binary, the command will only be actioned if the current data type is Decimal or 
Hexadecimal. If the current data is neither Decimal or Hexadecimal, then a warning message will be displayed, and 
the command will be aborted. 

When an Online Transfer from a PLC, Compare or Monitor operation is executed, the PLC Memory Component 
will read the data from the PLC and display it in the currently selected data format. If the data can not be displayed 
in the currently selected format, then an error message will be displayed. 

Note: The Timer (TIM) and Counter (CNT) memory areas are only available in the following 
PLCs: CS1G-H, CS1H-H, CJ1G-H, CJ1H-H, CJ1M, and CP1H. 

Monitoring Data 
Use the following procedure to monitor the data in PLC memory: 

1, 2, 3… 1. Ensure the PLC is online before activating the PLC Memory component. 

 
2. Select the Monitor button from the toolbar to monitor the PLC. 

 3. The Monitor dialog is displayed. Monitoring can be performed on the memory areas that 
have been opened in the PLC Memory component. Select the associated setting to monitor 
that area. 

 4. Select the Visible Area Only option to monitor the area visible to the window or the 
Selection option to monitor the area highlighted by the cursor. 

 5. Select the Monitor pushbutton to accept the settings or the Cancel pushbutton to abort the 
operation. 

Once monitoring, all changes to the data area are viewed. By navigating around the data area window, the visible 
area of the monitoring set by the Visible Area Only option changes to compensate. 

Note 1:  In the PLC Memory Window, individual values (cells) can be selected and the following 
operations can be performed to change present values during monitoring.  

•  For BIN (binary) displays, click the On, Off, ForceOn, ForceOff, ForceCanc, 
SetValue button to change the value of a bit. 

 The value can also be changed by right-clicking and then selecting Force | On, Force | 
Off, Force | Cancel, or Set |On, Set | Off, Set | Value from the pop-up menu.  

•  For other displays (e.g., decimal, BCD, or HEX), click the SetValue button to change 
the present value. 

 The present value can also be changed by right-clicking and then selecting Set | Value 
from the pop-up menu.  

Note 2: Continuous addresses can be monitored in the PLC Memory window by specifying the 
start address to be monitored. Set the start address in the Start Address field shown 
below and the display in the window will jump to the specified address for monitoring.  
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•  In the PLC Memory window, both individual bits for each word and the hexadecimal 
value of the word can be monitored at the same time if the display format is set to BIN 
(binary). 

Clearing and Filling Data Areas 

 
A whole data area can be cleared by clicking on the Clear Data Area button from the toolbar.  

A whole data area can be populated with a particular value. Use the following procedure to fill a data area with a 
single value. 

1, 2, 3… 
 

1. Open a data area by double-clicking a data area from the Data Area Workspace in the 
Memory tab. 

 
2. Select the Fill Data Area button from the toolbar. The Fill Data Area dialog is displayed. 
3. The Fill operation can be performed on the memory areas that have been opened in the PLC 

Memory component. Select the associated setting to fill that area. 
 4. Supply the value in the Value field. 
 5. Select the appropriate Fill Range option, either All, Visible Area Only or the selection 

currently highlighted by the cursor. 
 6. Select a Value option, either Binary, Binary Coded Decimal, Decimal, Signed Decimal or 

Hexadecimal.  
 7. If required, select a Set Status Value setting and the appropriate On or Off option. 
 8. Select the Fill pushbutton to accept the settings or the Cancel pushbutton to abort the 

operation. 
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PLC Address Area 
The Address tab of the PLC Memory dialog allows monitoring and forcing the status of individual bits. 

 

Monitoring 
Use the following to monitor an address or a symbol from an invoking application. 

1, 2, 3… 1. Ensure the PLC is online before activating the PLC Memory component. 
 2. Click on the Address tab of the PLC Memory component. 
 3. Open the Monitor area by double-clicking the Monitor branch from the Data Area 

Workspace in the Address tab. 

 

4. Enter an address in the Address field or select a Symbol to be retained from the invoking 
application: 

♦  In a Symbol field, type in a Symbol name or select the Browse button to select a Symbol to be 
retained from the invoking application. The corresponding Address field automatically detects 
and contains the address associated with the Symbol. 

♦  If a Symbol has not been selected, in an Address field, type in a direct word or bit address to 
monitor. 

Note: Address notation for CS/CJ/CP-series PLCs and CV-series PLCs is, for instance ‘D0’, 
‘0’, ‘E0.0’ to monitor a word, ‘0.0’, ‘cf100’ to monitor bits. 

 When monitoring starts, data from the PLC is displayed in the Value field, in the format specified 
in the Format field. The display format of the address or symbol to be monitored can be changed 
by selecting an appropriate button from the toolbar: Binary, Binary Coded Decimal, Decimal, 
Signed Decimal, Hexadecimal or Text.  

Any special address information is shown in the Attribute field. The attribute of a bit can be forced. It is not possible 
to force bit addresses that are read-only. Use the following procedure to apply a forced setting.  

1, 2, 3… 1. Ensure a bit is currently being monitored and is not read-only. 
 2. Select the Attributes setting for the bit. 

 

 

3. Select the forced state of the bit. A bit can be forced on by selecting the Force On button 
from the toolbar. A bit can be forced off by selecting the Force Off button from the toolbar. 
Forced settings can be cancelled by selecting the Force Cancel button from the toolbar. 
Select the Set Value button from the toolbar to set a value to the attribute.  

The update rate is shown in the Properties field. 
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Further rows can be inserted into the Address Monitor window by selecting Insert from the Address menu. Rows 
can be removed by selecting Remove from the Address menu. All rows can be removed by selecting Remove All 
from the Address menu.  

 

Forced Settings 
It is possible to specify the state of an address regardless of its actual (physical) state, this is particularly useful for 
testing certain conditions or rungs in a ladder program.  

Once scanned, the Forced Status window displays the address, value and attributes for all forced bits. 

It is not possible to force bit addresses that are read-only. 

Displaying Forced Status 
The forced status of bits can be retrieved from the PLC. Use the following procedure to retrieve the forced status of 
bits from the PLC. 

1, 2, 3… 1. Ensure the PLC is online before activating the PLC Memory component. 
 2. Click on the Address tab of the PLC Memory component. 
 3. Click the right-mouse button on the Forced Status branch and select Scan Forced Status. 

All bit areas in the PLC are scanned to find all forced bits (Forced On and Forced Off). The 
Forced Status window is displayed showing all forced bits and their associated value and 
attributes. 

Copying a Forced Bit 
A forced bit can be copied from the Force Status window to the Address Monitor window. Use the following 
procedure to copy a forced bit.  

1, 2, 3… 1. Ensure the PLC is online before activating the PLC Memory component. 
 2. Click on the Address tab of the PLC Memory component. 
 3. Open the Forced Status area by double-clicking the Forced Status branch from the Data 

Area Workspace in the Address tab. 
 4. Select the address to be copied with the right-mouse button in the Forced Status window and 

select Copy to Symbol Monitor Address. 

Clearing Forced Bits 
All forced bits can be cleared. Use the following procedure to clear forced bits.  

Caution: This operation will clear all forced bits in the PLC. 

1, 2, 3… 1. Ensure the PLC is online before activating the PLC Memory component. 
 2. Click on the Address tab of the PLC Memory component. 
 3. Open the Forced Status area by double-clicking the Forced Status branch from the Data 

Area Workspace in the Address tab. 
 4. Click the right-mouse button in the Forced Status window and select Clear All Forced 

Addresses. 
 5. Select the Yes pushbutton to confirm the operation. 

Updating the Forced Status Window 
Use the following procedure to refresh the Force Status window. 

1, 2, 3… 1. Ensure the PLC is online before activating the PLC Memory component. 
 2. Click on the Address tab of the PLC Memory component. 
 3. Open the Forced Status area by double-clicking the Forced Status branch from the Data 

Area Workspace in the Address tab. 
 4. Click the right-mouse button in the Forced Status window and select Refresh. 
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PLC Memory Management 
A number of features of the PLC Memory Component are common to both the Memory tab and Address tab. 

PLC Memory component files can be saved to the CX-Server project. Use the following procedure to save PLC 
Memory component details to the CX-Server project.  

1, 2, 3… 

 

1. Select the Save in Project button from the toolbar. The Save dialog is displayed. 
2. Select the required data areas to include in the file from the Areas to Save: field. 

 3. Enter a comment in the File Comment field. 
 4. Select the OK pushbutton to proceed. 

PLC Memory component files can be saved via a standard File Save dialog. Use the following procedure to save a 
PLC Memory component file.  

1, 2, 3… 1. Select Save to File from the File menu. The Save dialog is displayed. 
 2. The Save dialog is displayed. Select the required data areas to include in the file from the 

Areas to Save: field. 
 3. Enter a comment in the File Comment field. 
 4. Select the OK pushbutton to proceed. 
 5. A standard File Save dialog is displayed. Enter a file name in the File name field and select 

the Save pushbutton. PLC Memory files have a .MEM extension. 
Information saved to a file can be supplemented with header information set as a preference. Refer to Chapter 2 - 
PLC Memory Component for details of setting header information to a file. 

PLC Memory component files can be retrieved via a standard File Open dialog. Use the following procedure to 
open a PLC Memory component file.  

1, 2, 3… 

 

1. Select the Open File button from the toolbar to open a PLC Memory component file. A 
confirmation message box may appear if the file is already open. Select the Yes pushbutton 
to save the currently open details. Select the No pushbutton to discard the currently open 
details. Select the Cancel pushbutton to abort the operation. 

 2. A standard File Open dialog is displayed. Select a file from the Open PLC Memory File 
dialog, followed by the Open pushbutton. PLC Memory files have a .MEM extension. 

PLC Memory component data can be printed. Use the following procedure to print details.  

1, 2, 3… 1. Open the Address Monitor window from the Address tab or a data area window from the 
Memory tab. 

 
2. Select the Print Preview button from the toolbar. A preview window is displayed. 

 3. Select the appropriate pushbutton to view the printout. 

 ♦  Select the Next Page pushbutton to view the next page of the printout; 

♦  Select the Prev Page pushbutton to view the next page of the printout; 

♦  Select the Two Page pushbutton to view two pages of the printout at once; 

♦  Select the Zoom In pushbutton to zoom in to the page; 

♦  Select the Zoom Out pushbutton to zoom out from the page; 

♦  Select the Print pushbutton to print from the preview. 

♦  Select the Close pushbutton to close the preview window. 

 
4. Select the Print button from the toolbar. A standard Print dialog is displayed. 

 5. Set up the required printer settings. Select the OK pushbutton to print the PLC Memory 
details or the Cancel pushbutton to abort the operation. 

Note: Printer specific settings can be applied prior to printing the PLC Memory details, by 
selecting Print Setup from the File menu.  

Use the following procedure to copy or move information from or in the PLC Memory component.  

1, 2, 3… 1. Select an item or items in a window.  
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2. Select the Copy button from the toolbar to copy the item, or the Cut button from the toolbar 

to move the item. 
 3. Select an area to move the items to, for instance copying data area values into another data 

area. 

 
4. Select the Paste button from the toolbar to paste the item. A Paste operation can be 

performed several times without copying again. 

PLC Memory Preferences 
PLC Memory component preferences permits the setting of display properties for data monitoring.  

The Display tab defines the preferred display format. Use the following procedure to change the display format 
preference: 

1, 2, 3… 1. Select the Preferences option from the View menu. 
 2. Select the appropriate word display format option, either Binary, Binary Coded Decimal, 

Decimal, Signed Decimal, Floating Point, Hexadecimal, Double Floating Point or Text.  
 3. Select the appropriate bit display format option, either Text or Numeric. 
 4. If required, select the appropriate font using the Change Font pushbutton. 
 5. Select the OK pushbutton to accept the settings or the Cancel pushbutton to abort the 

operation. 
The Monitoring tab allows the monitor update interval preference to be amended. Use the following procedure to 
change the monitor update interval preference. 

1, 2, 3… 1. Select the Preferences option from the View menu. 
 2. Select the Monitoring tab. 
 3. Select a Monitor Update Interval and an associated Unit from the fields. 
 4. Select the OK pushbutton to accept the settings or the Cancel pushbutton to abort the 

operation. 
The General tab permits the setting of general preferences. Use the following procedure to change the general 
preferences. 

1, 2, 3… 1. Select the Preferences option from the View menu. 
 2. Select the General tab. 
 3. Select the Automatically Resize Column Widths option to ensure that all values remain 

visible within the data area window irrespective of their display format. It is best practise for 
this option to be set OFF when monitoring large data areas. 

 4. Select the Prompt Before Closing an Active Monitor Window option if confirmation is 
required before closing a data area window that is being monitored. 

 5. Select the Beep on Invalid Input option to receive an audible beep when an invalid input to 
the PLC Memory component has been made. 

 6. Select the Fast Window Update option to reduce the affect of flickering when monitoring. 
 7. Select the OK pushbutton to accept the settings or the Cancel pushbutton to abort the 

operation. 
The File tab permits the setting of header information into PLC memory component files. Use the following 
procedure to change the file information. 

1, 2, 3… 1. Select the Preferences option from the View menu. 
 2. Select the File tab. 
 3. Insert a file name in the File Name field. 
 4. Insert a comment in the Comment field. 
 5. Select the OK pushbutton to accept the settings or the Cancel pushbutton to abort the 

operation. 
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 CHAPTER 3 
IO Table Component 

This chapter describes the IO Table component available to C-series, CV-series, CS/CJ series PLCs and its ability 
to create, retrieve and edit a configured PLC’s rack and address data. 

The IO Table component allows configuration of racks, slots and units within a PLC, using available hardware as 
reference. Within a PLC there are three versions of an IO Table, all of which should ideally have the same contents. 
IO Table component editing allows manipulation of the internal version of the table, and modification of the PLC’s 
view of how the hardware is configured. The three versions are: 

♦  Actual IO Table. The real hardware configuration of the PLC units and slots on power-up. 
♦  Registered IO Table. The internal PLC table: this is the one used by the PLC when running, regardless of the 

state of the actual hardware. It can be read and, for C2000 PLCs, CV-series PLCs and CS/CJ series PLCs, 
written to by the CX-Server software.  

♦  CX-Server IO Table. The IO configuration understood by CX-Server. It can be created and modified directly, 
independently from the PLC, and can be transferred with a program (for CV-series and CS/CJ series PLCs).  

The Registered Table and CX-Server’s table can be changed from the PC, but the actual configuration requires the 
physical manipulation of the PLC hardware. It is only possible to transfer the Registered IO Table in C2000, CV 
and CS/CJ series PLCs to the PLC. Editing of individual IO units in the Registered IO Table is only available in 
C1000H, C2000H, CS/CJ series and CV-series PLCs. 

The IO Table component is displayed as a hierarchical structure. The IO Table view can be expanded to show 
entries for all Remote Terminals (RTs) and the IO. All possible racks and unit numbers for the active PLC are 
displayed although these may not all be in use. An address and IO string are displayed against each rack slot or unit; 
this is used to indicate the input and output characteristics of the unit. 

The status bar displays the selected PLC and CPU type, and the current operating mode of the PLC.  

When a Remote Terminal (RT) is added, it can be expanded to provide the Terminals view, showing entries for all 
slots on that remote rack. 

Icons to the left of a rack indicate units fitted to expansion racks, SYSBUS/SYSBUS2 remote racks or IO 
Terminals. To view the content of the IO Table, double-click on a rack. The unit address is displayed in brackets for 
each slot. 

For CV-series PLCs, SIOU units are shown on the IO Table tree as a separate rack. For CS/CJ series PLCs, SIOU 
units are all integrated into the main rack.  

Whilst in online mode operations can be selected that affect the PLC, for instance creating an IO Table. These 
options are only available when the PLC is in the correct mode of operation for programming. 

The IO Table component can be forced to be displayed in focus by selecting Always on top from the Options menu. 

For moving, resizing, maximising, minimising and closing windows, refer to Microsoft Windows online help for 
further information. 

Access to the IO Table component is from the invoking application or via the CX-Net Network Configuration Tool. 
Refer to Chapter 8 - CX-Net Network Configuration Tool for further details.  

 To close the IO Table dialog, select the Close button in the title bar.  

I/O Table Window Variations 
CX-Programmer Versions 6.0 and later have the following two kinds of I/O Table Windows. 

1, 2, 3… 1. I/O Table Window for the CS/CJ/CP Series (known as the CS/CJ/CP I/O Table Window) 
 2. I/O Table Window for the C Series and CVM1/CV Series (known as the C/CV I/O Table 

Window) 

Auto-selection of the I/O Table Window 
The following table shows which I/O Table Window will be selected automatically, based on the PLC model and 
computer operating system.  
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PLC Series PLC model Computer’s operating system Selected I/O Table Window 

Windows OS other than Windows 95 1) CS/CJ/CP I/O Table 
Window 

CS/CJ/CP Series CS1G/CJ1G, CS1H, CS1G-H, CS1H-H, 
CS1D-H, CS1D-S, CJ1G-H, CJ1H-H, or 
CJ1M Windows 95 

Series other than 
CS/CJ/CP 

C Series: 
C200H, C200HS, C200HX/HG/HE, 
C200HX-Z/HG-Z/HE-Z, C500, 
C1000H, or C2000H 

CVM1/CV Series: 
CVM1, CVM1-V2, CV1000, CV2000, 
or CV500 C2000H 

FQM1 Series: 
FQM1-CM001, FQM1-MMA21, or 
FQM1-MMP21 

Windows 95 or other Windows OS 

2) C/CV I/O Table Window 
(See note.) 

Note: With version 5.0 and earlier versions of the CX-Programmer, the C/CV I/O Table 
Window is always selected, regardless of the PLC model and operating system. 

Distinguishing between the CS/CJ/CP and C/CV I/O Table Windows 
The I/O Table Windows can be identified by the names in the project directory tree and the colors of icons, as 
shown in the following table.  

I/O Table Window variation Names in project directory tree Colors of icons in project directory tree 

1) CS/CJ/CP I/O Table Window I/O Table and Unit Setup : Grey and yellow 

2) C/CV I/O Table Window I/O Table : Sky blue 

I/O Table Window Functions 
The following table describes the functions of the two I/O Table Windows. 

I/O Table Window variation Existing functions New functions 

1) CS/CJ/CP I/O Table 
Window 

Creating a registered I/O table 
(Displays Unit type, number of Units occupied, and 
number of I/O words occupied.) 

•  Software switch settings (See note 1.) 

•  Unit settings (See note 1.) 

•  Replace Unit online. 

•  Display Unit production information. 

•  Register/display Unit comment. 

•  Register/display Unit profile. 

•  Monitor Unit error log. 
Note 1. 
The software switch settings and Unit settings are 
included in the Special I/O Unit and CPU Bus Unit 
parameter settings. 

•  Special I/O Unit and CPU Bus Unit 
parameter settings 

•  Specialized Support Tool startup function 
(See note 2.) 

•  Display a Rack’s current consumption 
(CS/CJ Series only) and Rack width (CJ 
Series only) 

•  Monitor CPU DIP Switch settings online. 
Note 2. 
When the CX-Programmer is installed from 
the CX-One. 

2) C/CV I/O Table Window Creating a registered I/O table 
(Displays Unit type, number of Units occupied, and 
number of I/O words occupied.) 

•  Software switch settings 

•  CPU Bus Unit settings 

•  Replace Unit online. 

•  Display Unit production information. 

•  Monitor Unit error log. 

•  When editing the I/O table offline, words can be 
reserved by installing Dummy Units. 

None 
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Special I/O Unit and CPU Bus Unit Settings 
One of the new CS/CJ/CP I/O Table Window functions sets the allocated DM area, allocated CIO area, and CPU 
Bus Unit Area (Ethernet Units only) for CS/CJ/CP-series Special I/O Units and CPU Bus Units without requiring 
the parameter addresses. (This function is supported by the CS/CJ/CP I/O Table Window only.) Even if new 
Special I/O Units and CPU Bus Units are purchased, the new Units parameters can be set just by installing the 
Unit’s CPS (Component and network Profile Sheet), so it isn’t necessary to upgrade the CX-Programmer.  

CPS File Overview 
The term CPS is short for the “Component and network Profile Sheet”, which is a CX-One file containing 
definition information for a CS/CJ/CP-series Unit or other component. The CPS files are provided in XML file 
format. 

The CX-Programmer uses the information in the CPS files to identify CS/CJ/CP-series Units in the I/O Table. 
Special I/O Unit and CPU Bus Unit settings are also based on these CPS files.  

The CPS files are composed of the following CS/CJ/CP-series Unit/Component information: 

•  ID information (such as the model number, name, Unit type, and Unit version) 

•  Parameter information (offset address, setting parameter name, and setting range or selection options) 

 

Unit B 

Parameter information

ID information 

CPS file for Unit A 

Unit A 

ID information

Parameter information

CPS file for Unit B 

CX-Programmer I/O Table 

Data read 

Unit A settings 

Data read

Unit B settings 

Parameter information

Parameter data itself 

Parameter information

Parameter data itself 

Special I/O Unit or 
CPU Bus Unit 

Special I/O Unit or 
CPU Bus Unit 

 

Specialized Tool Startup Overview (Supported when CX-Programmer Is 
Installed from CX-One) 

The Specialized Tool Startup function is a new CS/CJ/CP I/O Table Window function that can start the 
Programming Support Tool specific to a particular Unit (Special I/O Unit or CPU Bus Unit) directly from the I/O 
Table Window. (This function is supported by the CS/CJ/CP I/O Table Window only.) This function is supported 
when the CX-Programmer or other Support Tool is installed from the CX-One. The appropriate Programming 
Support Tool can start with the necessary PLC model information, Unit type, and online/offline status information.  

Displaying an I/O Table 

Displaying the CS/CJ/CP I/O Table Window 
The CS/CJ/CP I/O Table Window is displayed when the PLC is a CS/CJ/CP-series PLC and the computer’s 
operating system is a Windows OS more recent than Windows 95.  
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Rack’s starting CIO address

Slot number

Unit’s starting CIO address Unit model
(See note.)

Unit name

Number of Unit
resources occupied
by Special I/O Unit Special I/O Unit’s

unit number
Number of output words
and number of input
words

Note: The Unit model will be blank if there is no CPS file.
The Unit model will also be blank when data for C200H Special I/O
Units has been uploaded from the PLC (Transfer from PLC).  

Note: In the CS/CJ I/O Table Window, the current consumption and width for each PLC Rack 
can be displayed as shown below by selecting Options - Consumption and Width.  

 

 Online, the current status of the DIP switches on the target PLC (CPU Unit) can be 
checked by selecting Options - DipSwitch Information.  

 

Displaying the C/CV I/O Table Window 
The C/CV I/O Table Window is displayed when the PLC is not a CS/CJ/CP-series PLC or the computer’s operating 
system is Windows 95.  

 

Rack’s starting CIO address 

Slot number 

Rack number 

Unit’s starting CIO address 

Unit name 

Number of output words and 
number of input words 

Special I/O 
Unit’s unit 
number 
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Unit Settings 

Settings for the CS/CJ/CP I/O Table Window 
The CS/CJ/CP I/O Table Window is displayed when the PLC is a CS/CJ/CP-series PLC and the computer’s 
operating system is a Windows OS more recent than Windows 95. 

Creating an IO Table 
Creation of an IO Table whilst connected to a PLC causes the Actual IO Table in the hardware to be written to the 
Registered IO Table. An IO Table can also be edited offline and stored to file, this method is usually employed 
when designing a PLC’s IO Table. 

To create an IO Table, select Create from the Options menu. 

Slot Allocation 
The following procedure shows how to edit the I/O table in the I/O Table Window.  

 

1, 2, 3… 1. Right-click the slot where the Unit will be allocated and select Add Unit (or just 
double-click the desired slot). The Select Unit Dialog Box will be displayed.  

 2. Select the desired Unit (Unit to be allocated) from the directory tree menu and click the OK 
Button.  

Setting Parameters for CS/CJ/CP-series CPU Bus Units and Special I/O Units 
After the I/O table has been created, the I/O table and Special I/O Unit/CPU Bus Unit parameters can be transferred 
from the PLC and edited in the computer, as shown in the following example.  

1, 2, 3… 1. Connect the CX-Programmer online and open the I/O Table Window.  
 2. Select Options – Transfer from the PLC from the I/O Table Window’s menu. The Transfer 

from the PLC Dialog Box will be displayed. At this point, the I/O Table and SIO Unit 
Parameters Options can be selected. 

 3. Select the options (check the boxes) for the data that you want to transfer and click the 
Transfer Button. In this case, both options have been selected.
The I/O table and Unit parameters data will be transferred from the PLC and the transfer 
results will be displayed.  

 4. Check the transfer results and click the OK Button. The I/O table transferred from the PLC 
will be displayed.  

 5. To edit the parameters of a Special I/O Unit or CPU Bus Unit, select the Unit and either 
double-click the Unit or select Edit – SIO Unit Parameters from the menu. The selected 
Unit’s Edit Parameters Dialog Box will be displayed.  
In this case, a Controller Link Unit’s Edit Parameters Dialog Box has been displayed to edit 
the Unit’s CPU Bus Unit Allocation DM Settings.  
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 6. Edit the parameters and, if necessary, click the Compare Button. If the Compare Button is 
clicked while the PLC is online, the software immediately checks whether the I/O table 
settings match the Unit settings (such as the allocated DM area and CIO area) actually in the 
PLC’s CPU Unit.  
If the contents do not match, the settings read from the actual Unit will be displayed in 
orange. 

 7. When you want to download the parameters set for each Unit to the PLC’s CPU Unit, click 
the Download to Unit Button.  

 8. Click the Reset Button to enable the parameter settings that have been transferred. 
Note 1: When Special I/O Unit or CPU Bus Unit settings are edited in the I/O Table Window, 

the parameters allocated in the DM Area or CPU Bus Unit Setup Area for the Unit are 
only transferred to the actual PLC when the Transfer PC to Unit Button is clicked in 
the Edit Parameters Dialog Box. They are not automatically enabled, i.e., the new 
parameter settings will not be used. Click the Reset Button to enable the parameter 
settings that have been transferred. When the Reset Button is clicked, however, 
unexpected operation may result. Always confirm system safety before clicking the 
Reset Button. 

Note 2: When the CX-Programmer creates the Special I/O Unit or CPU Bus Unit settings in the 
I/O Table Window, it automatically uses the latest version of the CPS file that is 
available in the computer. 

•  If the actual Unit’s version number is older than the latest CPS file in the computer, 
a warning will be displayed when the settings are downloaded to the Unit. A Dialog 
Box will ask whether to change the computer’s settings. 
In general, click the Yes Button to change the computer’s settings. When the Yes 
Button is clicked, the Unit version in the computer’s Unit settings will be changed to 
the actual Unit’s version number. (If the No Button is clicked, the version number in 
the computer will be newer than the actual Unit’s version number, and the newer 
version number will be displayed.) 

•  Similarly, if the actual Unit’s version number is newer than the latest CPS file in the 
computer when the Unit’s settings are transferred from the PLC to the computer, the 
computer’s earlier Unit version number will be displayed. In this case, install the 
Unit’s correct (newer) CPS file in the computer. For details, refer to Installing a CPS 
File below. 
If the newer CPS File is not installed, the newer version’s Unit settings cannot be set 
and only the older Unit settings (in the older CPS file) can be set.  

Note 3: Storing the Parameter Settings Data File 

•  The data set in the Edit Parameters Dialog Box can be saved in a parameter settings 
file with a .xml filename extension. To save the parameter settings, right-click the 
desired Special I/O Unit or CPU Bus Unit in the I/O table and select Save 
Parameters from the pop-up menu.  

•  The saved parameter settings can also be read from a parameter settings file (.xml 
filename extension), but the settings must be for the same model Special I/O Unit or 
CPU Bus Unit. 

Note 4: Contents of Parameter Settings Data Files 
The structure of a parameter settings data file is based on the parameter settings in the 
CPS file. Parameter settings data files contain the following data: 

•  Model number, Unit version number, unit number, rack number, and slot number 

•  Name of the original CPS file used to create the parameter settings data 

•  Parameter names and data 

Note 5: When Special I/O Unit or CPU Unit settings are performed in the I/O Table Window 
and then transferred from the PLC Memory Window, the following warning will be 
displayed if the allocated DM Area/CIO Area addresses set for Special I/O Units or 
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CPU Bus Units in the I/O Table Window on the computer overlap with the PLC data 
table addresses. 

 
 Unless the CPU Bus Unit or Special I/O Unit settings have been previously transferred 

to the CPU Unit and the allocated DM Area/CIO Area data in the PLC data table for 
Special I/O Units or CPU Bus Units is to be overwritten, always click the No Button, 
shift the address, and repeat the transfer procedure.  

Note 6: CPU Bus Unit and Special I/O Unit settings are not checked for logical consistency. Be 
very careful of the logical consisting of the overall settings when making any setting that 
affects other settings, e.g., settings that enable or disable other settings. Transfer the 
Special I/O Unit or CPU Bus Unit settings to the PLC and then start operation, being 
aware that any logical inconsistencies may produce unexpected operation.  For example, 
if one setting selects either user settings or default settings and is set to use the default 
settings, it will not automatically change to enable user settings even if the related user 
settings are made. To use the user settings, they will have to be enabled manually and 
specifically in the setting that selects either user settings or default settings. 

Note 7: If Create I/O Table is selected when setting Special I/O Units or CPU Bus Units in the 
I/O Table Window, the settings in the Special I/O Units or CPU Bus Units on the 
computer will be initialized. To maintain the same settings, save the Special I/O Unit or 
CPU Bus Unit settings to a file by right-clicking the Unit in the I/O table and selecting 
Save Parameters from the pop-up menu. Then, after creating the I/O tables, read the 
settings back from the file by right-clicking the Unit in the I/O table and selecting Load 
Parameters from the pop-up menu.  

Installing a CPS File 
CPS files are automatically installed in the following directory when CX-One or CX-Programmer is installed. A 
CPS file is created for each unit version of each Special I/O Unit and CPU Bus Unit. 

Program Files\Common Files\Omron\Profiles\CPSFiles 

The CX-Programmer uses the CPS File for the most recent unit version. If a backup indicates that a newer unit 
version exists, the newer version’s CPS file must be installed. Use the following procedure to install the new CPU 
File. 

1, 2, 3… 1. Select File – CPS Install. The Installation of Cps files Dialog Box will be displayed.  
 2. Specify the CPS file to be installed. 
 3. Restart the CX-Programmer. 

Printing the I/O Table or Unit Parameter Settings 
The following procedure explains how to print the I/O table or a parameter list of Special I/O Unit and CPU Bus 
Unit settings.  
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1, 2, 3… 1. Select the desired Special I/O Unit or CPU Bus Unit in the I/O table and select File – Print 
from the pop-up menu. The Print Dialog Box will be displayed. 

Option 
Function 
 
I/O Table 
Prints the I/O table. 
 
Special Unit Settings 
Prints a parameter list of the Special I/O Unit or CPU Bus Unit settings. 
 
I/O Table + Special Unit Settings 
Prints the I/O table and a parameter list of the Special I/O Unit or CPU Bus Unit settings. 
 
 

 2. Select the desired print option and click the OK Button. The Print Dialog Box will be 
displayed. 

 3. To preview a print job, select File – Print Preview, select the desired print option in the 
Print Dialog Box, and click the OK Button.  

Note 1: When using Windows NT 4.0, the text characters may be altered in the I/O table’s print 
preview. In this case, reinstall the most recent Windows NT 4.0 Service Pack. 

Note 2: When making parameter settings for a Special I/O Unit or CPU Bus Unit in the I/O 
Table Window and transferring data from the PLC Memory Window, a warning will be 
displayed if the addresses in the transferred PLC data file overlap the allocated DM 
Area or allocated CIO Area addresses set for the Special I/O Unit or CPU Bus Unit in 
the computer’s I/O Table Window. 
Always click the No Button if you do not want to overwrite the actual PLC’s (CPU 
Unit’s) allocated DM Area or allocated CIO Area address data with the PLC data table 
data after the Unit settings data has been transferred to the PLC (CPU Unit). After 
cancelling the write operation, remove the PLC data table’s allocated DM/allocated 
CIO area from the areas that will be transferred and then transfer the data again.  

Settings for the C/CV Series I/O Table Window 
The C/CV Series I/O Table Window is displayed when the PLC is not a CS/CJ/CP-series PLC or the computer’s 
operating system is Windows 95. 

Creating an IO Table 
Creation of an IO Table whilst connected to a PLC causes the Actual IO Table in the hardware to be written to the 
Registered IO Table. An IO Table can also be edited offline and stored to file, this method is usually employed 
when designing a PLC’s IO Table. 

To create an IO Table, Select Create from the Options menu. 

Slot Allocation 
Use the following procedure to allocate a unit to a slot. 

1, 2, 3… 1. Select an empty slot in the IO Table component. 
 2. Click the right-mouse button and select a unit. For Single and Multiple IO Units a secondary 

selection is required from the right-mouse button menu. The type of PLC series and 
individual rack configurations determine the units that can be installed and therefore the 
content of the right-mouse button menu. The types of unit that can be selected are described 
in following paragraphs. 

Slots can also be allocated by transferring the rack information from the PLC. Refer to IO Table Component in this 
chapter for information regarding transferring IO Table information from the PLC. 
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For CS/CJ/CP series PLCs, the IO fields for racks, slots and units information can be edited directly in the IO Table 
tree. 

Only those units in the Registered IO Table for CS/CJ/CP series PLCs, C200H (including C200HS/X/G/E) PLCs 
and CV/CVM1-series PLCs can be edited. 

Note: Any slots allocated must be verified to ensure that the Real IO Table has been setup up 
correctly. 

Single and Multiple Units 

Points with an IO Type of Input, Output or Input/Output can be applied to the IO Table component. Each point 
contains a name and an address indicating its position in PLC memory. The information contained within a point 
can be read or updated by the controlling system and its status and content stored in the system’s database. An 
application accesses this point data by establishing a link between the application and the database. A point can 
have the same address as another and any comment entered against this address applies to all points at that location. 

All PLC series support 8-point, 16-point, 32-point and 64-point Units. CV-series PLCs and CS/CJ/CP-series PLCs 
also support 128-point and 256-point Units. 

Refer to the Run Time manual for an introduction to points. 

Counters, Position Controller, Numerical Control and ASCII Units 

Use the following procedure to apply unit settings to Counters, Position Controllers, Numerical Control and ASCII 
units. 

1, 2, 3… 1. Allocate a slot to be a Counter unit, Position Controller unit, Numerical Control unit or 
ASCII unit. The Enter SIOU Details dialog is displayed. 

 2. Enter valid settings for the Unit Number field, Address per Unit field, Input Words field and 
Output Words field. Valid settings exclude those settings that have already been used. 

 3. Select the OK pushbutton to complete the operation or the Cancel pushbutton to abort the 
operation. 

Additionally for Counters, Numerical Control and ASCII units, for CV-series PLCs and CS/CJ/CP series PLCs, the 
CIO and DM Address range need to be specified; refer to Chapter 3 - Software Switches for further information. 

Interrupt Units 

Interrupt units are automatically assigned until the maximum number of units has been reached. 

Sysmac-Bus Master Unit and Remote Terminals 

If the Sysmac-Bus Master option is selected from the context menu, the hierarchy in the IO Table component can be 
further expanded to expose the Remote Terminals and IO Terminals that form part of the SYSMAC-BUS option. 
Use the following procedure to apply unit settings to Sysmac-Bus Master. 

1, 2, 3… 1. Allocate a slot to be a Sysmac-Bus Master unit. The Enter RM Number dialog is displayed. 
 2. Select a unit number from the Unit Number field, either 0 or 1. 
 3. Select the OK pushbutton to complete the operation or the Cancel pushbutton to abort the 

operation. 
The Sysmac-Bus Master unit provides two types of slave units that can be applied to the slave rack in the same 
manner as a normal rack: 

♦  C500H Remote Terminal (RT); 
♦  C200H Remote Terminal (RT). 
Any units on the slave racks or other Remote IO Units connected to the master are allocated IO words according to 
the slot where the master is located.  

For C1000H and C2000H PLCs, Word multipliers are required to set the base address of IO Terminals on each 
SYSMAC-BUS Remote Master. 

SIOU/Communications Units 

SIOU/Communications Units can only be set up for CV-series PLCs and CS/CJ/CP series PLCs. 
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For CV-series PLCs SIOU/Communications Units the following Unit Setup and Software Switches setup can be 
performed:  

♦  Basic (Software Switches setup only); 
♦  DeviceNet Master (Software Switches setup only); 
♦  Controller Link; 
♦  Ethernet; 
♦  Host Link; 
♦  ISA Board Unit (Software Switches setup only); 
♦  ME-Net (Software Switches setup only); 
♦  Mini-map (Software Switches setup only); 
♦  M-Net (Software Switches setup only); 
♦  Motion Controller (Software Switches setup only); 
♦  PC (Software Switches setup only); 
♦  Syslink; 
♦  Sysmac-Bus Master; 
♦  SysNet. 
For CS/CJ series PLCs SIOU/Communications Units the following Unit Setup and Software Switches setup can be 
performed: 

♦  Controller Link Unit; 
♦  Device Net and Open Network controllers; 
♦  Ethernet Unit; 
♦  Serial Communications Unit (Software Switches setup only). 
Most of the settings for SIOU/Communications Units should have been set via the PLC setup component. Refer to 
Chapter 4 - PLC Setup Component for further details. 

Refer to Chapter 3 - Unit Setup and Software Switches for further information. 

Caution: Setup to SIOUs that have already been registered should be applied carefully. 

Verifying Correct Configuration 

If a change is made to the IO configuration that affects a type of IO word or the number of words required by a unit, 
for instance adding or removing units, an IO verification error occurs. Select Verify from the Options menu to 
ensure that an IO verification error has not occurred. If an error has occurred, use the procedures explained in 
Chapter 3 - Creating an IO Table, Chapter 3 - Slot Allocation and Chapter 3 - Transfer an IO Table to rectify any 
error.  

Unit Setup 
The Unit Setup for a selected rack IO option can be edited for CV-series and CS/CJ/CP series PLCs only. For 
C-series PLCs, refer to Chapter 8 - CX-Net Network Configuration Tool. Use the following procedure to edit the 
Unit Setup. 

1, 2, 3… 1. Highlight the rack/unit in the IO Table tree. 
 2. Click the right-mouse button and select Unit Setup. 
 3. Set the required unit setup options for the specified rack/unit. 

Note: The availability of the Unit Setup option depends on the rack/unit selected. The SIOUs 
attached to a PLC are shown in the IO Table component. 

The PLC Communications Unit Setup dialog allows both the system and software switch memory areas associated 
with a mounted Special Input/Output unit (SIOU) to be configured. 

Software Switches 
The Software Switch settings for a selected rack IO option can be edited for CV-series and CS/CJ/CP series PLCs. 
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For CV-series PLCs, the Software Switch settings appear in the IO Table tree as SIOU Units. For CS/CJ/CP series 
PLCs, the Software Switch settings appear in the IO Table tree as part of the Main Rack information. 

The dialog which is presented for software switch setup depends upon the type of the SIOU and allows the software 
switch memory area associated with a mounted SIOU to be configured. Software switches provide status 
information on each SIO unit on the PLC. 

Note: It is also possible to edit the Inner Board software switches for the CS/CJ series PLC if 
fitted by selecting Inner Board Software Switches option from the PLC’s context menu. 

The Software Switch dialog is displayed allowing the network unit system memory area to be configured and 
transferred to the PLC. Software switches can be defined for the following: 

♦  SYSMAC LINK. Allows set up of Data Link (on/off) and Internode Test (on/off) and setting of response 
monitor time; 

♦  SYSMAC NET. Allows set up of Data Link (on/off) and Internode Test; (on/off);  
♦  Ethernet. Allows set up of Internode Test (on/off) and setting of response monitor time. 
♦  Controller Link. Allows the polling status of the node to be set (whether it is a polling or polled unit) and 

whether to clear the Controller Link unit EPROM. 
Use the following procedure to edit the Software Switch Setup. 

1, 2, 3… 1. Highlight the rack/unit in the IO Table tree. 
 2. Click the right-mouse button and select Software Switches. 
 3. Set the required software switch setup options for the specified rack/unit. 

General 
The General tab of the Software Switches dialog provides the complete software switches settings for a Basic unit, 
PC unit, Mini-map unit, Host Link unit, Motion Control unit, ME-Net unit, DeviceNet Master unit and ISO Baud 
unit. It also serves as partial software switches settings for other units. 

1, 2, 3… 1. Access the Software Switch dialog for an appropriate rack/unit. 
 2. Set the required CIO and DM area address in the CIO Address field and DM Address field. 

Data Link Area 
The Data Link tab is used to control whether Data Link is generated automatically or by a specific Data Link table 
for SYSMAC LINK, SYSMAC NET and Controller Link. This setup is only used if the Node Type is Master. The 
list box at the bottom of the chapter is only used when Data Link is set to one of the automatic options (i.e. not 
specific). 

1, 2, 3… 1. Select Transfer from PLC from the Options menu to transfer the current system area settings 
from the unit. 

 2. Select the required unit and click the right-mouse button. Select the Software Switches 
setting. 

 3. Adjust the settings as required. 
 4. Select Transfer to PLC from the Options menu to transfer the network parameters to the 

unit. 
 5. Select the Reset Unit setting to restart the unit - the written settings are activated in the unit. 

Note: If the unit which is being set is the one on which the current communication to the PLC 
is being made, the PLC needs to be closed and opened before communications can 
continue. 

Ethernet 
The Ethernet setup differs from SYSMAC LINK, SYSMAC NET and Controller Link by not having a Data Link 
Area setup and by having two further dialog boxes, the IP Address Table and IP Router Table. This particular 
interface requires that each device attached to the network has an IP address, and that routing information for 
directing data across the network is also included (where necessary); such address information ensures that data is 
transmitted correctly between two nodes. 

Note: Table information is only used if the IP Address Conv. Method radio button is not set to 
Auto. 
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The File Transfer Protocol (FTP) allows access to a file card on the PLC. If a FTP login name and password are 
entered then these are used to start an FTP session. For more information, refer to the Ethernet User’s Manual. 

The IP Address Table dialog allows the IP address of a network node to be entered. 

1, 2, 3… 1. Select the Ethernet Unit from the IO Table and click the right-mouse button. 
 2. Select the Unit Setup option. 
 3. Click on the Insert pushbutton. 
 4. Enter the IP Address for the node in the IP Address field; each of the four fields must take a 

value in the range 0 to 255. 
 5. Select the OK pushbutton to proceed. 
 6. Click on the Delete pushbutton to remove the address from the table. 
 7. Select Transfer from PLC from the Options menu to write the changes back to the table. 

The IP Router Table establishes communications between different networks by maintaining the IP address for 
each interface and is created by clicking on the Insert pushbutton above the IP Router table dialog. Procedures are 
the same as for the IP Address Table described above. 

Syslink Unit and Controller Link Specific Settings 
A Syslink unit Software Switches dialog includes a General tab and Data Link tab described previously. 

The Error Information tab provides read-only information regarding the errors that the PLC can detect and raise an 
error flag. 

The Network Status tab provides network status information. It also activates the PLC to perform internode tests. 
Select the Start option to set the PLC to check for errors and report them. Select the Stop option to stop the PLC 
from detecting errors. The Network Node List field lists the network nodes and whether they are participating in the 
network operations. 

Sysmac-Bus2 Unit Specific Settings 
A Sysmac-Bus2 unit Software Switches dialog includes a General tab described previously. 

The Slave tab provides specific status information to the Sysmac-Bus2 unit. There are various types of slave that 
may be connected to a Remote IO Master unit. These slaves include IO Terminals, Programmable Displays and 
Remote IO Slave units. 

To view the slaves connected for a group, select the Group required from the field at the top of the Slaves tab. The 
remainder of the Slaves tab displays the Node and Status for each category. 

If the hierarchy of the IO Table has been expanded, the three groups can be populated with other units: 

♦  Group 1. 16-point and 32-point IO units. 
♦  Group 2. 16-point, 32-point, 64-point and 128-point IO units and 256-point dummy. 
♦  Group 3. 58M Remote Terminal, 54MH Remote Terminal and 122M Remote Terminal. 
 

Serial Communications Unit Specific Settings 
Serial Communications unit specific software switches settings can only be set for CS/CJ/CP series PLCs. 

A Serial Communications unit Software Switches dialog includes a General tab described previously. 

The Port 1 tab and Port 2 tab are identical. Settings can be specified for the Format field, Mode field and Hardware 
field. 

Displaying Unit Error Log in the IO Table 
By selecting a CPU Bus Unit or Special IO Unit in the IO table tree and clicking the right mouse button to select the 
Unit Error Log Menu, the error log for the selected Unit can be displayed (CX-Programmer Ver. 4.0 or later). 
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IO Table Management 
Changes made to an IO Table can be done by simply editing particular fields in the table. Basic information can be 
changed by displaying the configuration, selecting the rack or unit that needs to be changed and editing or selecting 
the new IO address or configuration information. 

All slot allocations in the IO Table can be cleared. Select Clear from the Options menu. 

An IO Table unit in the PLC’s Registered IO Table in the PLC can be deleted. Use the following procedure to 
delete an IO Table Unit.  

1, 2, 3… 1. Highlight the rack/unit in the IO Table to be deleted. 
 2. Click the right-mouse button and select Delete. 

The CX-Server IO Table component can be examined to determine if it has a valid configuration. To check an IO 
Table, select the Check option from the Options menu. A message is displayed indicating whether the operation 
was successful or not.  

The CX-Server IO Table component can compare the local IO Table on the PC with the CX-Server project settings 
and displays any differences or errors. Select the Compare with Project option from the Options menu.  

PC to PLC Communications 
The IO Table component permits the transferring of data to and from the PLC and allows comparisons to be made 
between data stored on the PC and the PLC.  

Note: If the CX-Programmer is Ver. 6.0 or later and the PLC is a CS/CJ/CP-series PLC, the 
Special I/O Unit and CPU Bus Unit parameter settings can be transferred as well as the 
I/O table.  

Transfer an IO Table from a PLC 
The Transfer from PLC option loads the Registered Table into the CX-Server IO Table, replacing the currently 
displayed setup. The IO Table can also be part of a general transfer which may, for example, include transferring 
program and memory data from the PLC. Use the following procedure to transfer an IO Table from the PLC. 

1, 2, 3… 1. Ensure the PLC is online before activating the IO Table component. 
 2. Select Transfer from PLC from the Options menu to transfer an IO Table from the PLC. 

The IO Table component is refreshed with the details from the PLC. 

Note: If only I/O Table is selected and only the I/O tables are uploaded from the actual PLC to 
the computer, the settings in the Special I/O Units or CPU Bus Units on the computer 
will be initialized. To maintain the same settings, save the Special I/O Unit or CPU Bus 
Unit settings to a file by right-clicking the Unit in the I/O table and selecting Save 
Parameters from the pop-up menu. Then, after uploading the I/O tables, read the settings 
back from the file by right-clicking the Unit in the I/O table and selecting Load 
Parameters from the pop-up menu.  

Transfer an IO Table to a PLC 
The Transfer to PLC option loads the CX-Server IO Table into the Registered Table: this is only available to 
C2000, CV and CS1-series PLCs. The table can be transferred to the PLC at any time (when the PLC is online) but 
the operation can be delayed until other configuration settings have been made and then the complete configuration 
can be transferred to the PLC via the PLC Setup component. Use the following procedure to transfer an IO Table to 
the PLC. 

1, 2, 3… 1. Ensure the PLC is online before activating the IO Table component. 
 2. Select Transfer to PLC from the Options menu to transfer an IO Table to the PLC. 

Note: If the PLC Setup area is either written to the PLC or to the IO Table area the PLC may 
need to be powered down and powered up in order for settings take effect. If the settings 
need to be changed without switching off the PLC, write the PLC Setup data first, then 
either generate or write the IO Table. Refer to Chapter 4 - PLC Setup Component.  
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Comparing an IO Table 
The Registered IO Table can be compared with the CX-Server IO Table and displays any differences. This option 
is helpful to confirm that a table that has been set up in CX-Server and has been transferred to the PLC, agrees with 
how the hardware is set up. Use the following procedure to compare a Registered IO Table with the CX-Server IO 
Table. 

1, 2, 3… 1. Ensure the PLC is online before activating the IO Table component. 
 2. Select Compare with PLC from the Options menu. 

Any differences (if any) are displayed in the IO Table component. 

Starting Specialized Support Tools 
Starting Specialized Programming Support Tools (Supported When Support Tools Were Installed from CX-One) 

When the CX-Programmer and other Programming Support Tools have been installed from the CX-One, the 
Programming Support Tool specific to a particular Unit (Special I/O Unit or CPU Bus Unit) can be started directly 
from the CS/CJ/CP I/O Table Window by right-clicking the desired Unit in the I/O table and selecting Start Special 
Application from the pop-up menu. 

♦  If the Unit is right-clicked in the I/O table and Start Special Application - Start with Settings Inherited is 
selected, the PLC model information, Unit model, and online/offline status information will be passed to the 
Programming Support Tool automatically when it starts. 

♦  If the Unit is right-clicked in the I/O table and Start Special Application - Start Only is selected, the 
Programming Support Tool will be started in the same way as it is from the Windows Start Menu. 

The following diagram shows how each Programming Tool can be started and how the I/O Table Window can be 
opened from the Programming Tool. 
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CX-Programmer 

 

I/O Table 

 
 
 
 

CX-Integrator 

 
CX-Position 

 
CX-Protocol 

 
CX-Process Support Software

 
CX-Motion 

 
CX-Motion-NCF 

Serial Communication Board/Unit 
(CS1W-SCB@@) 
(CS1W/CJ1W-SCU@@) 

Position Control Unit 
(CS1W/CJ1W-NC@@@) 

Motion Control Unit 
(CS1W-MC@@@) 

Loop Control Unit/Board 
(CS1W-LC001/LCB@@) 

Loop CPU Unit 
(CJ1G-CPU@@P) 

Process CPU Unit 
(CS1D-CPU@@P) 

Controller Link Unit 
(CS1W/CJ1W-CLK@@) 

Ethernet Unit 
(CS1W/CJ1W-ETN@@) 

SYSMAC LINK Unit 
(CS1W-SLK@@) 

DeviceNet Unit 
(CS1W/CJ1W-DRM@@) 

MECHATROLINK-II Position Control Unit 
(CJ1W-NCF@@) 

CS/CJ-series CPU 
Unit 

The CX-Programmer can be 
started from a CS/CJ-series 
PLC in the Network 
Configuration Window. 

CS/CJ/CP Series CPU Unit 

CPU Rack 

The I/O Table 
Window can be 
opened only when 
online.

The I/O Table 
Window can be 
opened only when 
online. 

The I/O Table Window 
can be opened only 
when online. 

Start Special Application 

CX-One

 
CX-FLnet 

 
CX-Motion-MCH 

MECHATROLINK-II Motion Control
Unit 
(CS1W/CJ1W-MCH@@) 

Profibus-DP Master Unit 
(CS1W-PRM@@) 

FL-net Unit 
(CS1W/CJ1W-FLN@@) 

 

 

Note: With some of the Programming Tools (CX-Integrator, CX-Protocol, and CX-Process 
Tool), the I/O Table Window can be opened from the Programming Tool as shown by 
the dotted lines above, but only when the PLC is online.  
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PLC Specific Features 
A number of features specific to types of PLC are described in the following paragraphs. 

Hot Swapping 
Hot swapping is permitted for C1000H/C2000H PLCs and allows modules to be changed without having to power 
down. The modules swapped must be identical. To Hot Swap, select the Hot Swap option from the Options menu. 

Note: With a CS1D or CVM1D CPU Unit, hot swapping (i.e., online replacement) is possible 
during operation for Basic I/O Units and, for the CS1D, Special I/O Units and CPU Bus 
Units as well. Open the I/O tables for the project, select the Unit to be replaced, and 
select Hot Swap from the Options menu. Click the Start Hot Swap button, remove the 
old Unit, mount the new Unit and click the End Hot Swap button. Perform this operation 
for each Unit to be replaced. 

   
 

Note: Online replacement is possible for a CS1D or CVM1D CPU Unit in any operating mode. 
Use the following settings in the Change PLC dialog box. 

CPU Unit being used PLC type selection list CPU Unit model  

CS1D CS1H-H CPU65 or CPU67 

CVM1D CVM1-V2 CPU21 
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Setting Rack Start Addresses 
This option is only available to CV-series PLCs and CS1-series PLCs. Use the following procedure to set Rack 
Start Addresses. 

1, 2, 3… 1. Select Rack Start Addresses from the Option menu. The Rack Start Addresses dialog box is 
displayed. 

 2. Enter the addresses for each rack as required. Select the OK pushbutton to accept the 
settings or select the Cancel pushbutton to abort the operation. 

Note: 1. For CS1-H, CJ1-H, CJ1M, and CS1D CPU Units in the CS- and CJ-series PLCs, 
select Options | Rack/Slot Start Address and the following dialog box will appear. 

   

Note:  2. Select Slot Start Address Settings and click the OK button. The Slot Start Addresses 
Settings dialog box shown below will appear. 

   

Note:  3. The start address for a Rack and slot number can be specified.  
This can be used, for example, to allocate fixed addresses to Input Units and Output 
Units. Note: The start address information set for Racks and slots can be downloaded 
and uploaded for the CPU Unit. 
4. For CS/CJ-series CPU Unit Ver. 2.0 or later with CX-Programmer Ver. 4.0 or later, 
up to 64 sets of rack/slot numbers and start addresses can be set. 

Units Profile Information 
For CS1-series PLCs, SIOU’s, CPU SIOU’s and other units, unit manufacturing information can be retrieved, the 
data read and comments saved against each unit to a Compact Flash disk when fitted. Use the following procedure 
to view the unit manufacturing details: 

1, 2, 3… 1. Highlight the PLC name and click the right-mouse button. 
 2. Select Unit Manufacturing Information and then either CPU Unit or Inner Board 

 Note:  An error is displayed if the unit does not support manufacturing information. The 
unit version for CS/CJ/CP-series Units can be checked in the Unit Manufacturing 
Information (CX-Programmer Ver.4.0 or later only). 

 



  

 



 CX-Server PLC Tools  
OMRON CHAPTER 4 – PLC Setup Component 
 
 

 CX-Server PLC Tools Page 35 

 CHAPTER 4 
PLC Setup Component 

This chapter describes the PLC Setup component and the procedures involved in changing a PLC’s settings both 
offline and online. 

The PLC Setup component allows the PLC settings to be entered for individual C-series PLCs, CV-series PLCs or 
CS1 PLCs. More than one PLC Setup component can be opened at any one time allowing a number of PLCs to be 
configured simultaneously. 

Once a PLC has been defined in a project in terms of name, device type and network type, changing various settings 
allows the PLC behavior to be altered. Options can also be selected to check the PLC is functioning correctly. 

The tabbed PLC settings component shows only options available for the selected PLC. Some options will be 
greyed out in instances where they are not applicable to the PLCs current state. 

The status bar displays the PLC and CPU type and the operational mode of the PLC. 

Note: When configuring a PLC it is advisable to have the PLC operational manual available 
for reference. A warning is displayed before any changes are made to a PLC’s current 
state. This gives the option of cancelling the procedure. 

Note: The information provided in this chapter is not definitive because of the wide variety of 
PLCs and their differing nature - even within the same PLC series. Consult the relevant 
PLC operating manual for specific PLC settings information. 

The PLC Setup component can be forced to stay as the top window by selecting the Always on top option from the 
Options menu. 

For Moving, resizing, maximising, minimising and closing windows, refer to Microsoft Windows online help. 

Access to the PLC Setup component is from the invoking application and also via the CX-Net Network 
Configuration Tool, refer to Chapter 8 - CX-Net Network Configuration Tool for further information. 

 To close the PLC Setup dialog, select the Close button in the title bar.  

CS/CJ/CP-Series PLC Settings 
The following paragraphs describe the features of the PLC Setup component associated with CS/CJ/CP-series 
PLCs. Refer to Chapter 4 - PC to PLC Communications for details of transferring PLC setup information to and 
from the PLC. 

The common Set Default option resets PLC Setup component values to the default settings. 

PLC Startup 
The PLC Startup tab of the PLC Setup component allows certain PLC settings to be made which always take effect 
on startup (until they are explicitly altered). Use the following procedure to apply settings in the PLC Startup tab. 

Startup Hold 
The Hold area in the PLC’s Work Area Memory retains the status when either the operating mode is changed, 
power is interrupted or the PLC operation is stopped. You can select one or all the following options for the hold 
area to retain. 

1, 2, 3… 1. Force Status Hold Bit - Specifies that the status of the forced status hold bit is to be 
maintained (ticked) or reset to OFF when power is next turned on. 

 2. IOM Hold Bit - Specifies that the status of the IOM hold bit is to be maintained (ticked) or 
reset to OFF when power is next turned on. 

Mode 
This selects the default PLC operation mode when the PLC is powered on: 

♦  Program - Select this for online programming when the PLC is powered on. 
♦  Monitor - Select this to start monitoring the running program when the PLC is powered on. 
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♦  Run - Select this to run the PLC’s program when the PLC is powered on.  
♦  Use Programming Console - This is the default setting that allows you to select the operating mode when 

online. 
In addition to the above, the following settings are available for CJ1-H, CS1-H, and CP1H PLCs. 

Execution Settings 
For the CJ1-H, CS1-H, and CP1H PLCs series PLCs set the Execution Setting options as appropriate. 

1, 2, 3… 1. Run program when initialize unit/board. Check the tick box to select this option. 
 2. Service for units when Inner Board recognition. Check the tick box to select this option. 

Settings 
The Settings tab of the PLC Setup component allows execution processes and controls to be defined and EM 
allocation to be enabled. 

Note: For CS1-H, CJ1-H, and CP1H PLCs only, this tab is called CPU Settings. 

Execute Process 
Use the following procedure to apply Execute Process settings. 

1, 2, 3… 1. Low Battery Enabled - Select (tick) this option to flag when CPU Unit battery errors are 
detected.  

 2. Interrupt Task Enabled - When this option is selected interrupt task errors will be detected. 
 3. Stop CPU Error Enabled - Select this option to determine if instruction errors (instruction 

processing errors (ER) and illegal access errors (AER)) are to treated as non-fatal or fatal 
errors. 

 4. Don't register FAL to error log - Select this option (tick) to stop registering FAL to error 
log. 

Memory Allocation 
CS/CJ-series PLCs can select either Memory Card or EM (Expansion Memory) specified file area. Each time EM 
is selected, the EM is reformatted automatically. 

To use EM rather than Memory Card, select the EM File Setting enabled setting and enter the EM Start File No. 
CS/CJ-series PLCs can use EM as file memory, either as or as well as Compact Flash disk. When transferred to the 
PLC, EM is formatted. 

In addition to the above, the following settings are also available for CJ1-H and CS1-H PLCs. 

Background Execution 
1, 2, 3… 1. Table data process instructions. Check the tick box enable Table date process instructions. 

 2. String data process instructions - Select (tick) this option to enable String data process 
instructions. 

 3. Data shift process instructions - Select (tick) this option to enable Data shift process 
instructions. 

 4. Com port number - Enter a number between 1 and 7 inclusive, to set the Com port you wish 
to connect by.  
Caution: Entering a com port number higher than the number of ports actually available will 
prevent future connections to that PLC. 

Timings 
The PLC Timings tab of the PLC Setup component allows cycle, interrupt and event timings to be defined. Use the 
following procedure when applying settings in the PLC Timings tab for standard CS/CJ/CP-series PLCs. When 
setting the timings for other PLC types follow the on-screen instructions. 

1, 2, 3… 1. Check the Watch Cycle Time setting and set the watch cycle time if enabled for the PLC; the 
default is 0 ms. 

 2. Deselect the Set Time to all Events setting to enter a time period for all event processes; this 
is entered as a percentage of the total cycle time. 
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 3. Check the Power Off Interrupt setting, and set if enabled for the PLC; the default is 0ms. 
 4. Set the Cycle Time setting to define the time interval for cycles. 
 5. Set the Scheduled Interrupt Interval setting to schedule interrupts to occur at regular 

intervals; either every 10 ms or a specific value can be set. 

SIOU Refresh 
The SIOU Refresh tab of the PLC Setup component allows SIOU Status to be enabled. Check the required Enable 
SIOU Status setting for each SIOU in the field. 

Unit Settings 
The Unit Settings tab of the PLC Setup component allows timings for the individual rack slots associated with the 
PLC to be set. Select the required slot(s) from the rack field and the required unit setting; the default is 8 ms. 

Host Link Port 
The Host Link Port tab of the PLC Setup component defines the protocol which allows transferring data between 
the PLC and the host PC. The default settings may be used or an alternative communications protocol defined. 
Some of the options may not be applicable depending on the device type selected. Use the following procedure to 
apply settings in the Host Link Port tab. 

1, 2, 3… 1. The Port Settings default is 9,600 bps, 1 start bit, 7-bit data, 2 stop bits and Even parity. 
Customised port settings can be entered by deselecting the Default setting. 

 2. Select the CTS Control setting to enable use of CTS. 
 3. Set the Unit Number setting for the selected PLC. 
 4. Set the Delay value; a pre-set transmission delay in the range 0000 to 9999 (for BCD this is 

in 10 ms units). 
The following entries cannot be amended: 

♦  Link Words. These word addresses are fixed at LR00 to LR63 (or bit addresses from LR0000 to LR6315). 
♦  Start Code and End Code. The message start and end codes. 
♦  NT Link Max. 

Peripheral Port 
The Peripheral Port tab of the PLC Setup component defines the connection between the PC and PLC. The default 
settings may be used or an alternative communications protocol defined. Use the following procedure to apply 
settings in the Peripheral Port tab. 

1, 2, 3… 1. The Port Settings default to 9600 bps, 1 start bit, 7-bit data, 2 stop bits and Even parity. 
Customised port settings can be entered by deselecting the Default setting. 

 2. Set the Unit Number setting for the selected PLC. 
The NT Link Max setting cannot be amended. 

Peripheral Service 
Note that this tab is only available for the CS1-H and CJ1-H PLCs (CS1G-H, CS1H-H, CJ1G-H and CJ1H-H). 

The tabbed dialog is split into three sections as follows: 

Sync/Async Comms 
Execution Mode - The default for this option is Not Specified, and as such means that all other parts are disabled 
except for Set time to all events. 
Select one option from the list to set the execution mode. Choosing Not Specified will disable all the options within 
the Peripheral Service dialog, except for 'Set time to all events'. Not Specified is the only way of setting the 
Peripheral Service Execution Time to zero. 
If Peripheral Service is chosen, editing Peripheral Service Execution Time is possible, and the system sets the 
default to 0.1. See also Instruction Processing (Peripheral Service Execution Time). 
Specifying Asynchronous will disable the same options as Not Specified, and set the Execution mode to 
Asynchronous processing. Synchronous likewise sets the Execution Mode to Synchronous processing. 
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Peripheral Service Mode 
Instruction Execution Time - A value within and including the range of 5 to 255 or 0 can be entered as a valid 
setting. 
Peripheral Service Execution Time - A value within and including 0.1 to 25.5 can be entered as a valid setting. For 
more information on when this option is available, see Sync/Async Comms, Execution Mode, above. 
Target Unit (1, 2, 3, 4, 5) and SIOU - The default for this setting is Not Specified. There are five possible options 
for this setting. After Not Specified, the next option is CPU SIOU. If this option is selected, the SIOU number 
should be entered in the box to the right marked 'SIOU'. The next option is SIOU, and likewise with the CPU SIOU 
option, the SIOU number should be entered in the box to the right marked 'SIOU'. The three remaining options 
allow either the Inner Board, Host Link Port or Peripheral Port to be set as the 'Target Unit'. 

Set time to all events 
Set time to all events (default 4%) - By ticking the checkbox, the default as stated above will be set. If the checkbox 
is not ticked, then a value between 0 and 255 inclusive can be entered, making a maximum setting of 25.5 (255 
*0.1). This option is found in the Timings tab for all other CS/CJ-series PLCs. 

Duplex Settings 
The Duplex Setting tab is activated by selecting the Duplex Settings option from the PLC Settings Options menu.  

 
With this option checked, use the Tabs scroll buttons to scroll to the right and click on the Duplex Settings tab to 
bring it to the front. The options in this dialog can now be set to provide the appropriate communications setup 
within the selected Communications Units. The dialog is divided into five sections as follows: 

Note: The Duplex Setting tab is available for CS1H-H 65 & 67 PLCs but is only applicable to the CS1D series 
PLCs. 

Operation Settings 
Run under Duplex Initial – This option should be selected if it is required to run two Units in parallel with Duplex 
Initial execution. Note that this setting only takes effect at startup or at the start of an operation. It cannot be 
changed during an operation. 

Return Automatically – Select this option when it is required to execute a process that returns to Duplex Operation 
automatically. 

Communications Unit Duplex Setting 
From the list of Communications Units select those that are to be run in duplex mode. If more than one Unit is set 
to duplex mode the options selected will be applied to each Unit. It is not possible to set different options for 
different Communications Units. To execute the Communication Duplex operation an IO table must be created or 
transferred. Note that this setting only takes effect at startup or at the start of an operation. It cannot be changed 
during an operation. 

Hot Swap 
Allow Plural Units - Selecting this option enables Units operating in Parallel or Duplex mode to be replaced while 
online. The Units, which can be exchanged while online are, Basic IO Units, SIOUs, and CPU SIOUs of the 
CS-Series PLCs. Note that this option can be selected while online. 
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STB Serial Settings 
Allow STB-COMM – Selecting this option will enable the Host Link Port of the Standby CPU. This option should 
not be selected if it is required to continue with communications when changing from Duplex operation to Standby 
operation. 

CPU Unit Duplex Transfer Settings 
Transfer Program – This option should be selected if it is required to skip the Transferring Program area at Duplex 
Initial operation after exchanging CPU units, (Verify will be executed). If programs can be matched beforehand, 
use this setting to reduce the Duplex Initial Operation time. 

EM Division Transmission – This option should be selected when it is required to transfer Duplex Initial data in 
specified EM sizes. If the option is not selected the complete EM area will be transferred at once. Note that this may 
cause the cycle time to be expanded for a short time. 

Division Size – If the EM Division Transmission option has been selected the value entered for the division size 
will determine the size of the EM area to transfer. Note that this setting only takes effect at startup or at the start of 
an operation. It cannot be changed during an operation. 

Transfer Parameter Area of Inner board – Select this option when it is required to transfer the Parameter Area of 
the inner board between Units. 

Transfer Variable Area of Inner board – Select this option when it is required to transfer the Variable Area of the 
inner board between Units. 

CV-Series PLC Settings 
The following paragraphs describe the features of the PLC Setup component associated with CV-series PLCs. 
Refer to Chapter 4 - PC to PLC Communications for details of transferring PLC setup information to and from the 
PLC. 

The common Set Default option resets PLC Setup component values to the default settings. 

PLC Startup 
The PLC Startup tab of the PLC Setup component allows certain PLC settings to be made which always takes 
effect on startup (until they are explicitly altered). Some of the options may not be applicable depending on the 
device type selected. Use the following procedure to apply settings in the PLC Startup tab. 

1, 2, 3… 1. The status of the Force Status Hold setting, IOM Hold Bit setting and Restart Continuation 
Bit setting in the Startup Hold area of the PLC’s Work Area memory can be set so that they 
are either maintained or reset to OFF on power up.  

 2. When power is restored after an interruption, the IO Bits setting and Power-On Status 
setting must be selected and the PLC startup mode must be set to Run or Monitor. 

 3. Set the Mode setting to either Program, Monitor, Run, Debug or Use Programming 
Console. The default mode is Program. 

 4. Set the Display Mode setting. The 7-segment display of the IO Interface units, IO Control 
unit and SYSMAC BUS/2 Remote IO Slave units can be set to one of three modes. The 
mode is indicated by the position of the decimal point. 

 ♦  Mode 1. Displays the first IO word allocated to the rack (000 indicates an error). This is the 
default mode. 

 ♦  Mode 2. Displays the CPU operating status (A or -) and error status 
(E, F or -), peripheral connection and rack number. 

 ♦  Mode 3. Displays a 4-character message when the IODP (189) instruction is executed in the 
unit’s program. 

 5. Check the Automatically Transfer User Program setting to automatically transfer the user 
program from one of the PLCs memory cards when the PLC starts-up. 

 6. Check the Display modes at startup setting to display all selected modes on startup. 
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Error Log  
The Error Log tab permits certain settings to be applied to error logging. Either Data Memory (DM) or Extended 
Memory (EM) areas can be selected to hold the PLC’s Error Log. Refer to Chapter 6 - PLC Error Component for 
a description of the Error Log. Use the following procedure to apply settings in the Error Log tab. 

1, 2, 3… 1. Check the Enable Error Log setting to enable error logging. If this is not selected, the 
default log auxiliary memory is assigned. 

 2. Enter the Start Address setting for the error log. This is only enabled if the Enable Error Log 
setting has been selected. 

 3. Enter the EM Bank Number setting if the Error Log is to be stored on an installed Extended 
Memory Card. The Start Address setting needs to be set to the relevant area of EM. This is 
only enabled if the Enable Error Log setting has been selected. 

 4. Enter the Number of Records setting for the number of records to be held in the PLC Error 
component. 

Note: An Error Log in the Auxiliary Area (words A100-A199 for CV1000) can contain up to 
20 error records. To increase the size of the log (to 2047 records), move it to either the 
DM or EM areas. 

Execution Controls 
Instructions can be executed and peripheral servicing performed by either using: 

♦  Event driven (asynchronous) processing mode. The peripheral servicing process interrupts the execution 
process cycle by sending IO refresh requests. 

or 
♦  Synchronised processing mode. The execution and peripheral servicing processes wait for each other to 

complete the task in hand.  
Consult the PLC operational manual for details when defining the execution controls. Use the following procedure 
to apply settings in the Execution Controls tab. 

1, 2, 3… 1. An operand can be indirectly addressed via the DM area in either Binary or BCD. Select the 
Binary setting or the BCD setting as required. 

 2. Set the Step Timer setting for the SFC step instructions. The default is 0.1 s. 
Note: For CV1000, CV2000 and CVM1/CPU21-EV2 PLCs, EM can be used for indirect 

addressing of an operand. 

Note: The Step Timer setting is not available to CVM1 PLCs. 

Execution Controls 1 
Use the following procedure to apply settings. 

1, 2, 3… 1. Check the Measure CPU-Bus Unit Cycle setting for the CPU to measure the service cycle. 
 2. Check the Detect Low Battery setting to flag PLC and Memory Card low battery. 
 3. Check the CPU standby on initialisation of bus units setting to ensure the CPU remains in 

standby until SYSMAC BUS/2 terminators are detected. If this is not checked, PLC 
operation begins regardless of the presence of terminators. 

 4. Check the Error on power off interrupts setting to ignore a momentary power interruption 
(and not generate an error) or leave unchecked to generate an error on power off. 

Execution Controls 2 
Check the following settings as required. 

♦  The Duplication action error setting. 
♦  The Multiple JMP000 use setting. 
♦  The Run program on IO verify error setting. 
♦  The Startup trace setting. 
♦  The Nest IO interrupts setting. 
♦  The IO Interrupt setting. 
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Host Link Port  
The Host Link Port tab of the PLC Setup component defines the protocol which allows transferring data between 
the PLC and the host PC. The default settings may be used or an alternative communications protocol defined. 

Use the following procedure to apply settings in the Host Link Port tab. 

1, 2, 3… 1. The Port Settings default to 9600 bps, 1 start bit, 7-bit data, 2 stop bits and Even parity. 
 2. Select a Unit Number setting for the Host Link port setting. This has a maximum value of 

31. 

IO Refresh  
The IO Refresh tab of the PLC Setup component allows the specification of refreshes and their definition as either 
timed or immediate refreshes. Some of the options may not be applicable depending on the device type selected. 
Use the following procedure to apply settings in the IO Refresh tab. 

1, 2, 3… 1. Check the Zero-cross setting to ensure output devices accurately switch on/off high power 
devices when minimum current is flowing (when the AC power supply crosses zero). 

 2. Check the Cyclic setting to generate a cyclic refresh at the end of program execution. 
 3. Check the Scheduled setting to specify a time interval between interrupt refreshes. This is in 

the range 0 ms to 120 ms. 
 4. Check the Immediate Refresh setting to allow program instructions to be set to interrupt for 

immediate refreshing. The Scheduled refresh setting must be set to 00 ms. 
Note: Scheduled refreshing is not available if the PLC is set for synchronous operation. 

Address Enable 
The Address Enable tab of the PLC Setup component allows addresses to be entered for selected local racks. Some 
of the options may not be applicable depending on the device type selected. Use the following procedure to apply 
settings in the Address Enable tab. 

1, 2, 3… 1. Enter an address for each required Local rack setting. The first word can be set between 0 
and 511. Word allocations must not overlap. The default for the CPU rack is zero. If word 
allocations overlap, they are ignored and the address returns to zero. Racks selected without 
a designated first word is allocated words automatically beginning from CIO 0000. 

 2. Enter the Group 1 and Group 2 values. This is the first word between CIO 0000 and CIO 
0999 for each SYSMAC BUS/2 Group 1 and 2 Masters. 

 3. Enter the Group 3 values. These are the first word for each SYSMAC BUS/2 Group 3 Slave 
between CIO 0000 and CIO 0999 for each SYSMAC BUS/2 Group 1 and 2 Masters and the 
first word for each SYSMAC BUS/2 Slave rack between CIO 0000 and CIO 2555. 

 4. Enter the RT Terminals, SIOU and IO terminals addresses as required. 
Note: Each group (Group 1, 2 and 3) has pre-set values assigned as a default. Group 1 and 

Group 2 supports 32 and 16 IO units respectively. Group 3 is reserved for racks and 
supports eight racks, each of which supports eleven slots. 

PLC Timings  
The PLC Timings tab of the PLC Setup component allows cycle, interrupt and event times to be set. Use the 
following procedure to apply settings in the PLC Timings tab. 

1, 2, 3… 1. Check the Watch Cycle Time setting and set the watch cycle time if enabled for the PLC; the 
default is 1000 ms. 

 2. Check the Power Off Interrupt setting, and set if enabled for the PLC; the default is 0 ms. 
 3. Set the Cycle Time setting to define the time interval for cycles. 
 4. Set the Scheduled Interrupt Interval setting to schedule interrupts to occur at regular 

intervals; either every 10 ms or a specific value can be set. 

Hold 
The Hold tab of the PLC Setup component allows the Hold area of the PLC’s Work Area memory to be defined. 
Use the following procedure to apply settings in the Hold tab. 
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1, 2, 3… 1. Check the Enable Hold Area setting to enable the Hold area and select its Start and End 
Address settings. 

 2. Check the required racks from the CPU field. 
 3. Check the required Sysbus/2 remote master from the Sysbus/2 Remote Master field. 
 4. Check the required Sysbus remote master from the Sysbus Remote Master field. 

C-Series PLC Settings 
The following paragraphs describe the features of the PLC Setup component associated with C-series PLCs. Refer 
to Chapter 4 - PC to PLC Communications for details of transferring PLC setup information to and from the PLC. 

The common Set Default option resets PLC Setup component values to the default settings. 

PLC Startup 
The PLC Startup tab of the PLC Setup component allows certain PLC settings to be made which always take effect 
on startup (until they are explicitly altered). Use the following procedure to apply settings in the PLC Startup tab. 

Mode 
This option selects the default PLC operation mode when the PLC is powered on. 

1, 2, 3… 1. Program – Select this for online programming when the PLC is powered on. 
 2. Monitor – Select this to start monitoring the running program when the PLC is powered on. 
 3. Run – Select this to run the PLC’s program when the PLC is powered on. 
 4. Pre-Powerdown mode – In this mode the PLC uses the operating mode last used before the 

power was turned off. 
 5. Use Programming Console – This is the default setting that allows you to select the 

operating mode when online. 

SIOU 
The SIOU Area DM settings are highly PLC specific and are dependent upon PLC selected and the SIOU mode. 
Refer to the online help for detailed information. 

IOM 
This option specifies that the status of the IOM hold bit is to be reset to OFF (ticked) or maintained when power is 
next turned on. 

Forced Status 
This option specifies that the status of the forced status hold bit is to be reset to OFF (ticked) or maintained when 
power is next turned on. 

Console Language 
Select the Console language to either English or Japanese as appropriate (CPM1/1A only). 

Expansion Instructions 
Set to either Default or User Settings. This option is only available for SRM1, CPM2* PLCs. 

CompoBus/S Devices (CPM2*-S*) 
Select the Maximum number of CompoBus and S Devices to either 16 or 32. 

Communications Mode (CPM2*-S*) 
Sets the communications mode to either High-Speed or Long-distance. 

Memory Error on Capacitor Failure 
Select this option if a memory error on capacitor failure is to be recorded. 



 CX-Server PLC Tools  
OMRON CHAPTER 4 – PLC Setup Component 
 
 

 CX-Server PLC Tools Page 43 

Cycle Time 
The Cycle Time tab of the PLC Setup component allows the total cycle time for the CPU unit to be defined. This 
period is the time taken to complete monitoring, program execution and IO port servicing. Use the following 
procedure to apply settings in the Cycle Time tab. 

1, 2, 3… 1. Cycle Monitor Time setting. This option sets the time allowed for the CPU unit to cycle 
through the type of operations indicated above. If it is exceeded, an error is generated and 
the CPU unit is stopped. 

 2. Cycle Time setting. Use this option to define a minimum cycle time by selecting a time 
period in the range 1 to 9,999 ms. The default is Variable (with the CPU calculating the 
cycle time in each cycle). 

 3. Servicing Time setting. This option allows the percentage of the defined cycle time which 
can be used to service a port to be set. It can be set for the Peripheral Port, RS232C Port, 
Comms Port A and Comms Port B. 

Note: The Cycle Time setting is ignored if the Cycle Monitor Time setting is longer and vice 
versa (provided a minimum time has been defined). The CPU unit waits until the longer 
of the two time periods has elapsed before starting the next cycle. 

Interrupt/Refresh 
The Interrupt/Refresh tab of the PLC Setup component allows certain PLCs to interrupt the main program by input 
and scheduled interrupts in order to call a subroutine. Use the following procedure to apply settings in the 
Interrupt/Refresh tab. 

1, 2, 3… 1. Interrupt Response - Set the interrupt mode to High Speed to interrupt immediately or to 
Normal to wait for the current process to complete. 

 2. SIOU Refresh setting - This option must be set to Disable Refresh when the Interrupt 
Response setting is set to High Speed (if the Disable Refresh setting has been set and the 
Interrupt Response is set to Normal, the Disable Refresh setting is ignored). 

 3. Schedule Interrupt Unit setting - These are interrupts for which you can select regular 
intervals of either a fixed 10ms duration or Set in increments of 1 ms.  

 4. SIOU Cyclic Refresh setting - Set the SIOU Cyclic Refresh setting if required. An SIOU 
Cyclic Refresh Unit(s) must be specified if an SIOU refresh setting has been made. 

The CQM1 PLCs support input and scheduled interrupts to stop the main program to run a subroutine.  

The following Interrupt/Refresh options are available with the CQM1H. 

 5. Interrupt Enable – This option allows you to set the various IR value interrupts to either: 
Normal (default), Interrupt or Quick. 

 6. Input Constant - This option allows you to set the input constant of IR000 Bits. Select the 
value in milliseconds as appropriate.  

 7. Pulse Output 0/1 Unit – Set the output pulse 0 and 1 to either Relative or Absolute.  

Port Settings  
The Peripheral Port, Comms Board A, Comms Board B and Host Link Port tabs of the PLC Setup component 
defines the settings for the connection between the PC and PLC. The default settings may be used or an alternative 
communications protocol defined. Use the following procedure to apply settings. 

1, 2, 3… 1. The Port Settings are set to 9600 bps, 1 start bit, 7-bit data, 2 stop bits and Even parity. 
Customised port settings can be entered by deselecting the Default setting. The Mode 
setting can be set to one of the following connection types: 
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 ♦  PC. 

♦  Hostlink 1 to n. Multiple PLC RS422/485 connections to the PC. 

♦  RS232C. Single PLC RS232 connection to a printer or from a reader. 

♦  1-to-1 Link Slave. Sets PLC as slave in an RS232 PLC to PLC connection. 

♦  1-to-1 Link Master. Sets PLC as master in an RS232 PLC to PLC connection. 

♦  NT Link 1:1. For using NT link commands in an RS232 PLC to PT (Programmable Terminal) 
connection. 

♦  NT Link 1:n.  For using NT link commands in an PLC to RS422/485 multi-PT connection.  

♦  Protocol Macro 1:1. Single PLC RS232 to device connection. 

♦  Protocol Macro 1:n. PLC to RS422/485 multi-device connections. 
 2. Select the CTS Control setting to enable use of the CTS line on the PLC. 
 3. Set the Unit Number setting for the selected PLC. 
 4. Set the Delay setting; a pre-set transmission delay in the range 0000 to 9999 (for BCD this is 

in 10ms units). 
The following entries cannot be amended: 

♦  Link Words. These word addresses are fixed at LR00 to LR63 (or bit addresses from LR0000 to LR6315). 
♦  Start Code and End Code. The message start and end codes. 
♦  NT Link Max.  

Error Settings 
The Error Settings tab of the PLC Setup component defaults to the detection and reporting of long cycle times, 
interrupt errors and low battery condition. Use the following procedure to apply settings in the Error Settings tab. 

1, 2, 3… 1. Cycle Time - Check the Do not detect long cycles option to stop detection and reporting of 
long cycles. 

 2. Styles - Check the Do not store records option if records are not to be stored. 
 3. Battery - Check the Do not detect low battery option if low battery condition is not to be 

reported on. 

High Speed Counters 
The CQM1H-CTB41 high-speed counter board is an Inner Board applicable to units CPU51 and CPU61. A 
maximum of two boards can be mounted simultaneously in slots 1 & 2 of the PLC.  The high-speed counter board 
counts high-speed pulses from 50 to 500 kHz entering through ports 1 to 4. It performs tasks according to the 
number of pulses counted.  

When the present value of the high-speed counter matches a specified target value or lies within a specified range, 
the bit pattern specified in the comparison table is stored in internal output bits and external output bits. A bit 
pattern can be set for each comparison result and the external output bits can be output through an external output 
terminal. 

Up to four external outputs can be produced when either the target value is matched or a range comparison 
condition is satisfied. The high-speed counter board does not provide high-speed counter interrupts, it simply 
compares the present value to target values or comparison ranges and produces internal and external bit outputs. 

CPM1/CPM1A PLCs have a high-speed counter function that can be used in incrementing mode or up/down mode. 
The high-speed counter can be combined with input interrupts to perform target value control or zone comparison 
control that is not affected by the PLCs cycle time.  High-speed counter signals can be input to CPU bits 00000 
through 00002. In incrementing mode, input 00001 can be used as a regular input. 

High Speed Counter/Synchronised Pulse Control 
Select the appropriate option to determine the parameters of the high speed counter. If the option ‘Don’t use either 
function’ is selected the counter is disabled and the Counter Reset and Counter Mode option are disabled. 

Counter Reset 
Select the counter reset mode of operation, either Z phase and software reset or Software reset only. 
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Counter Mode 
Select the appropriate option to determine the counters mode of operation. 

Device Net 

I/O Link Refresh Area 
Note: This tab is only available for the CPM2*-S* PLCs. 

1, 2, 3… 1. Standard - Select this button to set the standard/default settings for the I/O Refresh Area. 
 2. Custom - Select this button to make your own settings. 
 3. Write: These setting are the same as Read, but without the option of selecting the 'AR' 

memory area. 
 ♦  Area - This option defaults to IR area 1, but can be set to IR area 2, DM area, LR area or HR area. 

♦  Address - This is the beginning address number. 

♦  Size - The default is 0. However, if the size is 0 for Write, then the size for Read must be 1, or 
vice versa. Any custom setting's maximum value is determined by what the Area and Address 
values before it were set to. For example, if IR area 1 is selected, and the maximum address is 
specified (in this case max = 49), then the maximum size is 1. (The size value is specified in 
Words). 

 4. Read: These setting are the same as Write, but with the additional option of being able to 
selecting the 'AR' memory area for reading. 

 ♦  Area - This option defaults to IR area 1, but can be set to IR area 2, DM area, LR area or HR area. 

♦  Address - This is the beginning address number. 

♦  Size - The default is 0. However, if the size is 0 for Write, then the size for Read must be 1, or 
vice versa. Any custom setting's maximum value is determined by what the Area and Address 
values before it were set to. For example, if IR area 1 is selected, and the maximum address is 
specified (in this case max = 49), then the maximum size is 1. (The size value is specified in 
Words). 

PLC Status 
These options determine the status of the PLC. 

Append PLC Status on top of IN data - Select this button to Append PLC Status on top of IN data, or choose 'Do not 
append PLC Status'. 

Do not append PLC Status - Select this button to not append PLC Status on top of IN data, or choose 'Append PLC 
Status on top of IN data'. 

PC to PLC Communications 
The PLC Setup component permits the transferring of data to and from the PLC and allows comparisons to be made 
between data stored on the PC and the PLC. 

Uploading PLC Settings 
The Transfer from PLC option loads the settings from the PLC into the PLC Setup component. Use the following 
procedure to upload PLC settings. 

1, 2, 3… 1. Ensure the PLC is online before activating the PLC Setup component. 
 2. Select Transfer from PLC from the Options menu. A confirmatory dialog is displayed. 

The PLC Setup component is refreshed with the details from the PLC. 

Downloading PLC Settings 
The Transfer to PLC option loads the settings to the PLC. Use the following procedure to download an IO Table. 

1, 2, 3… 1. Ensure the PLC is online before activating the PLC Setup component. 
 2. Select Transfer to PLC from the Options menu. A confirmatory dialog is displayed. 
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Comparing PLC Settings 
The Verify option compares the settings on the PLC with those on the PLC. This option is helpful to confirm that a 
table that has been set up in CX-Server and has been downloaded to the PLC, agrees with how the hardware is set 
up. Use the following procedure to compare PLC settings. 

1, 2, 3… 1. Ensure the PLC is online before activating the IO Table component. 
 2. Select Verify from the Options menu. 

Any differences (if any) are displayed in the PLC Setup component. 
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 CHAPTER 5 
Data Trace/Time Chart Monitor Component 

This chapter describes the Data Trace/Time Chart Monitor component and its ability to display either the PLCs 
uploaded data trace buffer or monitored data obtained from the PLC’s memory areas during program execution. 

Data held in a PLC’s memory areas can be monitored and traced during program execution. When displayed, this 
information provides a valuable tool for analysing the program’s performance. 

The Data Trace/Time Chart Monitor component has two separate modes of operation: 

♦  Data Trace. The PLC can be configured to trace a number of channels and bits and can sample these when a 
trigger condition is activated. When the PLC trace buffer is full or the user stops the trace, the trace buffer can 
be uploaded and viewed – the trace however, is complete. Values do not change on the screen, all sampling is 
achieved in the PLC and displayed when finished.  

♦  Time Chart Monitor. A number of channels and bits can be configured and monitored online. The changing 
values are displayed in the monitoring view as either a trend graph or histogram. A trigger condition can also 
be set which resets the sampled amount of data. Monitoring continues until stopped by the user. 

 
With the CX-Programmer version 6.0 and later versions, data collected by the Data Trace and Time Chart Monitor 
functions can be saved in standard CSV files (with .csv filename extension). The data saved in standard CSV files 
can be analysed and printed in programs such as Microsoft Excel.  

The status bar provides instant help, the PLC and CPU type, the current operating mode of the PLC and the status 
of the Data Trace/Time Chart Monitor component. 

The Toolbar and status bar can both be turned on or off. Select Status Bar from the View menu to control the 
display of the status bar. Select Toolbar from the View menu to control the display of the Data Trace/Time Chart 
Monitor toolbar. 

The Data Trace/Time Chart Monitor component can be forced to stay as the top window by selecting the Always on 
top option from the Options menu. 

For moving, resizing, maximising, minimising and closing windows, refer to Microsoft Windows online help. 

Access to the Data Trace/Time Chart Monitor dialog is from the invoking application.  

 To close the Data Trace/Time Chart Monitor dialog, select the Close button in the title bar.  

Sampling Ranges 
The following paragraphs discuss sampling ranges specific to PLC series. 
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CS/CJ-series PLC Sampling Range 
The CS/CJ-series PLC can trace a maximum of 31 bits and 6 words and performs data tracing using one of the 
following methods: 

♦  Setting a timer interval. The trace can be performed in increments of 5ms during a 5-2550 ms cycle. To sample 
data only once each cycle, set the interval to 0 ms.  

♦  Including the TRSM (170) instruction in the PLC’s program. This instruction identifies the points in program 
execution where specified data is to be stored in Trace Memory. The timer interval must be set to ‘TRSM’. 

Note: The buffer for Data Trace is 4K words. 

CV-series PLC Sampling Range 
The CV-series PLC can trace a maximum of 12 bits and 3 words and performs data tracing using one of the 
following methods: 

♦  Setting a timer interval. The trace can be performed in increments of 5 ms during a 5-2550 ms cycle.  
♦  Including the TRSM(170) instruction in the PLC’s program. This instruction identifies the points in program 

execution where specified data is to be stored in Trace Memory. The timer interval must be set to ‘TRSM’.  

C-series PLC Sampling Range 
The C-series PLC can trace a maximum of 12 bits and 3 words and performs data tracing using one of the following 
methods: 

♦  Setting a timer interval. A Data Trace can be performed at regular, independent intervals by setting a timer 
interval from the peripheral device. 

♦  Including the TRSM(45) instruction in the PLC’s program. This instruction identifies the points in program 
execution where specified data is to be stored in Trace Memory. 

Note: Data Tracing cannot be performed from a Programming Console. 

Setting Monitoring Conditions 
The Data Trace or Time Chart Monitor must be activated before the settings can be configured. To select Data 
Trace or Time Chart Monitoring mode, select the Mode option from the Operation menu followed by either Data 
Trace or Time Chart Monitor.  

Note: The mode of the Data Trace/Time Chart monitor component is identified prior to 
activation from the invoking application. 

The Time Chart Monitor/Data Trace Configuration dialog allows the conditions for the Data Trace or Time Chart 
Monitor to be set, i.e. specifying the data to be monitored, the intervals at which this is to occur and the trigger 
conditions. 

 
Use the following procedure to set conditions for the Data Trace or Time Chart Monitor modes.  

1, 2, 3… 1. Select the Configure Trace/Time Chart button from the toolbar. 
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2. Set the trigger condition that causes the data trace to start by selecting a Symbol/Address and 

Value on the Trigger tab. Use the Browse pushbutton to insert a known symbol from the 
invoking application. If a bit address is selected, the trigger is based on a falling or rising 
edge as opposed to a particular value for a word address: the Value field changes to the Edge 
field. 

 3. For Time Chart Monitor only, establish the sampling time and Buffer Size on the Sampling 
tab. 

 4. Apply a delay value in the Delay field. A negative value in this field advances the start of the 
trace before the trigger condition by the supplied interval value. A positive value in this field 
delays the trace after the trigger condition by the supplied value in sampling. 

 5. Select the Word Addresses field on the Word Addresses tab and/or Bit Addresses on the Bit 
Addresses tab) to be monitored. 

 6. Once all conditions have been set as required, click the OK pushbutton. Select the Cancel 
pushbutton to abort the configuration operation. 

Use the following procedure to select the Word addresses or Bit addresses. It is possible to set only word addresses, 
bit addresses, or a mix of both.  

 
1, 2, 3… 1. Select a free area in the Address or Symbol columns with the right-mouse button and click 

New. The Address Selection dialog is displayed. 
 2. Insert an address in the Address/Symbol field, or select the Browse pushbutton to locate a 

symbol from the invoking application. 
 3. Click the OK pushbutton in the Address Selection dialog to accept the settings or select the 

Cancel pushbutton to abort the operation. The address or symbol is displayed in the Data 
Trace Configuration dialog. Multiple addresses or symbols can be applied. 

 4. To delete an existing address or symbol, select an address or symbol with the right-mouse 
button and click Delete. 

When in the Data Trace mode of operation, the data trace configuration in the PLC can be uploaded and 
viewed/edited for re-use. Select the Upload pushbutton from the Data Trace Configuration dialog. 

Managing the Data Trace/Time Chart Monitor 
Use the following functions to manage the Data Trace or Time Chart Monitor. 

 
Select the Execute button from the toolbar to execute a data trace/time chart monitor.  

 
Select the Trigger button from the toolbar to set the trigger condition so that execution will end 
normally.  

 
Select the Stop button from the toolbar to stop a data trace/time chart monitor.  

 
Select the Read button from the toolbar to upload the data trace. This may take a few moments; 
the status of the Read function can be verified by the information supplied in the status bar. The 
Read button is not used for the Time Chart Monitor mode of operation. 
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Saving Data Trace Settings 
Results data collected by the Data Trace and Time Chart Monitor functions can be saved as special 
CX-Programmer data files (.cdt filename extension) or standard CSV files (.csv filename extension). 

♦  Saving Data in a CX-Programmer Data File 
To save the data in a special CX-Programmer data file (.cdt filename extension), select File – Save or File – 
Save As. 

♦  Saving Data in a CSV File 
To save the data in a standard CSV file, select File – Save CSV. 

Retrieving Data Trace/Time Monitor Settings 
Data Traces can be stored on file and retrieved for later analysis. Settings may be retrieved from a project from an 
invoking application. Select the Open option from the File menu. A standard open window is displayed. 

Data Trace/Time Chart Monitoring component files can be retrieved via a standard File Open dialog. Use the 
following procedure to open a Data Trace/Time Chart Monitoring component file.  

1, 2, 3… 

 

1. Select the Open File button from the toolbar to open a Data Trace file.  
2. A standard File Open dialog is displayed. Select a file from the Open dialog, followed by the 

Open pushbutton. PLC Memory files have a .CDT extension. 
Note: It is possible to open a file type that is not applicable to the current mode, e.g. opening a 

Data Trace file when in Time Chart Mode. 

 To close a currently open file, select the Close button from the file’s title bar. Recently opened 
files can be directly selected for opening via the File menu. 

Displaying a Data Trace/Time Chart 
Once uploaded, the Data Trace/Time Chart Monitor component is populated with the required details. 
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The top graph illustrates the word addresses or symbols. The bottom graph illustrates the bit addresses or symbols. 
Each word address is colour coded. The word and bit addresses are listed in the left pane; the splitter bar can be 
moved by placing the mouse cursor over the splitter bar and dragging it to its new position to show more or less of 
the displayed numbers. 

 The slider position, used to analyze the data returned by the data trace, can be moved by placing 
the mouse cursor over the graph slider and dragging it to its new position. Both sliders can be 
moved together by selecting Synchronise Cursors from the View menu. When moving the slider, 
it snaps to the sampled intervals. Moving and holding the slider left and right scrolls the view 
window left and right. 

The Data Trace/Time Chart Monitor component permits the zooming and scaling of the Data Trace/Time Chart 
view. Use the following procedure to zoom and scale the Data Trace/Time Chart view.  

 
Select the Zoom In button from the toolbar to zoom in on the word graph. 

 
Select the Zoom Out button from the toolbar to zoom out from the word graph. 

 
Select the Restore Zoom button from the toolbar to return the graph to the original view. 

 
Select the Scale In button from the toolbar to zoom in on a particular graph against the vertical 
axis. 

 
Select the Scale Out button from the toolbar to zoom out from a particular graph against the 
vertical axis. 

 
Select the Restore Scale button from the toolbar to return the graph to the original scale. 

This can be modified to switch between Histogram and Trend Graph when in Word Display Mode or to switch 
between Outline and Block when in Bit Display Mode. Use the following procedure to switch display modes. 

1, 2, 3… 1. Select the Word Display Mode option or the Bit Display Mode option from the Options 
menu. 

 2. For Word Display Mode, select either Histogram or Trend Graph. 
 3. For Bit Display Mode, select either Block or Outline. 

The Word values shown on the screen can be displayed in one of four formats: 

♦  Binary; 
♦  Decimal; 
♦  Signed Decimal; 
♦  Hexadecimal. 
Use the following procedure to select a Bit value format.  

1, 2, 3… 1. Select Word Value Format from the Options menu. 
 2. Select either Binary, Decimal, Signed Decimal or Hexadecimal. 

The Bit values shown on the screen can be displayed in one of two formats: 

♦  Boolean (1 or 0); 
♦  Text (On or Off). 
Use the following procedure to select a Bit value format.  

1, 2, 3… 1. Select Bit Value Format from the Options menu. 
 2. Select either Boolean or Text. 

The Data Trace/Time Chart view can be toggled to display either PLC addresses or symbol names. Select the 
Options menu and then Show Symbol Names. If a symbol name is not available then the PLC address is shown. 

The colours associated with the Data Trace/Time Chart view can be customised. Use the following procedure to 
change the colours on the Data Trace/Time Chart view.  

1, 2, 3… 1. Select Colours from the Options menu. The Trace Colour Selection dialog is displayed. 
 2. Select a Change pushbutton associated with a colour to be applied to a Word or Bit address. 

A standard Microsoft Windows Colour dialog is displayed. 
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 3. Select a colour from the Colour dialog and click the OK pushbutton. Select the Cancel 
pushbutton from the Colour dialog to abort the operation. 

 4. If required, Select a Change pushbutton for another colour and repeat step 3. 
 5. Select the Apply pushbutton from the Trace Colour Selection dialog to apply the change 

colour settings. Select the OK pushbutton to apply the change colour settings and close the 
dialog. Select the Cancel pushbutton to abort the operation. 

The display of the Data Trace or Time Chart Monitor can be further refined by displaying a grid over the window. 
Select Grid from the Options menu to control the display of the grid.  

Any symbol names inherited from the invoking application can be displayed on Data Trace or Time Chart Monitor 
by selecting Show Symbol Names from the Options menu. 

SYSWIN Data Trace and Time Chart Monitor Files 
SYSWIN 3.x Data Trace Files (*.SDT) and Time Chart monitoring files (*.STC) can be opened directly into 
CX-Server. Use the following procedure to import these files:  

1, 2, 3… 

 

1. Select the Open button from the toolbar. The Open dialog is displayed. 
2. Select an alternative file type from the Files of Type field, either SYSWIN version 3 Data 

Trace Files (.SDT) or SYSWIN version 3 Time Chart Monitor Files (.SDC). 
3. Select a file to open. 
4. Select the Open pushbutton to import the file. Select the Cancel pushbutton to abort the 

operation. 
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 CHAPTER 6 
PLC Error Component 

This chapter describes the PLC Error component and its ability to display and clear PLC errors, the PLC Error Log 
and messages. 

The PLC Error component is only available when the PLC is online. 

The PLC Error component provides a view of current errors occurring in the PLC’s CPU and allows them to be 
cleared when the cause of the PLC error has been removed (providing the PLC is in the correct mode). Errors 
occurring are also written to the PLC Error Log and displayed in the PLC Error component automatically although, 
if set to Manual Refresh, the error history is only updated when the Refresh button is selected. 

Messages are displayed when a user-defined MSG instruction in the ladder program is encountered; these messages 
may have been defined as part of an error trap or to provide more general information. Messages may also be 
generated by the system in certain circumstances. 

When a number of errors have occurred on the PLC, the most serious error is displayed automatically. For detailed 
information concerning a PLC error, refer to the relevant PLC manual.  

 
The status bar displays the connected device and PLC mode and the PLC Clock (if one is present and clock 
monitoring has been enabled from the Options menu).  

♦  The Error Log is always available for CV and CS1/CJ1-series PLCs but can be selectively enabled or disabled 
for C-series PLCs. 

The PLC Error component can be forced to stay as the top window by selecting the Settings option from the 
Options menu and checking the Always on Top setting on the General tab. 

Access to the PLC Error component is from the invoking application. If a serious error has occurred, the PLC Error 
component is displayed automatically. 

 To close the PLC Errors dialog, select the Close button in the title bar.  

Errors 
The Errors tab of the PLC Error component displays the current error status of the PLC, when an error is detected 
in the PLC it is shown with the item identifier, code position, error status level and error details. The icon next to the 
item number indicates the type of error detected and reflects the error status in the Status column.  

Errors may be cleared but this is dependent upon removal of the cause of the error in the PLC and the PLC’s 
operating mode.  

When the PLC is in Program Mode, all errors can be cleared; when in Monitor mode, only the last error can be 
cleared. It is not always possible to clear an error when the PLC is in Run mode; in this instance, a dialog is 
displayed which allows an attempt to be made at clearing the error. Providing the cause of the error has been 
rectified, the error can be cleared, although the PLC mode may need to be switched to achieve this. 

Use the following procedure to clear errors.  

1, 2, 3… 1. Select the Errors tab in the PLC Error component. 
2. Select the Clear All pushbutton. 
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There are three types of errors that can be recorded.  

 Fatal error: Program execution is halted and the PLC error indicator is constantly illuminated. 

 Warning error (non-fatal): The PLC error indicator flashes. 

 
No errors: PLC is operating normally. 

Note: The user program, Parameter Area, and I/O Memory in the CPU Unit can be cleared to 
initialize the CPU Unit by selecting Clear All Memory Areas from the Options menu of 
the PLC Errors dialog box. 

Error Log 
The Error Log tab of the PLC Error component displays the error history of the associated PLC including entry 
number, date and time of occurrence (if date and time stamping is supported by the PLC), code position and error 
details. The icon shown against the Entry number indicates the error status (unlike the Errors tab, there is no Status 
column). 

Use the following procedure to clear the Error Log.  

1, 2, 3… 1. Select the Error Log tab in the PLC Error component. 
2. Select the Clear All pushbutton. 

Note: The Error Log cannot be cleared in Run mode.  
There are three types of Error Log entries recorded. 

 
Fatal Error Log entry. Program execution is halted by this error occurrence. 

 
Warning Error Log (non-fatal) entry.  

 
No Error Log entries. 

The maximum number of Error Log entries allowed by the PLC is displayed beneath the Error Log. 

Note: With the CX-One Ver 1.1 (CX-Programmer Ver. 6.1) and later versions, the error log 
displayed in the PLC error window’s Error Log Tab can be saved as a CSV file by 
clicking the Save Button.  The saved data can be analyzed or printed later with programs 
such as MS Excel.  

Messages 
The Messages tab of the PLC Error component displays the messages set by a ladder program. These are 
user-defined messages which have been inserted into the PLC program, they do not have to be error messages. 
Messages can either be selectively cleared or all cleared at the same time. 

Use the following procedure to clear a message.  

1, 2, 3… 1. Select the Messages tab in the PLC Error component. 
 2. Highlight the message to be cleared and select the Clear pushbutton. Alternatively, select 

the Clear All pushbutton or remove a selection by keeping the [SHIFT] key depressed when 
highlighting messages. 

Error Log Settings 
The Error Log Options dialog allows the Error Log to be activated, time monitoring to be set and automatic update 
of the Error Log to be performed. When the component is initially opened, it activates settings saved previously. 

Time Monitoring 
Some PLC types support a clock which can also be monitored. Use the following procedure to invoke time 
monitoring against the PLC Clock.  
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1, 2, 3… 1. Select the Settings option from the Options menu. 
 2. Select the Clock tab. 
 3. Check the Monitor the PLC Clock setting. The current clock time from the PLC is then 

displayed in the status bar so the user can verify the current time against the error log entries. 
 4. Select the Apply pushbutton to activate the settings. Select the OK pushbutton to apply the 

settings and close the dialog. Select the Cancel pushbutton to abort the operation. 
Note: Where PLCs do not support a clock, ‘No Clock’ is displayed in the Status Bar and the 

information on the Clock tab is greyed-out.  

Manually Updating the Error Log 
Manual refresh of the Error Log is useful if it is desired to prevent other users from clearing the displayed error 
history. Use the following procedure to enable manual refresh of the error log. 

1, 2, 3… 1. Select the Settings option from the Options menu. 
 2. Select the Error Log tab. 
 3. Check the Update Error Log Entries Automatically setting. If not checked, a Refresh 

pushbutton is displayed next to the Clear pushbutton to manually refresh the Error Log 
content (in the PLC Error component). 

 4. Select the Apply pushbutton to activate the settings. Select the OK pushbutton to apply the 
settings and close the dialog. Select the Cancel pushbutton to abort the operation. 

Use the following procedure to refresh the Error Log automatically.  

1, 2, 3… 1. Select the Settings option from the Options menu. 
 2. Select the Error Log tab. 
 3. Deselect the Update Error Log Entries Automatically setting. 
 4. Select the Apply pushbutton to activate the settings. Select the OK pushbutton to apply the 

settings and close the dialog. Select the Cancel pushbutton to abort the operation. 

Customising the Layout of the Error Log 
Some PLCs do not support time stamps, date stamps or clocks. The layout of the Error Log can be changed to 
remove the time and date columns as necessary and make the display more relevant to the PLC. Use the following 
procedure to customise the layout of the PLC Error component. 

1, 2, 3… 1. Select the Settings option from the Options menu. 
 2. Select the Error Log tab. 
 3. Error Log time and date information can be hidden from view by checking the Hide Error 

Log Time Column and the Hide Error Log Date Column settings. 
 4. Select the Apply pushbutton to activate the settings. Select the OK pushbutton to apply the 

settings and close the dialog. Select the Cancel pushbutton to abort the operation. 

Enabling and Disabling the Error Log  
For C-series PLCs only, the error log can be enabled and disabled as required. Use the following procedure to 
enable or disable the error log. 

1, 2, 3… 1. Select the Settings option from the Options menu. 
 2. Select the Error Log tab. 
 3. Check the Error Log Enabled setting to manually monitor errors. 
 4. Deselect the Error Log Enabled setting to stop monitoring errors. 
 5. Select the Apply pushbutton to activate the settings. Select the OK pushbutton to apply the 

settings and close the dialog. Select the Cancel pushbutton to abort the operation. 

Overwriting Error Log Entries 
For C-series PLCs only, the overwrite mode depends upon the CPU type. It may either overwrite the last entry in 
the Error Log each time or cycle through the Error Log and start to overwrite it from the beginning. Overwriting is 
only performed when the maximum number of records in the Error Log has been reached. Again this is PLC 
dependent. 
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1, 2, 3… 1. Select the Settings option from the Options menu 
 2. Select the Error Log tab. 
 3. Check the Error Log Overwrite Mode setting to allow the PLC to overwrite Error Log 

entries. 
 4. Select the Apply pushbutton to activate the settings. Select the OK pushbutton to apply the 

settings and close the dialog. Select the Cancel pushbutton to abort the operation. 

Displaying the Error Log 

 
The PLC Error component can be set so that it is only activated when an error in the PLC actually occurs (providing 
it is already open); for example, if the PLC Error component has been minimised it automatically returns to full size 
as the top window when an error is generated in the PLC.  

1, 2, 3… 1. Select the Settings option from the Options menu. 
 2. Select the General tab. 
 3. Check the Activate only when Error detected setting. 
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 CHAPTER 7 
Memory Card Component 

This chapter describes the Memory Card component available to CV-series PLCs and CS/CJ-series PLCs and its 
ability to store and transfer data. File storage is achieved by a File memory card for a CV-series PLC and a Compact 
Flash or EM memory configured as ‘file memory’ for a CS1-series PLC. 
Information can be transferred from the PLC to the memory card or from the memory card to the PLC. A saved 
program can be transferred from the memory card to the program area during operation. Extended PLC setup and 
program files can be automatically transferred at PLC startup if they are named autoexec.std and autoexec.obj 
respectively. 
It is possible to run the Memory Card component whilst the PLC is offline. 
The Memory Card component can be forced to be displayed in focus by selecting the Always on top option from the 
Options menu. 
For moving, resizing, maximising, minimising and closing windows, refer to Microsoft Windows online help for 
further information. 
Access to the Memory Card component is from the invoking application.  

Memory Card Operation 
The appearance and behavior of the Memory Card component is similar to Microsoft Windows Explorer. 
Differences between the Microsoft Windows Explorer exist within the Memory Card component when certain 
functions are accessed. Refer to Microsoft Windows Explorer help, part of the standard Microsoft Windows 
documentation for options and functions not described in this chapter but available within the Memory Card 
component.  

Caution:  Memory cards must be formatted prior to use. 

 
The status bar provides instant help, the PLC and CPU type, and quick reference information describing how much 
space is available on a particular device for the selection in the left pane.  

In addition to the devices and folders supported by the PC, the Memory Card component also displays the 
connected PLC device. In terms of the device/folder structure of Microsoft Windows Explorer, the PLC contains a 
Memory Card folder if available (i.e. if fitted), Program Area, IO Memory Area and Parameter Area. For a 
CS/CJ-series PLC, a Memory Card folder can contain subfolders. 

Note: In order to view or execute on the PLC a file from the memory card, the file must be 
copied back to the PC folder. Double clicking on the files in the list has no action 
associated with it since files cannot be opened across the communications connected to 
the PLC.  

A memory card can be displayed for each connected PLC and allows their contents to be moved between 
destinations. The operation is aborted if there is not enough space. Snapshots of PLC Memory areas can be taken 
by transferring information from the Program Area, IO Memory Area or Parameter area to the Memory Card 
folder.  
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For CV-series PLCs memory cards can be either RAM, EPROM, or EEPROM. EPROM and EEPROM cards can 
only be written to using the Memory Card Writer.  

For CS1-series PLCs memory cards can be either Compact Flash disk or configured EM memory. 

There are three ways in which memory cards can be accessed: 

♦  They can be read from/written to during an online operation using programming software; 
♦  By instruction via a program in the PLC; 
♦  Using the Memory Card component; 
Refer to the associated PLC manual for further information. 

The Memory Card component automatically detects whether the memory card is in place or not. An error message 
is displayed if it is detected that the memory card has been removed whilst the Memory Card component is active. 

Files held on the memory card can be compared with data in the PLC. File formats can be one of four types: 

♦  .LDP indicates partial program area files; 
♦  .OBJ indicates full program area files; 
♦  .STD indicates PLC setup area files; 
♦  .IOM indicates any other type of file. 
The CS/CJ-series PLC also supports the configuration of EM memory as file memory. Providing the EM Table 
Setting Enabled option from the Settings menu is set within the PLC Setup component whilst in Program mode. 
Refer to Chapter 4 - PLC Setup Component for further details.  

A fitted memory card on CV-series PLCs or Compact Flash card on CS/CJ-series PLCs must be formatted to be 
used as a file storage device. Setting a CS1-series PLC as file memory in the PLC Setup component automatically 
formats EM file memory for use in the Memory Card component.  

Memory Card Display 
The Memory Card component can be manipulated in the same manner as most Microsoft Windows displays to 
control what is displayed; for example, expansion of the file storage hierarchy. 

The left pane displays the content, in terms of Devices, Networks and Points. 

 To expand the hierarchy in the left pane, select this icon. 

 To collapse the hierarchy in the left pane, select this icon. 

To view the content of a particular branch in the hierarchy, double-click on the item in the left 
pane. 

 
Select the Large Icons button from the toolbar to display the content of the right pane as large 
icons. 

 
Select the Small Icons button from the toolbar to display the content of the right pane as small 
icons. 

 
Select the List button from the toolbar to display the content of the right pane as a list. 

 
Select the Details button from the toolbar to display the content of the right pane with associated 
details. 

Use the following procedure to copy or move information from or in the PLC Memory component.  

1, 2, 3… 1. Select an item, or items, in a window. More than one item can be selected by pressing Shift 
and selecting another item to extend the selection, or by pressing Ctrl and selecting another 
item to add to the selection. 

 
2. Select the Copy button from the toolbar to copy the item, or the Cut button from the toolbar 

to move the item. 
 3. Select an area to move the items to, for instance copying data area values into another data 

area. 
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4. Select the Paste button from the toolbar to paste the item. A Paste operation can be 

performed several times without copying again. 
A file or label (if at top level) can be renamed. Use the following procedure to rename memory card data.  

1, 2, 3… 1. Highlight the required document or folder. 

 
2. Select the Rename button from the toolbar. The document/folder name can now accept 

input. Enter the new name and press Return. 
A file or folder can be deleted. Use the following procedure to delete a file or folder.  

1, 2, 3… 1. Highlight the required document or folder. 

 
2. Select the Delete button from the toolbar. A Confirm Folder Delete dialog is displayed. 

 3. Select the Yes pushbutton to continue with the deletion or the No pushbutton to abort the 
operation. 

The Toolbar and status bar can both be turned on or off. Select Status Bar from the View menu to control the 
display of the status bar. Select Toolbar from the View menu to control the display of the PLC Memory toolbar. 

If the display of a PLC device takes a few moments to refresh, ensure the Auto Refresh PLC View option from the 
Options menu is turned off. This then allows the PLC to be refreshed manually by selecting Refresh from the View 
menu. 

Extended PLC setup and program files can be transferred to the Memory Card as autoexec files so they can be 
automatically transferred at PLC startup. Select the Transfer as AutoExec Files from the Options menu.  

Memory Card Properties  
Use the following procedure to view memory card properties. 

1, 2, 3… 1. Highlight the required document or folder. Multiple devices, folders and files can be 
selected if required. 

 
2. Select the Properties button from the toolbar. 
3. View the details. Some options may be amended, for instance the read-only attribute for a 

file; in this instance, amend settings as appropriate. Select the OK pushbutton to complete 
the operation or the Cancel pushbutton to abort the operation. 

Transferring Data between the PLC and Memory Card 
Use the following procedure to transfer data between the PLC and memory card. 

1, 2, 3… 1. Select the Files on the PLC to be copied and click the right-mouse button. 
 2. Select Transfer To option followed by either Memory Card or EM File Area. 

Possible Memory Card Errors 
The following list provides a brief overview of the possible errors that could arise with the memory card when 
operating in Program Mode. Refer to the associated PLC manual for further information. 

♦  The PLC Program is protected and cannot be written to; 
♦  The file card does not contain enough free space to transfer the PLC data required; 
♦  The source file name specified to transfer data from does not exist; 
♦  The file on device already exists; 
♦  The file device is read only and cannot be written to; 
♦  The file device does not exist, insert the memory card; 
♦  Cannot transfer data from the file device to the PLC’s area when the PLC is in Run mode; 
♦  To transfer data from the file device to the PLC’s IO area, the PLC must be in Program mode; 
♦  The data cannot be transferred to the PLC as the PLC is password protected or access rights have not been 

granted. 
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Note: With the CX-One Ver 1.1 (CX-Programmer Ver. 6.1) and later versions, the following 
functions can be executed if the PLC model is set to CP1H. 

1, 2, 3… 1. Memory Cassette Transfer function 
 Data can be transferred and verified between the Memory Cassette and CP1H CPU Unit. 
♦  Applicable Data 

The following table lists the kinds of data that can be selected for transfer/verification.  
Applicable data 

Program, parameters, Data Memory, variable tables, comments, program index, and Data Memory 
initial values 

♦  Procedure 
Select PLC – Edit – Memory Cassette/DM and click the Transfer to Memory Cassette, 
Transfer to PLC, or Verify All Areas Button.  

 2. Data Memory to Flash Memory Backup function 
All of the Data Memory in the CP1H CPU Unit’s internal RAM can be backed up as DM 
initial values in the CPU Unit’s internal flash memory. The backed up data is known as 
Backup DM (DM initial values). 

♦  Procedure 
Select PLC – Edit – Memory Cassette/DM and click the Backup Button in the Backup to 
Flash Memory Field. 
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 CHAPTER 8 
CX-Server Network Configuration Tool (CX-Net) 

This chapter describes the CX-Server (CX-Net) Network Configuration tool, the procedures for establishing 
communications to PLCs for direct and gateway connections. The Network Configuration Tool hosts tools that 
assist in the creation and editing of local and network Routing Tables and the creation and editing of Data Link 
Tables. 

To successfully establish communications between CX-Server and a network PLC, an intermediary or gateway 
PLC has to contain a valid Routing table to allow the correct routing of packets. The CX-Net Network 
Configuration tool allows communications to PLCs with a CX-Server project and configuration of the PLC. The 
CX-Net Network Configuration tool allows the following: 

♦  Hosts the Routing Table editor to provide routing table support at a network level, enabling PLCs to act as 
gateways across networks; 

♦  Hosts the Data Link table editor to provide Data Link table support at a network level; 
♦  Setup of PLC devices and their communication units; 
♦  Network diagnostics; 
♦  Control of Data Link operation. 

Note: The availability, format and content of the facilities within the CX-Net Network 
Configuration tool depend upon the device type of the PLC being considered (C-series, 
CS1-series or CV-series) and the network to which that PLC is connected (SYSMAC 
LINK, SYSMAC NET, Ethernet or Controller Link). 

Refer to the specific OMRON System and Operation manuals for details of the operation of the various network 
units and their available settings and options. 

 
The status bar provides instant help, the status of the current connection and the operating mode of the PLC.  

When the CX-Net is initially loaded, the Project Devices field is empty. Opening or creating a CX-Server project 
populates the Project Devices list with all the devices in that CX-Server project. Selecting each device in turn 
causes the right-hand side of the dialog to display a graphical representation of that connection (either direct or 
through a gateway connection), together with node and network information.  

Note: Offline connections are shown as a red line whilst for online connections this changes to 
green. Other aspects also change when online, refer to Chapter 8 - Opening a PLC for 
further information. 

Any operations (e.g. network unit setup, Data Link and routing table editing) which are carried out affect the 
physical connection PLC which is currently connected, not the CX-Server project PLC. 

Routing Tables contain the information necessary to allow communications between different networks including 
local and remote network address details; they are held in a specific area of PLC memory. Refer to Chapter 11 - for 
information regarding Routing Tables. 

CS/CJ/CP-series PLCs linked to either a Controller Link or Ethernet network also use FINS routing tables. 
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CV-series PLCs also have routing tables which, unlike the C-series, are not dependent upon the networks 
(SYSMAC LINK, SYSMAC NET or Ethernet or Controller Link) to which they are connected. These tables are 
known as FINS routing tables. A direct connection is known as a Local Routing Table. A network connection is 
known as a Network Routing Table. 

C-series PLCs linked to a SYSMAC LINK network are unable to communicate with a different network and 
therefore do not have a routing table; however, C-series PLCs linked to a SYSMAC NET or Controller Link 
network do have this capability and so have an associated routing table. These tables are known as SYSMAC NET 
and FINS routing tables respectively. 

Data Link Tables provide a means of allowing a network of devices to share information. The manner in which this 
information is distributed in a system depends upon the network to which the table relates. The SYSMAC NET 
network contains one node acting as the ‘parent’ node or Data Link server (containing the Data Link table), unlike 
the SYSMAC LINK network where a copy of the Data Link table is sent to all nodes on that network. The 
Controller Link network operates in a similar manner to SYSMAC LINK except that the network is split into two 
areas with each node being associated with one or other of these areas. Data is then copied to each node in the 
related area. Refer to Chapter 10 - Data Links for further information regarding Data Link Tables. 

For moving, resizing, maximising, minimising and closing windows, refer to Microsoft Windows online help for 
further information. 

Access to the CX-Net Network Configuration tool is either from the invoking application or from the Start 
pushbutton on the Microsoft Windows taskbar. 

 To close the CX-Net Network Configuration tool, select the Close button in the title bar. 

CX-Net and CX-Server Projects 
All device information is contained within a CX-Server project file. Once the file has been opened, the PLCs listed 
in that CX-Server project can be opened and the devices on their networks manipulated. CX-Server projects can be 
manipulated from the CX-Net Network Configuration tool.  

Creating a New CX-Server Project 
A new CX-Server project can be created from the CX-Net Network Configuration tool. Use the following 
procedure to create a new CX-Server project. 

1, 2, 3… 1. Select New from the Project Menu. The Create Project dialog is displayed. 
 2. The CX-Server project must be saved before it can be edited. Enter a file name in the File 

name field. An existing CX-Server project can be overwritten by selecting a .CDM file 
displayed in the Create project dialog. 

 3. Select the Save pushbutton to save the new project or the Cancel pushbutton to abort the 
operation. CX-Server files have a .CDM extension. 

Opening an Existing CX-Server Project 
CX-Server project files can be retrieved using a standard File Open dialog. To close a currently open file, create a 
new CX-Server project or select Close from the Project menu. 

Use the following procedure to open a CX-Server project file. 

1, 2, 3… 

 

1. Select the Open button from the toolbar to open a CX-Server project file.  
2. A standard File Open dialog is displayed. Select a file from the Open dialog, followed by the 

Open pushbutton. PLC Memory files have a .CDM extension. 
A list of the most recently opened CX-Server project files is displayed in the Project menu. 

Note: Select Save As from the Project menu to save a project open in CX-Net under any 
desired name. 

Adding a Device 
To add a device to a CX-Server project, select the Add Device option from the Project menu. The Add PLC dialog 
is displayed. The Add PLC dialog is identical to the Change PLC dialog. 
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To change a device within a CX-Server project, select the Change Device option from the Project menu. The 
Change PLC dialog is displayed. 

Editing a Device List 
The Device List dialog, (see Runtime User manual) can be used to change the settings of the PLCs in the currently 
opened CX-Server project, and to add new PLCs. 

The CX-Server project Device List can only be edited when a device is not currently open – the option is disabled 
when a connection is active. 

 
Select the Edit Project button from the toolbar to edit a CX-Server project, or select the Edit 
option from the Project menu. 

PLC Settings 
The PLC menu contains options that operate on a single PLC device within the open CX-Server project, including 
the setup of its units. It also contains the options for opening and closing a PLC device. 

Opening a PLC 
A PLC can be opened for communications once the associated CX-Server project file has been opened. Use the 
following procedure to open a PLC. 

1, 2, 3… 

 

1. Select a device from the PLC Devices list. If required, add a device to the CX-Server project 
by selecting Add Device from the Project menu and edit the CX-Server project by selecting 
the Edit Project button from the toolbar. 

 
2. Select the Open / Project Device button from the toolbar.  

Note: The Open option does not become available until a device name has been selected from 
the Project Devices list. 

It may take several seconds to establish a connection. If a connection cannot be made with the PLC's settings, then 
a message appears showing this. In this case it may be necessary to change the PLC's settings before trying again, or 
checking that the physical connection (e.g. wiring) is possible. 

For SYSMAC LINK end connections a new SYSMAC LINK menu is added allowing specific SYSMAC LINK 
network operation. 

For Controller Link end connections a new Controller Link menu is added allowing specific Controller Link 
network operation. 

When a physical connection has been made the status of the PLC in the status bar changes to Online with the 
current mode of the PLC. The connection lines change colour to green to also denote the PLC is online. In addition, 
the actual values for Node and Network are displayed, together with details of the device actually connected (rather 
than what is defined in the CX-Server project for that setting). When a connection is made to an Ethernet network 
the Node box changes to a drop-down list, allowing the node to be changed in order to connect to a new PLC. If a 
node is selected but there is nothing there, then no information is shown. Returning to offline operation causes a 
return to the original (CX-Server project) configuration settings in the Node and Network fields. 

Upon connection, certain menu options are made available, depending upon the connection type. 

The current operating mode (Run) of the connected PLC is shown in the status bar of the tool – when making a 
connection, or when a connection is broken, the mode indicator shows Unknown. The indicator shows Run, Stop or 
Monitor when a connection is properly completed. CV-series PLCs also support a Debug mode. This mode 
indicator changes whenever a change is made in the operating mode of the PLC. 

Note: The mode in which the PLC runs on startup is set in the PLC Setup Component, refer to 
Chapter 4 - PLC Setup Component. 

Closing a PLC 

 
The Open / Project Device button on the toolbar acts as a toggle switch. To close a device, 
simply reselect the Open / Project Device button on the toolbar (i.e. when the menu option 
shows a tick against it and the toolbar button is depressed). 
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When the device is closed, the details displayed in the Connection part of the CX-Net Network Configuration tool 
are removed. 

Configuring a PLC’s System Settings 

 
The PLC Setup Component can be selected to define the settings which govern the PLC’s 
behavior; for example, connection mode. Select the Configure PLC System Settings button 
from the toolbar. Refer to Chapter 4 - PLC Setup Component for further information. 
Alternatively, select PLC Setup from the PLC menu. 

Scanning for PLC Connections 
A serial scan can be performed which searches all PC COM ports to see if there are any currently attached PLCs 
and, if found, what communication settings are being employed by those PLCs. This procedure is useful when the 
configuration of the PLCs communication settings (i.e. baud rate) are unknown. Device information from the 
results of the scan can then be copied into the CX-Server project, if required. Refer to Chapter 8 - Dragging Device 
Information into a CX-Server Project. 

When the Scan Serial Ports for PLCs dialog is first displayed, it shows the results of the last scan to be performed 
until the Refresh pushbutton has been clicked. Use the following procedure to scan for PLC connections. 

1, 2, 3… 

 

1. Open a CX-Server project by selecting the Open button from the toolbar or create a new 
project. If required, add a device to the CX-Server project by selecting Add Device from the 
Project menu and edit the CX-Server project by selecting the Edit Project button from the 
toolbar. 

 2. Select Scan Serial Ports for PLCs from the Project menu. The Scan Serial Ports for PLCs 
dialog is displayed. 

 3. Select either individual ports or select the Select All pushbutton to scan all ports from the 
Available Ports field. 

 4. Select either individual baud rates or select the Select All pushbutton to scan all baud rates 
from the Baud Rates field.  

 5. Select either individual cable types or select the Select All pushbutton to scan all cable types 
from the Cable types field. 

 6. Select the Next pushbutton; the Scan Serial Ports For PLCs dialog starts the scan. The 
Status field indicates the current progress. On completion, all currently connected PLCs are 
listed in the Drag and Drop Device Units field. 

Note: If changes are made to PLC connections after a scan has been made, select the Refresh 
pushbutton to update the displayed list. 

Dragging Device Information into a CX-Server Project 
The scan operation described in Chapter 8 - Scanning for PLC Connections, picks up device information from the 
physically connected serial port devices. Once a scan has been performed, the Scan Serial Ports for PLCs dialog 
can remain open alongside the CX-Net Network Configuration tool. Dragging a device or network unit from the 
Drag & Drop Device Units field into the Project Device field in the CX-Net Network Configuration tool allows 
this device information to be added into the CX-Server project. 

Use the following procedure to utilise a convenient shortcut for entering PLC details into a CX-Server project. 

1, 2, 3… 

 

1. Open a CX-Server project by selecting the Open button from the toolbar or create a new 
project. If required, add a device to the CX-Server project by selecting Add Device from the 
Project menu and edit the CX-Server project by selecting the Edit Project button from the 
toolbar. 

 2. Perform a scan by selecting Scan Serial Ports for PLCs from the Project menu. 
 3. Select the required device in the Drag and Drop Device Units field. 
 4. Drag the device across to the Project Devices field in the CX-Net Network Configuration 

tool. 

Displaying PLC Device Information 

 
The PLC Device Information dialog displays the selected CX-Server project PLC’s device and 
connection details. To display PLC device information, select the Display PLC Information 
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button from the toolbar, or select the Information command from the PLC menu. 

Setting the PLC Mode 
The main window of the CX-Net Network Configuration tool shows the current operating mode of the connected 
PLC. The PLC Set Mode dialog allows this to be changed. The run modes available to a PLC depend upon the PLC 
device type. Use the following procedure to set the PLC Mode. 

1, 2, 3… 

 

1. Open a CX-Server project by selecting the Open button from the toolbar or create a new 
project. If required, add a device to the CX-Server project by selecting Add Device from the 
Project menu and edit the CX-Server project by selecting the Edit Project button from the 
toolbar. 

 2. Select the Open / Project Device button from the toolbar to open connections to the device. 

 
3. Select the Set PLC Operating Mode button from the toolbar or select the Set Mode 

command from the PLC menu. 
4. Click on the required Operating Mode setting. Select the Set pushbutton. A confirmation 

dialog appears – confirm the operation. 
 5. Select the Close pushbutton to remove the dialog. 

Clearing PLC Errors 

 
Errors, error logs and messages generated by a PLC can be examined and cleared (if possible) 
via the PLC Error Component. Select the Display PLC Error Status button on the toolbar or, 
select the PLC Error Status command from the PLC menu. Refer to Chapter 6 - PLC Error 
Component for more information. 

Creating an IO Table 

 
The PLCs IO Table can also be manipulated by the CX-Net Network Configuration tool by 
activating the IO Table component. The IO Table allows Unit Setup and Software Switch setup 
of SIOU units as well as IO configuration and creation. Before editing the PLCs IO Table it must 
be transferred from the PLC into the IO Table component. Select the Configure IO Table 
button from the toolbar or select the I/O table Setup commend from the PLC menu. Refer to 
Chapter 3 - IO Table Component for further details. Use the following procedure to activate the 
IO Table component. 

Displaying the PLC Unit Status 
The Unit Status option is only available for those nodes where the end connection to the PLC is either SYSMAC 
LINK, SYSMAC NET, Ethernet or Controller Link; in each instance the type of information displayed differs but 
the pushbuttons available are identical. 

♦  SYSMAC LINK. Displays Communications Test, Line Status, Data Link Status, Controller Errors, Backup 
Status Errors, Error Status, Error Log, Status, Error Details; 

♦  SYSMAC NET. Displays Data Link Status, Operating Status, Errors; 
♦  Ethernet. Displays General Status, Error Flags and Error Logs; 
♦  Controller Link. Displays Data Link Status, nodes, Errors and Error Logs. 
The information displayed is for viewing only. However, the Error Log can be cleared. Use the following 
procedure to display the PLC Unit Status. 

1, 2, 3… 

 

1. Open a CX-Server project by selecting the Open button from the toolbar or create a new 
project. If required, add a device to the CX-Server project by selecting Add Device from the 
Project menu and edit the CX-Server project by selecting the Edit Project button from the 
toolbar. 

 2. Select the Open/Close Project Device PLC button from the toolbar to open connections to 
the device. 

 
3. Select the Show Unit Status button from the toolbar or select Unit Status from the PLC 

menu. 
 4. Select the Clear Log pushbutton to delete the entries in the error log. 
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 5. Select the Close pushbutton to remove the dialog. 

Note: Unit status and error log data for Communications Units (e.g., Controller Link Units and 
SYSMAC LINK Units) can be written to files in CSV format. Click the Save button in 
the PLC Unit Status dialog box and the Save As dialog box will appear. Select the CSV 
format and the folder in which to save, input the file name, and click the Save button. 
The status of the Communications Unit and the error log data will be saved in a CSV file. 
 This function allows network errors to be analysed from CSV files. 

Note: With a C-series PLCs, the error log for a Communications Unit (e.g., Controller Link 
Unit or SYSMAC LINK Unit) can be saved using PLC | Unit Status/Error Log. 

Testing the Network Connection 
Once network connections have been created, the network should be tested to ensure that all nodes are responding 
properly. The following tests are available: 

♦  Internode Echo-Back Test. This test checks the condition of a number of specific network and node address 
and whether communications can be established; 

♦  Broadcast Nodes Test. This test examines all nodes on the network and is available for Ethernet, Controller 
Link and SYSMAC LINK only. This test may take some time for an Ethernet network which is not subject to 
the same size restrictions as Controller Link and SYSMAC LINK. The results show all nodes found and the 
PLC type if possible;  

♦  Ping Node Test. Allows echo testing of a specific TCP IP address.  

 
Select the required test from the associated button in the toolbar, either the Echo Back Test 
button, the Broadcast Test button or the Ping Test button. 

Communications Unit Setup 

 
The Configure Communications Unit button from the toolbar is used for SYSMAC LINK, 
SYSMAC NET and Controller Link setup options on SIOU units for C-series PLCs. These 
options only describe settings that cannot be accessed via the IO Table component. 

For CS1-series PLCs and CV-series PLCs, the setup allows SYSMAC NET, SYSMAC LINK and Controller Link 
setup. This information is defined via the IO Table component; refer to Chapter 3 - IO Table Component for further 
information. 

Select a unit type from the Unit Type field. If provided, select the Setup pushbutton to further configure 
communications setup. Select the Close pushbutton to close the dialog. 

SYSMAC LINK Settings 
The SYSMAC LINK menu only appears when the end connection is the SYSMAC LINK network. It allows settings 
specific to a SYSMAC LINK network to be made. 

Network Status 
The SYSMAC LINK Network Status dialog shows the nodes present on the network. It also indicates the 
controlling server node. Use the following procedure to setup SYSMAC LINK Network Status settings. 

1, 2, 3… 1. Select the Network Status option from the SYSMAC LINK menu. 
 2. Select the Close pushbutton to remove the dialog. 

Network Settings  
The Network Settings dialog allows parameter settings for a SYSMAC LINK network to be defined; this includes 
the maximum number of nodes on a network, the maximum number of polling units per communications cycle, and 
the maximum number of frames per communications cycle. 

On entry, this dialog displays the last parameters entered for a selected network. Use the following procedure to 
setup SYSMAC LINK Network Settings. 

1, 2, 3… 1. Select the Network Setup option from the SYSMAC LINK menu. 
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 2. Adjust the settings as required (or select the New pushbutton to return to the default values 
for the network). 

 3. Select the Write pushbutton to download the network parameters to the SYSMAC LINK 
network controller. Note that this is only possible when the connected node is the polling 
(server) node – otherwise the Write pushbutton is disabled. The status display indicates 
whether the write operation was successful. 

 4. Select the Close pushbutton to remove the dialog. 

Controller Link Settings 
The Controller Link menu only appears when the end connection is the Controller Link network. It allows settings 
specific to a Controller Link network to be made. 

Network Status 
The Controller Link Network Status dialog shows the nodes present on the network. It also indicates the controlling 
server node. Use the following procedure to setup Controller Link Network Status settings. 

1, 2, 3… 1. Select the Network Status option from the Controller Link menu. 
 2. Select the Close pushbutton to remove the dialog. 

Network Settings 
The Network Setup dialog allows parameter settings for a Controller Link network to be defined; this includes the 
maximum number of nodes on a network, the maximum number of polling units per communications cycle, and the 
maximum number of frames per communications cycle. 

On entry, this dialog displays the last parameters entered for a selected network. Use the following procedure to 
setup Controller Link Network Setup settings. 

1, 2, 3… 1. Select the Network Setup option from the Controller Link menu. 
 2. Adjust the settings as required (or select the New pushbutton to return to the default values 

for the network). 
 3. Select the Write pushbutton to download the network parameters to the SYSMAC LINK 

network controller. Note that this is only possible when the connected node is the polling 
(server) node – otherwise the Write pushbutton is disabled. The status display indicates 
whether the write operation was successful. 

 4. Select the Close pushbutton to remove the dialog. 

Routing Tables 
Routing tables allow networked PLCs to be configured so that they can communicate with each other via gateways; 
across remote networks. These tables contain the network and unit number information required. It is only 
necessary to set up routing tables if the end connection PLC is not a direct connection, i.e. using another PLC as a 
gateway connection. The routing table is held within the PLC(s) which acts as the gateway device. Different types 
of PLC and networks have different capabilities for routing. 

For details about using routing tables refer to Chapter 11 – Routing Tables. 

Data Link 
Data Link tables allow a PLC to be configured so that it can participate in one or more automatic data sharing 
schemes, over SYSMAC LINK, SYSMAC NET and Controller Link networks, without the need for special 
programming. Words of IO and DM can be set aside for use as data link words, which are allocated to various 
nodes in the network. Limits on the amount of data and number of nodes varies with the type of network and the 
type of PLC. The allocation of words to nodes is defined by two or more Data Link tables. 

Data can only be shared on a single physical network. A gateway cannot be used to pass information from one 
network to another. 
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SYSMAC NET data links can be configured so that both C-Series and CV-Series PLCs can share data. However, 
it is a limitation that in these mixed configurations, the master must be a C-Series PLC. There are no such 
restrictions on a SYSMAC LINK or Controller Link network. 

The Data Link menu includes options to setup the SYSMAC NET, SYSMAC LINK and Controller Link Data 
Links. 

The DataLinks Editor is used to configure SYSMAC LINK and Controller Link data links, Refer to Chapter 10 – 
Data Links.  

A separate datalink editor is utilised for configuration of SYSMAC NET datalinks, Refer to Chapter 8 - Offline 
SYSMAC NET Data Link Editor for further details. 

Data Link Setup 
The Data Link Setup dialog varies in title and content according to the type of network connected to the current 
PLC; however, the pushbutton functions on each dialog are the same. 

The dialog lists the contents of the Data Link table associated with the PLC; initially the Data Link table displayed 
is empty, or set to zero, until a table has been opened or read. 

SYSMAC NET Data Link Setup 
The setup dialog first needs to know whether the Data Link table is written for CV-Series or C-Series PLC type 
SYSMAC NET this information is requested using the SYSMAC NET Table Type dialog. 

Use the following procedure to setup the SYSMAC NET Data Link. 

1, 2, 3… 

 

1. Select the Online Edit Data Link button from the toolbar. 
2. Select a setting to indicate the type of SYSMAC NET which is used in the Data Link. 

 3. Select the OK pushbutton to continue (the Data Link Setup dialog is displayed), or the 
Cancel pushbutton to abort the operation. 

Opening a Table 

Use the following procedure to open a table. 

1, 2, 3… 1. Select the Open pushbutton to open a Data Link table from disk (alternatively select the 
Read pushbutton to view the table in the PLC). 

 2. Select the appropriate table and select the OK pushbutton. 
 3. The Data Link Setup dialog is now populated with the contents of the Data Link file. 
 4. Select the Write pushbutton to transfer the table to the PLC. 
 5. Select the Verify pushbutton to compare the contents in the dialog with those in the PLC. 

Note: Data Link tables have a ‘.SL3’ (SYSMAC LINK), ‘.SN3’ (SYSMAC NET) or ‘.CL3’ 
(Controller Link) filename extension. 

Editing a Table 

To edit the displayed Data Link table, click on the Edit pushbutton; the associated offline table editor is used, refer 
to Chapter 10 – for SYSMAC LINK / Controller Link Data Link Editor and Chapter 8 - Offline SYSMAC NET Data 
Link Editor for further details. 

Updating Table Status 

After an editing session using the offline editor (i.e. after pressing the Edit pushbutton), the dialog can be updated 
using the Update pushbutton. 

Saving a Table 

The Save As dialog allows the displayed table to be saved to disk with a given name. Use the following procedure 
to save a table. 

1, 2, 3… 1. Click on the Save As pushbutton in the Data Link Setup dialog. The Save As dialog is 
displayed. 

 2. Enter the new file name for the data link table (ensure that the file type is correct) in the File 
name field. 
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 3. Either select the Save pushbutton to save the new file and return to the previous dialog or 
select the Cancel to abort the operation. 

Deleting a Table in a PLC 

The current Data Link table held in the PLC can be deleted by selecting the Delete pushbutton. 

Viewing Table Information 

The Table Information dialog displays basic information relating to the selected Data Link table indicating the 
author, associated network and file name. The information displayed on this screen cannot be edited whilst online. 
Use the following procedure to view table information. 

1, 2, 3… 1. Select the Info pushbutton on the Data Link Setup dialog. 
 2. Select the Close pushbutton to remove the dialog from the screen. The Data Link Table 

dialog is redisplayed. 
Select the New pushbutton in the dialog to clear the dialog information. 

Offline SYSMAC NET Data Link Editor 
The SYSMAC NET Data Link Table Editor is available to both CV-series and C-series PLCs linked to a SYSMAC 
NET unit. 

 
The status bar provides instant help. 

 
Access to the SYSMAC NET Data Link Editor dialog is achieved in a number of ways: 

♦  From the CX-Net Network Configuration tool. Select Editor from the Data Link menu. The 
Select New File type dialog is displayed. Select the SYSMAC NET file type from the File 
Type field and select the OK pushbutton. 

♦  From the Data Link Setup dialog. Select the Edit pushbutton. 
♦  From the Start pushbutton in the Microsoft Windows taskbar. The Select New File type 

dialog is displayed. Select the SYSMAC NET file type from the File Type field and select 
the OK pushbutton.  

Creating and Editing a SYSMAC NET Data Link Table Item 
Use the following procedure to creates SYSMAC NET Data Link Table Item. 

1, 2, 3… 

 

 

1. Select the New button from the toolbar in the SYSMAC NET Data Link Table Editor 
dialog. 

2. Select the Insert Table Item option from the Table menu. Address information can also be 
edited by double-clicking on the required node.  

The Add SYSMAC NET Data Link Table Item dialog allows the memory area at the node to be configured. Use the 
following procedure to configure the node. 

1, 2, 3… 1. Enter the node number in the Node No field; this must be in the range 1 to 126. /verify 
where 



CX-Server PLC Tools  
CHAPTER 8 – CX-Net Network Configuration Tool OMRON 
 
 

CX-Server PLC Tools Page 70 

 2. Enter the memory size; this must be in the range 0 to 127.  
 3. Select the OK pushbutton to redisplay the Data Link Table Editor. 

Note: The above example applies to CV-Series, but C-Series operates in exactly the same 
manner although the information displayed differs slightly. 

 
To edit a Data Link table, double-click on a table item or select the Edit Table Item button from 
the toolbar; the Edit Data Link Table dialog is displayed (this is identical to the Add Data Link 
Table Item dialog shown above).  

Deleting an Item from the SYSMAC NET Data Link Table 
Use the following procedure to delete an item from the SYSMAC NET Data Link Table. 

1, 2, 3… 1. Select the node to delete an item and select the Delete Item button from the toolbar. 

 
2. A confirmation dialog is displayed. Select the Yes pushbutton to confirm the deletion of the 

item. Select the No pushbutton to abort the operation. 

Opening an Existing SYSMAC NET Data Link Table 
Use the following procedure to open an existing SYSMAC NET Data Link Table. 

1, 2, 3… 

 

1. To open a table from disk, select the Open button from the toolbar in the Data Link Editor 
dialog. A standard File Open dialog is displayed. 

 2. Select a file from the Open dialog and select the Open pushbutton. The SYSMAC NET 
Data Link Table Editor is automatically populated with the contents of the selected file. 

Note: SYSMAC NET Data Link table files are identified by the ‘.SM3’ extension. 

Logical Error Checking 

 
The SYSMAC NET Data Link Table Check dialog displays any errors resulting from validation 
of the address details entered in the table; it is identical in appearance to the SYSMAC LINK 
Data Link Table Check dialog shown earlier and is obtained in the same way. 

Old Format Tables 
Data Link tables were previously held in ‘.SNT’ and ‘.SN2’ file format. The File Open dialog allows these file 
types to be opened in the CX-Net Network Configuration tool. Use the following procedure to open ‘.SNT’ and 
‘.SN2’ formatted files. 

1, 2, 3… 1. Select the Add (old) option from the Table menu in the SYSMAC NET Data Link Table 
Editor dialog. 

 2. Select a file from the Open dialog and select the Open pushbutton.  

Table Information 

 The Data Link Table Information dialog allows the recording of comments against a particular 
table and is the same both in operation and appearance, as that for the routing table comments 
described earlier. 
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 CHAPTER 9 
PLC Clock Tool 

The PLC Clock tool provides a facility to monitor and set the PLC Clock and synchronise the PLC clock to the PC 
clock. 

The PLC Clock tool dialog can be set so that it remains ‘on top’ and is not obscured by other windows by clicking 
the right mouse button in the task bar and selecting the Always on Top option. 

 To close the PLC Clock dialog, select the Close button in the title bar.  

 
 

The PLC Clock tool displays two clock images that represent the time for the computer (PC) on the left and the 
PLC on the right. The time and date are also represented in a digital format for both the computer and the PLC. 

The times for both the Computer and the PLC are updated once a second. 

A synchronise button is located centrally between the two clock images. This button once pressed, will synchronise 
the PLC clock to the computer clock. The same effect can also be evoked from the Options – Synchronise Clocks 
menu. 

The File menu allows the PLC Clock tool to be closed by use of the Exit menu item. 

The Options – Set PLC Clock allows the time and date within the PLC to be set. 

If the PLC Clock window is minimised the PLC clock time will be displayed in digital format in the task bar. 
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 CHAPTER 10 
Data Links 

What Are Data Links? 

Overview 
Data links automatically exchange data in preset areas between nodes (PLCs and/or computers) on a network. 
Settings can be made either manually or automatically.  

CX-Net operations can be used for all operations from setting up the PLC network to controlling data exchange. 

Manual Settings 
Manual settings enable more flexible allocations, including the send size for each node, the sequence of nodes for 
sending and receiving, and the setting of nodes for sending only or receiving only. Use manual settings to create 
flexible data links to meet the requirements of the individual system (e.g., efficient utilization of memory, 
restrictions on allocated addresses, etc.).  

Data link tables (i.e., tables that define data link area allocations) are generated by CX-Net or network support 
software (such as Controller Link Support Software), and sent to all nodes for use. 

Controller Link

PC PC PC

 

Note: The following table provides a general comparison of manual setup between Controller 
Link and SYSMAC LINK. 

Item Controller Link SYSMAC LINK 

Node sequence Free 

Send size Can be specified. 

Receive-only nodes Supported Supported 
 (Reception only is enabled by 

setting the send area size at the 
local node to 0.)  

Send-only nodes Supported 

Memory area Can be specified. Cannot be specified. Fixed as 
follows: 

CS/CJ/CV Series: Area 1: CIO; 
Area 2: DM 

C Series: Area 1: LR; Area 2: DM 

Receive size Can be specified. All or none 

Reception offset (reception 
from start address + specified 

number of words)  

Can be specified. No (From start address only)  

Communications cycle time Cannot be set. Can be set. 

PLC PLC PLC
Controller Link
Unit 

Only part of area 

Only part of area 
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Automatic Settings 
Automatic settings can be used for simple data exchanges involving fixed allocations, when all nodes are set for the 
same send size and the same data is to be shared among all nodes in order of node address. 

Using a Programming Device (such as the CX-Programmer or a Programming Console), set the data exchange 
method in the DM parameter area of the startup node. 

Controller Link

 

Note: The following table provides a general comparison of automatic setup between 
Controller Link and SYSMAC Link. 

Item Controller Link SYSMAC LINK 

Node sequence Fixed at ascending order. 

Receive-only nodes Not supported. 

Send-only nodes Not supported. 

Memory area Can be specified. (Area 1: CIO 
Area or LR Area; Area 2: DM Area 

or EM Area)  

Cannot be specified. Fixed as 
follows: 

CS/CJ/CV Series: Area 1: CIO; 
Area 2: DM 

C Series: Area 1: LR; Area 2: DM 

Start address Can be specified. Cannot be specified.  

Send size Same size for all nodes can be 
specified. 

Same size for all nodes can be 
selected from specific patterns. 

 

This section describes how to perform Controller Link and SYSMAC LINK operations from creating data link 
tables to starting up the data links. 

PLC PLC PLC 
Controller Link 
Unit 

Data exchange (shared data)  
(I/O Area, LR Area, DM Area, etc.)
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User Interface Overview 

Datalink Component 
The following illustration shows the window used when constructing Controller Link or SYSMAC LINK data links 
manually. 

 

Data Link 
Configuration 
window 

Node Editing 
window 

Toolbar 

Function Bar 
 

Data Link Component Menu 
Menu Sub-menus/Com

mands 
Function 

New Creates new data link tables. 

Open Opens data link tables, Files with any of the file name extensions 
shown below can be opened. 

When a file is opened, the proper editor starts up. 

Controller 
Link 

♦  cl2 – CX-Net Controller Link/CLKSS data link tables 
♦  cl3 – CX-Net Controller Link data link tables 
♦  clk – CLKSS data link tables 
♦  csv – CX-Net Controller Link data link tables (tab-delineated text 

file)  

 

SYSMAC 
LINK 

♦  .sl3 – SYSMAC LINK data link tables 
♦  .slk – SYSMAC LINK data link tables for SYSMAC Support 

Software 
♦  .csv – SYSMAC LINK data link tables (tab-delineated text file)  

Save Saves the data link tables that are being edited. 

Save As Saves data link tables, Files with any of the file name extensions 
shown below can be saved. 

Controller 
Link 

♦  .cl2 – CX-Net Controller Link/CLKSS data link tables 
♦  .cl3 – CX-Net Controller Link data link tables 
♦  .clk – CLKSS data link tables 
♦  .csv – CX-Net Controller Link data link tables (tab-delineated text 

file)  

 

SYSMAC 
LINK 

♦  .sl3 – CX-Net SYSMAC LINK data link tables 
♦  .csv – CX-Net SYSMAC LINK data link tables (tab-delineated 

text file)  

Print Prints data link information. 

File 

Print Preview Previews the data to be printed. 
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Menu Sub-menus/Com
mands 

Function 

 Exit Exits the Datalink Component window. 

Move Right Moves the cursor to the right in the Data Link Configuration window. 

Move Left Moves the cursor to the left in the Data Link Configuration window. 

Move Up Moves the cursor up in the Data Link Configuration window. 

Move Down Moves the cursor down in the Data Link Configuration window. 

Change Window Changes the active window. 

Zoom Out Zooms out from within the Data Link Configuration window. 

Zoom In Zooms in within the Data Link Configuration window. 

Zoom Original Returns the Data Link Configuration window to its initial scale. 

Show in List Shows the Data Link Area settings in list format. 

Show in Table Shows the Data Link Area settings in table format. 

Show Func Bar Shows function key guides at the bottom of the Datalink Component 
window. (Enabled for table format only.)  

View 

Show Offset Shows the specified offset value on the Node Editing window. 

Wizard Executes the Datalink Wizard. 

Add Source Link Adds a node to the data links.  

Add Destination Adds the receive area of a participating node to the data links. 

Delete Deletes nodes. 

Validate Table Checks data link tables. 

Table Information Edits data link table information. 

Show Node List Displays a list of nodes. 

Table 

Redraw Resets colored displays. 

Transfer from PLC Uploads online data link tables to the computer. 

Transfer to PLC Downloads online data link tables from the computer to a PLC. 

Verify Node Compares data link tables generated by CX-Net with data link tables 
stored in the PLC. If they do not match, a error dialog box is displayed. 

Data Link 
Operation/Status 

Displays the operation and data link status of manually set data links. 

Automatic Data 
Link Setup 

Sets parameters for automatically set data links, and transfers them 
to the startup node. 

Set All Nodes for 
Network Operation 

Executes transfer, verify, and delete operations for all nodes.  

Show All Network 
Nodes 

Reads data link tables from all nodes. 

Online 

 

Delete Deletes data link tables. 

Options Cycle Time Sets the communications cycle time (for SYSMAC LINK data link 
tables only). 

Help Displays help. 
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Toolbar 

 
(1) (2) (3) (4) (5) (6) (7) (8) (9) (10) (11) (12) (13) (14) (15) (16) (17) (18) (19) (20) 

No. Icon Function 

(1) New Creates new data link tables. 

(2) Show All Network Nodes Shows all nodes in the network. 

(3)  Opens a data link tables, Files with any of the file name 
extensions shown below can be opened. 
When a file is opened, the proper editor starts up. 

Controller Link .cl2 – CX-Net Controller Link/CLKSS data link tables 
.cl3 – CX-Net Controller Link data link tables 
.clk – CLKSS data link tables 
.csv – CX-Net Controller Link data link tables (tab-delineated 

text file)  

 

Open 

SYSMAC LINK .sl3 – SYSMAC LINK data link tables 
.slk – SYSMAC LINK data link tables for SYSMAC Support 

Software 
.csv – SYSMAC LINK data link tables (tab-delineated text 

file)  

(4) Save Saves the data link tables that are being edited. 

(5) Toggle Network/Single Node 
Operation 

Specifies either all nodes or a single node for data transfers. 

(6) Transfer to PLC Downloads online data link tables from the computer to a PLC. 

(7) Transfer from PLC Uploads online data link tables to the computer. 

(8) Delete Deletes data link tables. 

(9) Verify Node Compares data link tables generated by CX-Net with data link 
tables stored in the PLC. If they do not match, a error dialog box 
is displayed. 

(10) Data Link Operation/Status Displays the operation and data link status of manually set data 
links. 

(11) Automatic Data Link Setup Sets parameters for automatically set data links, and transfers 
them to the startup node. 

(12) Validate Table Checks data link tables. 

(13) Wizard Executes the Datalink Wizard. 

(14) Add Source Link Adds a node to the data links. 

(15) Add Destination Adds the receive area of a participating node to the data links. 

(16) Set Source or Destination 
Link Area Properties 

Displays the Node Settings dialog box. This dialog box is used 
to modify the node properties. 

(17) Delete Link Destination 
Service Area 

Deletes nodes selected in the Data Link Configuration window, 
or deletes a receive area. 

(18) Zoom In/Zoom Out/Zoom 
Original 

Zooms the Data Link Configuration window in or out, or returns 
it to the initial scale.  

(19) Print Prints data link information. 

(20) Help Displays help. 
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Function Bar 

 

(1) (2) (3) (4) (5) (6) (7) (8) (9) (10)  

No. Icon Function 
(1) F1: Help Displays help. 

(2) F2: Node<->Table Moves the focus between nodes and tables. 

(3) F3: Link Start Address Moves the focus between settings for the link start addresses 
(status, Area 1, Area 2).  

(4) F4: Move Up Area Moves a node up the node refresh sequence. 

(5) F5: Move Down Area Moves a node down the node refresh sequence. 

(6) F6: Show/Hide Offset Shows or hides the offset for the node being displayed. 

(7) F7: Insert Area Inserts a new receive area (new node). 

(8) F8: Delete Node Deletes a node or communications area. 

To delete a node or link area from a node list, select the item from 
the list and then click F8: Delete Node. 

To delete a node or link area from a table, select the item from the 
table and then click F8: Delete Node.  

(9) F9: Show Prev Node Shows the previous node. 

(10) F10: Show Next Node Shows the next node. 

 

Manually Setting Data Links 
 

Follow the procedure described below to create data link tables manually for Controller Link or SYSMAC LINK 
data links. 

Note: There is no need to create a data link tables when data links are set automatically. For 
details on automatic setup, refer to Automatically Set Data Links.  
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Procedure through Data Link Startup 

 

Reading the Data Link Tables, and Transferring Them to the PLC from Datalink Component
window 
1) Data Link | Setup 
2) Select either Controller Link Unit or SYSMAC LINK Unit as the Communications Unit 
  mounted to the PLC. (For the local network only, i.e., when the network address is 0.)  
3) File | Open 
4) Online | Transfer to PLC 

Connect Online (CX-Net: PLC | Open). 

Creating a CX-Server File (*.CDM) for Online Connection. 
1) Select New from the Project menu, and save the file under a file name. 
2) Select Add Device from the Project menu, and register the PLC. 

Save the data link tables (Datalink Component window: File | Save). 

Check the data link tables (Datalink Component window: Table | Validate Table). 

Start the software. 
Open the Datalink Component window (Data Link | Setup | Controller Link or SYSMAC 
LINK or SYSMAC NET). 

 

Creating Data Link Tables Online 
1) Datalink Wizard Settings (Table | Wizard). Use the manual setting function if the data  
  link tables are to be created manually. 
2) Node Edit Window Settings 

Starting the Data Links from the Datalink Component Window 
1) Data Link | Setup 
2) Select either Controller Link Unit or SYSMAC LINK Unit as the Communications Unit 
mounted to the PLC. (For the local network only, i.e., when the network address is 0.)  
3) Online | Data Link Operation/Status 
4) Select the Run option in the Operation field, and click the Set button.  
 

 

Reference: Create data link tables manually when any of the following conditions is present: 
1 The send area size differs for nodes participating in the data link. 
2 The sequence of send nodes differs from the sequence of node addresses. 
3 There are nodes that receive only part of the send data (Controller Link only). 
4 There are nodes that receive data with an offset specified (Controller Link only). 
5 There are nodes that do not send data (Controller Link only). 
6 There are nodes that do not receive data. 

Creating Data Link Tables 
Create a data link table for each node registered in the CX-Server file that is read. 
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Make the settings for (1) to (8) below. 

 
 
 

 

Node 2 
(receive) 

(3)  
Area setting 
(area/start 
address) 

(4) Send size 

(2) Node 1 
PLC type 

 

 

Node 1 
(send) 

Node 3 
(receive) 

(7) Receive  
sizes from 
remote nodes

(5) Node refresh sequence:  
  2,  1,  3       1,  2,  3          2,  1,  3 

(6)  
Status area 

Node 3 
(receive) 

Node 3 
(send) 

Node 2 
(send) 

Node 1 
(receive) 

Node 1 
(receive) 

Node 2 
(receive) 

 

Data link 
status 

Data link 
status 

Data link 
status 

Node 2
PLC 

Node 3 
PLC 

(8) 
Offsets

(1) Participating data link nodes 

 
To create a data link table, make the following settings in order. 

1 Datalink Wizard Settings 

 

(1) Set participating data link nodes.  

 

(2) Set the PLC type. 

(3) Set the areas. 

(6) Set the status area. 

(5) Set the refresh node sequence. 

(4) Set the send size. 

 
2 Node Editing Window Settings 

 (7) Set receive sizes from remote nodes.

(8) Set offsets.  

 

 

Note 1: It is possible to add or delete nodes from the participating data link nodes (1) using the 
Datalink Wizard. 
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Adding nodes Select Table | Add Source Link. 
Add 

Adding link words Select Table | Add Destination. 

Deleting specified nodes or link areas Select the node from the node list, and 
then click F8: Delete Node. 

Delete 
Deleting link areas from specified nodes Select the node from the table, and then 

click F8: Delete Node. 

Note 2: It is possible to change the following items set by the Datalink Wizard for each node: (2) 
PLC type, (3) Area (memory area and start address), (4) Send size, (5) Node refresh 
sequence (see note 3), and (6) Status area.  

Note 3: The node refresh sequence is set using F4: Move Up Area and F5: Move Down Area. 
Reference: The operations differ for Controller Link and SYSMAC LINK when creating data links. 

The following table shows the points on which the manually set data link functions are 
different. 

Function Controller Link SYSMAC LINK 
(1) Offset setting Supported Not supported 

(2) Receive size setting Supported Not supported. (It is only possible 
to specify whether all of none of 
the data sent is to be received.)  

(3) Memory area Area 1: Can be selected. 

Area 2: Can be selected. 

(CIO, LR, DM, EM, etc., 
according to PLC type)  

Area 1: CIO 

Area 2: DM 

(Fixed.)  

(4) Communications cycle time 
setting 

Not supported Supported 

These four differences apply even to data link setup operations using the CX-Net. Aside from these points, other 
operations are basically the same. 

System Configuration Example 
The procedure is described below, from data link creation through startup, taking a Controller Link data link 
system as an example. 

 

CX-Net 

Controller Link network 

CS1G-CPU45 

Peripheral Bus or Host Link 

Data link 

CS1G-CPU45 C200HX 

1 2 3 

Data link 

PLC type 

Node address 
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Data Link Setup Example 

  

 Area 2 

 Send (#1) 

Receive (#2) 

Receive (#3) 

DM500 

DM530 

DM560 

DM600 

Node 1 

 Send (#2)

Receive (#1)

Receive (#3)

Node 2 

 
Send (#3) 

Receive (#1) 

Receive (#2) 

Node 3 
DM600

DM630

DM660

DM700

DM730

DM760

Area 1 

 Send (#1) 

Receive (#2) 

Receive (#3) 

CIO 1000 

CIO 1030 

CIO 1060 

CIO 1100 

Node 1 

CS1G 

 Send (#2)

Receive (#1)

Receive (#3)

Node 2 

CS1G

 
Send (#3) 

Receive (#1) 

Receive (#2) 

Node 3 

C200HX 

CIO 1200

CIO 1230

CIO 1300

IR  300

IR  320

IR  350

IR  390

CIO 1260
Size 

20 words 

Offset 
10 words 

DM700 DM800

 
The refresh sequence for nodes 1 and 2 is as follows: #1, #2, #3. For node 3, the order is #2, #1, #3. Node address 
03 does not receive all of the data sent from node address 02. Rather, data from the 20 words (CIO 1240 to CIO 
1259) beginning from the start address +10 words (i.e., the offset) is received in IR 300 to IR 319. Other data is 
received with no offset. 
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Creating Data Link Tables Offline 
First create manually set data link tables offline. 

Datalink Wizard Operations 
1 While offline, select Setup from the Data Link menu in CX-Net. The Data Link dialog box will be displayed. 

  
2 Select either Controller Link or SYSMAC LINK, and then click the OK button. 

The Datalink Component window will be displayed. 
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3 Select Table | Wizard. If data link tables have already been input, the following dialog box will be displayed. 
(It will not be displayed if these are the first data link tables being created.)  

 

 
4 Click the Yes button. The Datalink Wizard dialog box will be displayed for setting the participating data link 

nodes. 

 

Addresses of nodes to participate in the 
data links. 

If this box is selected, fast 
default table generation will 
be set when the Defaults 
button is clicked. In that 
case, all nodes will be set 
as a group, using the initial 
values that have been set. 

Clicking the Defaults button 
sets the initial values used 
for fast default table 
generation. 

 
5 Set the addresses of the nodes that are to participate in the data links. In this case, input 1-3 to set node addresses 

01 to 03. (To set node addresses 01, 02, and 04, for example, input 1,2,4.)  
6 Click the Next button or press the Enter key. The following dialog box will be displayed. 

  

(1) 

(2) 

(3) 

(6) 

(4) 

(5) 

(7) 

(8) (9) 

 

 

No. Item Function 
(1) Node Displays node number to set. 

(2) PLC Sets the PLC type. 

(3) Memory area Area 1 memory area 

  Area 2 memory area 
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No. Item Function 
(4) Start Address Area 1 start address 

  Area 2 start address 

(5) Size Area 1 local node send size (in words)  

  Area 2 local node send size (in words)  

(6) Status Data link status memory area (See note.)  

(7) Ordered Destination 
Nodes 

Node Refresh Sequence 

Beginning with the data link start address above, specify which nodes are to 
have data refreshed at the local node address and the order in which data is 
to be refreshed (i.e., the node refresh sequence). This order will be the same 
for Area 1 and Area 2. 

(For the local node address, data is sent from the local node area. For a 
remote node address, data is received from the remote node address to the 
local area.)  

Note: •  The local node must be included in the refresh nodes. 

•  If the address of any node participating in the data links is not entered 
here, data will not be received from that node. 

Example: If 1, 2, 3 is input, node addresses 1, 2, and 3 will be allocated in 
order, beginning with the start address. 

(8) Make Default Click this button to make the values set for the above items the default values 
for new data link settings. 

(9) Next >> Click to proceed to the next dialog box. 

 
Note: The default setting for data link status depends on the PLC being used. For details, refer to the Controller 

Link Units Operation Manual (W309). 
PLC Data link status 

CS/CJ Series 
CVM1/CV Series 

The data link status is contained in the 16 words (fixed) from CIO 1500 +25 × unit number + 
7 to 22 in the CPU Bus Unit Area. 
  15  8 7  0

+7 words Node 2 Node 1 
... ... ... 

+22 words Node 32 Node 31  
C200HX/HG/HE The data link status for node addresses 1 to 6 only is contained in the words from SR 239 to 

SR 241, and SR 241 to SR 245. 
 Network 0 Network 1 15  8 7  0

SR 239 SR 243 Node 2 Node 1 
SR 240 SR 244 Node 4 Node 3 
SR 241 SR 245 Node 6 Node 5 

 
CQM1H Series The data link status for node addresses 1 to 6 only is contained in the words from IR 91 to IR 

93. 
  15  8 7  0

IR 91 Node 2 Node 1 
IR 92 Node 4 Node 3 
IR 93 Node 6 Node 5  

 
7 Set node address 01 as shown in the following table, and then click the Next button or press the Enter key. Set 

node addresses 02 and 03 in the same way. 

Item Data set Description 
Node address 1 − 

PLC type CS1G-CPU45 − 
Memory area CIO 

Start address 1000 

Sets CIO 1000 as the data link start 
address for the Area 1 local node. 

Area 1 

Send size 30 Sets 30 words as the send size (unit: 
words) for the Area 1 local node. 

Memory area D 

Start address 500 

Sets D00500 as the data link start 
address for the Area 2 local node. 

Area 2 

Send size 30 Sets 30 words as the send size (unit: 
words) for the Area 2 local node. 
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Item Data set Description 
Ordered destination nodes 1, 2, 3 Specifies the node refresh sequence. 

Beginning with the start addresses, 
nodes 01, 02, and 03 are set in order. 
(The local node address is 1, so 
transmission is first, followed by 
reception from node 02, and finally 
reception from node 03.)  

Memory area CIO Status 

Start address 1100 

Sets CIO 1100 as the data link status 
start address. 

 
8 Set node address 02 as shown in the following table. 

Item Data set Description 
Node address 2 − 

PLC type CS1G-CPU45 − 
Memory area CIO 

Start address 1200 

Sets CIO 1200 as the data link start 
address for the Area 1 local node. 

Area 1 

Send size 30 Sets 30 words as the send size (unit: 
words) for the Area 1 local node. 

Memory area D 

Start address 600 

Sets D00600 as the data link start address 
for the Area 2 local node. 

Area 2 

Send size 30 Sets 30 words as the send size (unit: 
words) for the Area 2 local node. 

Ordered destination nodes 1, 2, 3 Specifies the node refresh sequence. 
Beginning with the start addresses, nodes 
01, 02, and 03 are set in order. (Reception 
from node 01 is first, followed by 
transmission from the local node, and 
finally reception from node 03.)  

Memory area CIO Data link status 
start address 

Start address 1300 

Sets CIO 1300 as the data link status start 
address. 

 
9 Set node address 03 as shown in the following table, and then click the Next button or press the Enter key. 

Item Data set Description 
Node address  3 − 

PLC type  C200HX − 
Memory area IR 

Start address 300 

Sets IR 300 as the data link start address 
for the Area 1 local node. 

Area 1 

Send size 40 Sets 40 words as the send size (unit: 
words) for the Area 1 local node. 

Memory area DM 

Start address 700 

Sets DM 700 as the data link start address 
for the Area 2 local node. 

Area 2 

Send size 40 Sets 40 words as the send size (unit: 
words) for the Area 2 local node. 

Ordered destination nodes 2, 1, 3 Specifies the node refresh sequence. 
Beginning with the start addresses, nodes 
02, 01, and 03 are set in order. (Reception 
from node 02 is first, followed by reception 
from node 01, and finally transmission from 
the local node address.)  

Memory area LR Data link status 
start address 

Start address 0 

Sets LR0 as the data link status start 
address. 
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Reference: Fast Datalink Wizard Settings 

It is possible to generate a table with all nodes set for the same PLC type and the same 
areas (using Fast Default Table Generation), and then to modify individual nodes in the 
Node Editing window as required. 
Make the settings as follows: 

  
1 Click the Defaults button and then set the default values in the following 

dialog box. 

 
2 Select the Fast Default Table Generation option, and then click the Next

button or press the Enter key.  
The settings for all participating nodes will be generated at the above 
default values. 

♦  PLC type 
♦  Memory area, data link start address, communications data size 
♦  Status memory area  
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Node Editing Window Settings 
10 The following Datalink Component window will be displayed. 

 

Data Link 
Configuration 
window 

Node Editing 
window 

 

Data Link Configuration Window 

 

Indicates the data link memory area. 

Indicates the data link 
memory area. 
1: Area 1 
2: Area 2 

The same color indicates that 
data is shared among nodes. 

The ovals indicate the send 
areas (Area 1 and Area 2).

            : The arrows indicate the direction of data transfer. 

The rectangles indicate the receive 
areas (Area 1 and Area 2). 

Participating data link node 
address 

 
Send areas are indicated by ovals in order of the addresses of nodes participating in the data links. The same color 
indicates that data is shared among nodes. Therefore, with the number of participating nodes represented by n, one 
oval and n-1 rectangles are shown for each node. 

This window can be used to check the data sent and received between nodes. 
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Node Editing Window Settings 

Set the data link details for each node (i.e., send size, receive size, reception offset) in the Node Editing window. 

Note: The Node Edit window appears in table format by default, as shown below. To convert 
it back into the earlier list format, select View | Show in List. 

 

 
(1) (2) (5) (6) (7) (8) (9)

(10)(4) 
(3) 

The settings for each active node 
shown in the node field to the left 
are displayed here. 

 

No. Name Description 
(1) Node Selects the address of the node to be edited. 

The settings for an active node (selected with ) are displayed to the right. 

(2) PLC The PLC type set by the Datalink Wizard is displayed and can be changed here. 

(3) Status The status memory area and start address set by the Datalink Wizard are displayed and can 
be changed here. 

(4) Area 1/Area 2 The Area 1 and Area 2 classifications and start addresses set by the Datalink Wizard are 
displayed and can be changed here. 

(5) Node 
(Display only. Order 
can be changed.)  

•  Node addresses are displayed from top to bottom, in order of node refreshing at the local 
node (in order of allocated node address).  

•  To change the refresh sequence set by the Datalink Wizard, click either F4: Move Up Area 
or F5: Move Down Area in the Function Bar, or press the corresponding Function key. 

(6) Link Addr. 
(Automatic display)  

•  For the local node send area, the start address of the data sent from the local node is 
automatically displayed. 

•  For the receive area from remote nodes, the local node start address for storing data 
received from remote nodes is automatically displayed. 

(7) Size 
(Setting/Display)  

•  For the local node send area, the send size set by the Datalink Wizard is displayed and can 
be changed here. 

•  For the receive area from remote nodes, the receive size from remote nodes is set here in 
word units. (It can only be set here.) The default is the entire send size from remote nodes. 

(8) Offset 
(Setting/Display)  

The reception offset from the source start address displayed at “Src. Addr.” is set here. (The 
default is 0.)  

(9) Src. Addr. 
(Automatic display)  

•  For the local node send area, “Send” is automatically displayed. 

•  For the receive area from a remote node, the remote node’s source start address (the 
value before the offset) is automatically displayed. 

(10) F4: Move Up Area 
F5: Move Down 
Area 

Changes the node refresh sequence. 
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Node Editing Window (Edited Node Address: Node 01)  

Function 
(1) Indicates that 20 words (D00000 to D00019) from 

a remote node (node 03) are received into the area 
starting from CIO 01000 (i.e., CIO 01000 to CIO 
01019) at the local node (node 01). 

(2) Indicates that 30 words starting from CIO 01020 
(i.e., CIO 01020 to CIO 01049) from the local 
node (node 01) are sent to a remote node. 

 Address at local node 

(1)

(2)

(3)

Indicates that the node refresh sequence at the local 
node (node 01) is 03 to 01 (local node) to 02. 

Address at remote node 

 

(3) Indicates that 40 words (CIO 00200 to CIO 
00239) from a remote node (node 02) are received 
into the area starting from CIO 01050 (i.e., CIO 
01050 to CIO 01089) at the local node (node 01). 

Reference: It is also possible to display the Node Editing window in list format, as before. 
Select View | Show in List from the menu. The change will go into effect the next time 
the window is opened. 

 

 

Node Editing window 

 

Setting Size (Send or Receive) and Offset 

♦  The send size can be set for the local node row by double-clicking in the Size cell. (The default is the size set 
by the Datalink Wizard.) For remote node rows, the receive size can be set. (The default is the entire send size 
from remote nodes.)  

♦  The reception offset can be set by double-clicking the Offset cell. (The default is 0.)  

 Size and offset can be set.

Automatically displayed.
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Reference: Size modifications and offsets can be set in the Area Specify dialog box that is displayed 
by double-clicking on the data link configuration icon (oval for send area  or 
rectangular for receive area ). 

 
Area Specify Dialog Box (Send Area)  

 

Specify send size.
Offset cannot be changed. 

 
Area Specify Dialog Box (Receive Area)  

 
Specify send size.

Offset cannot be changed. 

 

Note: With SYSMAC LINK, the send size can be set, but the receive size and the reception 
offset cannot. Therefore, the Area Specify dialog boxes are as shown in the following 
example diagrams. 

•  Send Area •  Receive Area 

Can be set. Cannot be set. 
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Changing Node Refresh Sequences 

The node refresh sequence set for each node by the Datalink Wizard can be changed in the Node Editing window. 

In the Node Editing window, select the node for which the refresh sequence is to be changed. 

 

Change the node refresh sequence by either clicking F4: Move Up Area or F5: Move Down Area in 
the Function Bar, or pressing the F4 or F5 function keys. 

 
Reference: The node refresh sequence for individual nodes cannot be checked in the Data Link 

Configuration window. Node refresh sequence checking and changes must be 
performed in the Node Editing window. 

Adding Participating Nodes to Data Links 

In the Node Editing window, it is possible to add nodes aside from the participating nodes set by the Datalink 
Wizard’s Network Nodes setting. 

 

The following window is displayed by selecting Table | Add Source Node from the Datalink Component menu or 

by clicking the  button in the Toolbar. 

 
Specify the node address, PLC type, and the Area 1 and Area 2 memory areas, and then click the OK button. 

F5: Move 
Down Area 
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The node will be added. 

 

Added.  

Deleting Nodes Added to the Data Links 

Select the node to be deleted from the Node Editing window. 

Delete the node by clicking the F8: Delete Node button in the Function Bar. 

Caution: If the node is deleted by clicking the  button in the Toolbar, the deletion will be executed immediately. 

Setting to Not Receive Data 

Set the receive size to 0 in the Node Editing window. 

 

Setting to Not Send Data 

Set the send size to 0 in the Node Editing window. 
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Procedure Using Setup Example 
Set Area 1 for each node, based on the data link setup example in the example system configuration. 

Note: The receive size and reception offset can only be set for Controller Link, and not for 
SYSMAC LINK. 

Setting Node Address 01 

1 Select node address 01 from the node address list on the left. Node 01 will be highlighted. 

 Select node address 01 as the object to be edited. 

The data link data for the selected node 
address is displayed here. 

 
The data link table for node address 01, the node to be edited, is displayed as a list in the Node Editing window on 
the right. 

 

Receive area from  
remote nodes Indicates the node refresh 

sequence. (In this example, 
for node address 01, no 
change is required.) 

Sends 30 words from the local node (node address 
01), starting with CIO 01000 (i.e., CIO 01000 to CIO 
01029). 

Receives 30 words from node 02, starting with 
CIO 01230 (i.e., CIO 01230 to CIO 01259) into 
the local node area starting with CIO 01030 
(i.e., CIO 01030 to CIO 01059). 

Receives 40 words from node 03, starting with 
CIO 00350 (i.e., CIO 00350 to CIO 00389) into 
the local node area starting with CIO 01060 
(i.e., CIO 01060 to CIO 01099). 

Local node send area 

 

Reference: With node address 01, the node refresh sequence matches the default (order of 
addresses), so no change is required. 
With node address 01, the size and offset are both automatically displayed as the 
defaults, so no changes are required. 

 The size and offset can be set.

Automatically displayed.  
2. With node address 01, the node refresh sequence matches the default (order of addresses), so no change is 

required. 
With node address 01, the size and offset are both automatically displayed as the defaults, so no changes are 
required. 
Settings for area 2 are made using the same method.  
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Setting Node Address 02 

Node address 02 is set in the same way as node address 01. 

 

 

Local node send area

Receive area from remote nodes

 

Setting Node Address 03 (Setting an Offset)  

For node address 03, the procedure for setting the node refresh sequence and the offset is as follows:  

1 Select node address 03 from the node address list on the left. 
2 With node address 03, the node refresh sequence does not match the default, so the order of addresses must be 

changed. Change the node refresh sequence by either clicking F4: Move Up Area or F5: Move Down Area in 
the Function Bar, or pressing the F4 or F5 function keys. 

  

F5: Move Down Area

 
3 Double-click on the Offset cell, and input the data size to be offset. In this example, set the offset size to 10 

words. 

 
With this setting, 20 words sent from node 01 will be received, starting from CIO 1000, and with an offset of 10 
words (i.e., CIO 1010 to CIO 1030). 
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Checking Data Link Tables 
1 Select Table | Validate Table in the Data Link Editor (Controller Link or SYSMAC LINK). The results of the 

check will be displayed as shown in the following illustration.  

 
 

Printing Data Link Tables 
Follow the procedure below to print data link tables that have been generated. 

1 Select File | Print in the Data Link Editor (Controller Link or SYSMAC LINK). 

Printing Example:  
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Saving Data Link Tables 
Follow the procedure below to save data link tables that have been generated. Data link tables are saved with a .cl3 
file name extension as the default. It is also possible to save them in .csv format. 

1 Select File | Save As in the Data Link Editor (Controller Link or SYSMAC LINK). The Save As dialog box will 
be displayed. 

2 Input the file name (“Sample” in this example), and specify the location where the file is to be saved. Then click 
the Save button. The data will be saved to a file with a .cl3 extension added to the file name (i.e., “Sample.cl3” 
in this case). 

Creating, Reading, and Writing CSV Files (Saving)  

Creating CSV Files 
Based on the CSV-format template file (Sample1.csv) provided with this software, it is possible to create files in 
CSV format for data link tables created manually using spreadsheet software (such as MS Excel).  

Including the Sample1.csv file, there are three types of files provided as reference material. The other two, in 
addition to Sample1.csv, are Sample1.xls (which describes tags and data), and Sample1.cl2 (data link table file 
format). 

(Sample1.xls window)  

 

Reading CSV Files 
Files in CSV format can be read to data link tables. 

1 Select Controller Link or SYSMAC LINK in the main CX-Net window (Data Link | Setup in the CX-Net 
PLC Network Configuration Tool dialog box). The Datalink Component dialog box will be displayed. 

2 Select Open from the File menu, and then select *.csv from the File of Type field. 
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Writing CSV Files (Saving)  
Once data link tables have been created, they can be written to CSV-format files. 

1 Select Save As from the File menu in the Datalink Component dialog box, and then select *.csv from the File of 
Type field. 

The following illustration provides an example of a written CSV file. 

 
(1)  Network ID  

parameters 

(2) Participating 
 node parameters 

(3) Area 1 
parameters 

(4) Area 2 
 parameters 

 

Note: When displayed by spreadsheet software (such as MS Excel). 
Types of Data Written to CSV Files 

 Tag name  Description Set value 

<network-type> 
The network type (CLK/SLK). CLK network: CLK 

SLK network: SLK 

<cycletime> 

The communications cycle 
time. 

5 to 255. Enabled only when 
<network –type> is set to SLK, and 
ignored when <network-type> is set 
to CLK. An error will be generated if 
an out-of-range value is set when a 
file is loaded.  

<author> 
The name of the author 

SLK: (Table information) author 

Set any text string (with up to 30 
characters). Enabled only when 
<network –type> is set to SLK. 

<information> 

(Title or node 
information)  

Input file information. 

CLK: Node information 

SLK: (Table information) title 

Set any text string (with up to 30 
characters). 

(1) <net- 
param> 

<comment> 

Comment. 

SLK: (Table information) 
comment 

Set any text string (with up to 255 
characters). Enabled only when 
<network –type> is set to SLK, and 
ignored when <network-type> is set 
to CLK. 
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 Tag name Description Set value 
<node> 

(Node No.)  

The node No. 
for the link. 

1 to 62. An error will be generated if an out-of-range 
value is set when a file is loaded. 

<cpu> 

(PLC type)  

The PLC type 
for the node. 

CS1G, CS1G-H, CS1H, CS1H-H, CJ1G, CJ1G-H, 
CJ1H-H, CJ1M, CS1D-H, CS1D-S, CV500, CV1000, 
CV2000, CVM1, CVM1-V2, CQM1H, C200HE, 
C200HE-Z, C200HG, C200HG-Z, C200HX, C200HX-Z, 
NSB, CS/CJ/CP 

<cpu-type> 

(CPU model)  

The CPU model 
for the node. 

CS1G: CPU42, CPU43, CPU44, CPU45 

CS1G-H: CPU42, CPU43, CPU44, CPU45 

CS1H: CPU63, CPU64, CPU65, CPU66, CPU67 

CS1H-H: CPU63, CPU64, CPU65, CPU66, CPU67 

CS1G/CJ1G: CPU44, CPU45 

CJ1G-H: CPU42, CPU43, CPU44, CPU45 

CJ1H-H: CPU65, CPU66, CPU67 

CJ1M, CP1H: Not specified. 

CS1D-H: CPU65, CPU67 

CS1D-S: CPU42, CPU44, CPU65, CPU67 

CV500: Not specified. 

CV1000: Not specified. 

CV2000: Not specified. 

CVM1: CPU01, CPU11, CPU21 

CVM1-V2: Not specified. 

CQM1H: CPU51, CPU61 

C200HE: Not specified. 

C200HE-Z: Not specified. 

C200HG: Not specified. 

C200HG-Z: Not specified. 

C200HX: Not specified. 

C200HX-Z: Not specified. 

C200HX-Z: CPU65, CPU85 

NSB: Not specified. 

<status-start-type> 

(Status start address, 
memory area)  

The status start 
address and the 
memory area. 

Any of the following memory areas can be specified, 
regardless of the PLC type. 

Initial value: Default (See note.)  

CIO: Blank, CIO, or IR 

DM: D or DM 

LR: L or LR 

EM: E + Bank No. 

HR: H or HR 

AR: A or AR 

T/C: T/C 

Note: Data link status is stored in the default area. For 
details, refer to the Unit's operation manual. 

(2) <node-param> 

<status-start-ch> 

(Status area start 
address)  

The start 
address for the 
status area. 

The range differs depending on the status area type. 
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 Tag name Description Set value 
<start-type> 

(Link Area 1 type)  

Specify the area type for Link Area 1. Same as for status area type. 

<start-ch> 

(Link Area 1 start 
address)  

The beginning word for Link Area 1. Same as for status area start 
address. 

Node No. 
Node 
address 

The node address for linking 
at Link Area 1. 

1 to 62 

Link start 
address 

Link word The beginning link word for 
Link Area 1. 

Set the link start address + link 
size for the above link node. 

Link size 
Size 
(Unit: 
words)  

The link size for Link Area 1. Set any value. 

(3) <area1> 

<link-
area> 

Offset size 
Offset The offset size for Link Area 

1. 

 

Set any value. If no offset is 
required, set 0. 

<start-type> 

(Link Area 2 type)  

The area type for Link Area 2. Same as for status area type. 

<start-ch> 

(Link Area 2 start 
address)  

The beginning word for Link Area 2. Same as for status area start 
address. 

Node No. Node 
address 

The node address for 
linking at Link Area 2. 

1 to 62 

Link start 
address 

Link word The beginning link word for 
Link Area 2. 

Set the link start address + link 
size for the above link node. 

Link size 
Size (Unit: 
words)  

The link size for Link Area 2. Set any value. 

(4) <area2> 

<link-
area> 

Offset size 
Offset The offset size for Link Area 

2. 

 

Set any value. If no offset is 
required, set 0. 
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An example text data configuration for a CSV file is shown below. 

  

Note: Commas are used for delineation. (They are added when there are blank cells.)  
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Connecting Online 
After the PLC has been registered, select either of the following types of registered PLCs for connecting online, 
depending on the CX-Net function used. 

1) PLCs registered for direct connection 

2) PLCs registered as nodes on a network 

PLC registered for online connection 

CX-Net function (1) PLC registered for direct 
connection (node 
address 0)  

(2) PLC registered as node on a 
network (node address 01 or 
higher)  

Controller Link Not supported. (See note.) Supported 

SYSMAC LINK Not supported. (See note.) Supported 

Data link table 
transfer 

SYSMAC NET Supported Not supported. 

Note: If there is a routing table, node address 0 is possible. 

 
When transferring Controller Link or SYSMAC LINK data link tables, therefore, online connection is required for 
PLCs registered as nodes on a network. 

Example: Connecting PLC1 (Registered as a Node on a Network) Online 

1 In the CX-Net project workspace, select the PLC to be connected online. 
2 In the project workspace, select PLC1, and then select Open from the PLC menu. 

PLC1 will be connected online, and the display will change as follows:  

Changes to green when online. 

The online/offline status and the 
PLC’s operation mode are displayed.

Select PLC1, and 
then select Open 
from the PLC 
menu.

 

 
To go back offline, again select Open from the PLC menu. 
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Reading and Transferring Data Link Tables 
After a data link table has been created, follow the procedure below for reading it and transferring it to all nodes 
participating in the data links. 

Reading the Data Link Table 
1 Select Data Link | Setup from the CX-Net.  

The Data Link Setup dialog box will be displayed. (For local network only, i.e., when network address is 0.)  

 
Clicking on this down arrow will 
display the Communications 
Units mounted to the PLC, as 
shown below. 

  
2 Select Controller Link or SYSMAC LINK, and then click the OK button. 

Either the Datalink Component (Controller Link) or Datalink Component (SYSMAC LINK) window will be 
displayed. 

 
3 Select File | Open. 

The Open dialog box will be displayed. 
4 Select the data link table file (Sample.cl3 in this example,) and then click the Open button. 
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The data link tables will be read as shown below. 

 
 

Note: Before selecting Data Link Setup, make sure that the PLC can be connected online. 

Transferring the Data Link Table 
Transferring to All Nodes on the Network 

1 Select Set All Nodes for Network Operation from the Datalink Component’s Online menu. Selecting this 
operation allows the data link tables to be transferred simultaneously to multiple PLCs. 

2 Select Online | Transfer to PLC. The following dialog box will be displayed.  

 
3 Click the Yes button. 
4 An error list will be displayed. 
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5 The data link tables will be transferred. 
6 The transfer results will be displayed. 

 
 

Note: As long as all the data link tables can be transferred to all of the PLCs attempted, Set All 
Nodes for Network Operation can be selected to transfer the data link tables 
simultaneously to multiple PLCs. If there are any PLCs with the power turned OFF, or 
with disconnected cables, use the following method to transfer the data link table to one 
PLC at a time. 

 
Note: •  CX-Programmer (CX-Net) Ver. 3.2 or later is required to use the 

Controller Link Support Board as a Network Support Board (NSB).  
•  When using a SYSMAC Link Support Board or CX-Programmer 

(CX-Net) Ver. 3.1 or earlier, data link tables can be transferred only to 
a single Network Support Board (NSB) node. Always use the following 
method to transfer data link tables to all the nodes on the network. 

1. Use the mouse to select any node other than the Network Support 
Board in the Data Link Configuration window or the Node 
Editing window of the Datalink Component window. 

2. Select Set All Nodes for Network Operation from the Online 
menu in the Data Component window. 

3. Select Transfer to PLC from the Online menu. 
4. The data link tables are transferred after the check is completed. 

 

Transferring to Individual Nodes on the Network 

1 Select the transfer destination node address from the Node list in the Datalink Component. 

 

 
Make sure that Set All Nodes for Network Operation is not selected in the Online menu.  

2 Select Online | Transfer to PLC. The following dialog box will be displayed. 
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3 Click the Yes button. 
4 An error list will be displayed. 
5 The data link tables will be transferred. 
6 The transfer results will be displayed. 

Starting and Stopping Data Links (Including Status Displays)  
Before performing the operations described below, connect online to a node where the data link table has been 
transferred. As long as the data link table is stored there, data link starting and stopping can be executed from any 
node. 

Note: When starting data links with manual setup, the data link mode for the startup node must 
be set to manual. 

Starting Data Links 
1 Select Data Link | Setup from the CX-Net. 

The Data Link Setup dialog box will be displayed. (For local network only, i.e., when network address is 0.)  

 
Clicking on this down arrow will 
display the Communications 
Units mounted to the PLC, as 
shown below. 

  
2 Select Controller Link or SYSMAC LINK, and then click the OK button. 

Either the Datalink Component (Controller Link) or Datalink Component (SYSMAC LINK) 
window will be displayed. 
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3 Select Datalink Operation/Status from the Online menu. 
The Datalink Status dialog box will be displayed. As shown below, the status of various items is displayed. The 
communications cycle time and refresh cycle time are updated only when this window is opened or when the 
PLC operating status is changed. 

 
Select either the Run or 
Stop option and then 
click the Set button. 

 
4 Select the Run option in the Operation field. 
5 Click the Set button. 

The data links will start, and the Operational Status box will be displayed. 

 

Note: • The data link mode (manual/automatic) and data link operation are determined by the 
data link setup at the startup node. With manual setting the links, it is necessary to set, 
for the startup node, the data link table and the data link mode (manual setting) in the 
DM parameter area. If these are not set correctly, the data links will not start. 

• Check the following points before starting the data links. 
With manual setting, the appropriate data link table must be set for each node executing 
the data links. Data link tables must be deleted for nodes that are not participating in the 
data links. Also, even when the correct data link tables are set, make sure that there will 
be no effect on the equipment before starting or stopping the data links. 

 

Stopping Data Links 
1 Click the Stop option in the Operation field of the Datalink Status dialog box. 
2 Click the Set button. 

The data links will be stopped. 
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Automatically Set Data Links 
This section explains how to make the settings for automatically set data links. 

Make the settings in the Automatic Datalink (Controller Link) or Automatic Datalink (SYSMAC LINK) dialog 
box. 

First make the settings for data link operation at PLC startup, and for the automatic data link setup parameters, and 
then transfer the data to the startup node. 

When using automatically set data links, there is no need to create data link tables with the Data Link Editor. 

Procedure Through Data Link Startup 

Start the data links. 
Datalink Component Data Link Status 
operation 
1) Online | Status 
2) Select the Run option in the Operation 

field, and then click the Set button. 

Turn ON the power to the PLC. 

Create a CX-Server file (*.CDM) for connecting online. 
1) Select New from the Project menu and save the setting under a file name. 
2) Select Add Device from the Project menu, and register the PLC (as a node on the 

network). 

Connect online to the startup node PLC (registered as a node on the network). 
(Select the startup node PLC and then select PLC | Open from the CX-Net.) 

Set the automatic data link setup parameters. 
1) Select Data Link | Setup. 
2) Select Controller Link Unit or SYSMAC LINK Unit as the Communications Unit 

mounted to the PLC. (For the local network only, i.e. when the network address is 0.)  
3) Select PLC | Setup in the Datalink Component window.  
4) Select Automatic in the Generation Type field in the Automatic Datalink dialog box, 

and make the settings for the automatically set data link areas (start word, size, and 
nodes participating in data links, for Area 1 and Area 2). 

4) To have the data links started when 
the PLC is started, set Start for the 
status at startup. 

Transfer the automatic data link setup parameters to the startup node. (Click the 
Write button.) 
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Controller Link Automatic Setup 
1 Before executing the following operations, connect online to the PLC that is serving as the startup node. 
2 Select Data Link | Setup from the CX-Net. (For local network only, i.e., when network address is 0.)  

 

 
Clicking on this down arrow will 
display the Communications 
Units mounted to the PLC, as 
shown below. 

  
3 Select Controller Link, and then click the OK button. 

The Datalink Component (Controller Link) window will be displayed. 

  
4 Select Automatic Datalink Setup from the Online menu. 

The Automatic Datalink (Controller Link) dialog box will be displayed. 
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♦  Controller Link 

Select Start in 
order to have data 
links start when the 
PLC is started. 

Select Automatic. 
(If Manual is 
selected, data link 
tables created by 
the user will be 
used.) 

If Automatic is 
selected, data link 
parameters can be 
set. 

When Read or 
Write is executed, 
the results are 
displayed here. 

Reads settings 
data from the PLC.

Transfers settings 
data to the PLC. 

 
5 Select Start or Stop in the Power Up Run State field. 

Note: Selecting Start causes the data links to start when the PLC is powered up, without having 
to perform any other data link startup operation. 
When Automatic is selected, the automatic data link setup parameters can be set, as 
shown below. 

 

♦  Controller Link 

Set the status start 
word. 

Set the nodes 
participating in the 
data links. 

Make the settings for Area
2. Set the area for
executing the data links,
the start word, and the
size. 

Make the settings for Area 
1. Set the area for 
executing the data links, 
the start word, and the 
size. 

 
7 Set the automatic data link setup parameters. 
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SYSMAC LINK Automatic Setup 
1 Before executing the following operations, connect online to the PLC that is serving as the startup node. 
2 Select Data Link | Setup from the CX-Net. (For local network only, i.e., when network address is 0.)  

 

 
Clicking on this down arrow will 
display the Communications 
Units mounted to the PLC, as 
shown below. 

 
3 Select SYSMAC LINK, and then click the OK button. 

The Datalink Component (SYSMAC LINK) window will be displayed. 

  
4 Select Automatic Datalink Setup from the Online menu. 

The Automatic Datalink (SYSMAC LINK) dialog box will be displayed.
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Reads settings data 
from the PLC. 

Transfers settings 
data to the PLC. 

Select for manual 
setup. 

For automatic 
setup, select CIO 
only, DM only, or 
CIO and DM. 

For automatic setup, 
select from among the 
following areas and 
words. 
•  CIO 04CH, DM 08CH 
•  CIO 08CH, DM 16CH 
•  CIO 16CH, DM 32CH 
•  CIO 32CH, DM 64CH 
  

5 Select the memory area for automatic setup (CIO Area only, DM Area only, or CIO and DM Areas), and select 
the area and word settings from the following list. 

 

Word Allocations for SYSMAC LINK Automatic Setup (Example: CS/CJ Series, CVM1/CV Series)  
Area and word settings 

CIO Area (words) DM Area (words) 
CIO: 4 
words 

DM: 8 
words 

CIO: 8 words 

DM: 16 
words 

CIO: 16 
words 

DM: 32 
words 

CIO: 32 
words 

DM: 64 
words 

CIO 1000 to CIO 1003 D00000 to D00007 #1 

CIO 1004 to CIO 1007 D00008 to D00015 #2 
#1 

CIO 1008 to CIO 1011 D00016 to D00023 #3 

CIO 1012 to CIO 1015 D00024 to D00031 #4 
#2 

31 

CIO 1016 to CIO 1019 D00032 to D00039 #5 

CIO 1020 to CIO 1023 D00040 to D00047 #6 
#3 

CIO 1024 to CIO 1027 D00048 to D00055 #7 

CIO 1028 to CIO 1031 D00056 to D00063 #8 
#4 

#2 

#1 

CIO 1032 to CIO 1035 D00064 to D00071 #9 

CIO 1036 to CIO 1039 D00072 to D00079 #10 
#5 

CIO 1040 to CIO 1043 D00080 to D00087 #11 

CIO 1044 to CIO 1047 D00088 to D00095 #12 
#6 

#3 

CIO 1048 to CIO 1051 D00096 to D00103 #13 

CIO 1052 to CIO 1055 D00104 to D00111 #14 
#7 

CIO 1056 to CIO 1059 D00112 to D00119 #15 

CIO 1060 to CIO 1063 D00120 to D00127 #16 
#8 

#4 

#2 

 

Reference 
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Transferring Automatic Data Link Setup Parameters to the Startup Node 
The automatic data link parameters that have been set are then sent to the connected startup node PLC. It is also 
possible to read the automatic data link parameters that have been set for the PLC.  

Transferring Data to the Startup Node PLC 
1 Click the Write button in either the Automatic Datalink (Controller Link) or the Automatic Datalink Setup 

dialog box. 
The following dialog box will be displayed for confirmation. 

  
2 Click the Yes button. 

The set data will be transferred to the startup node PLC. 
Note: •  The data link mode (manual/automatic) and data link operation are determined by the 

data link setup at the startup node. With automatic setup, it is necessary to set, for the 
startup node, the data link mode (automatic) and the number of data link words in the 
Automatic Datalink Setup dialog box. If these are not set correctly, the data links will 
not start. 

•  Before starting the data links with automatic setup, make sure that the correct automatic 
data link setup parameters are set for the data link startup node. If incorrect automatic 
data link setup parameters are set, it may cause the equipment to operate unpredictably. 
Even when the correct parameters are set, make sure that there will be no adverse effect 
on the equipment before starting or stopping the data links. 

Reading Data from the Startup Node 
Perform this operation to check or change settings. 

1 Click the Read button in either the Automatic Datalink (Controller Link) or the Automatic Datalink Setup 
dialog box. 
The following dialog box will be displayed for confirmation. 

  
2 Click the Yes button. 

The set data will be transferred from the PLC and displayed at the Automatic Datalink (Controller Link) or the 
Automatic Datalink Setup dialog box. 
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Monitoring Data Link Status 

Monitoring Data Link Status, Such as Communications Cycle Time 
1 Select the startup node PLC in the Project workspace. 
2 Select Open from the PLC menu to connect online. 
3 Select Data Link | Setup. 
4 Select Controller Link or SYSMAC LINK, and then click the OK button. The Datalink Component dialog 

box will be displayed. 
5 Select Online and then Datalink Operation/Status. The Data Link Status dialog box will be displayed. 
6 The following items will be displayed in the Network Properties field:  

Data link start word, polling node number, communications cycle time, and data link refresh cycle time 
PV/maximum value. 
The following items will be displayed in the Operational Status field for each node:  
CPU Unit error status, data link operation status, CPU unit operation mode, and communications status 

Monitoring Data Link Status and Network Error Status from CX-Net 
1 While online, open the I/O table window and select either Controller Link or SYSMAC LINK. Right-click 

and select the software switch. 
2 The following items can be monitored for a particular Controller Link Unit. 

Tag name Contents 
General Displays the words allocated in the CIO and DM Areas. 

Error Information Network parameter errors, data link table errors, routing table errors, 
PLC setup errors, EEPROM write errors, node address duplication 
errors, network parameter verification errors, communications 
controller transmission errors, communications controller errors, and 
error log 

Data Link Startup node address, polling node address, and local node data link 
participation status 

Data link status as seen from each node (PLC operation status, PLC 
errors, communications errors, data link participation status, offset 
errors, and reception area insufficient or surplus space)  

 

Network Status Network participation status for each node 

Status Termination resistance status, power ON status 
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The following items can be monitored for a particular SYSMAC LINK Unit. 

Tag name Contents 
General Displays the words allocated in the CIO and DM Areas. 

Error Information Data link errors, node setting errors, routing table errors, 
communications controller errors, communications setting errors, data 
verification errors, duplicate No. errors, parameter errors, error logs, 
and EPROM write errors 

Network Status Local node address, local network address, polling node local address, 
unit number, power supply, internode test, and network node address 

Data Link Data link status (PLC operation status, PLC errors, communications 
errors, data link participation status, offset errors, and reception area 
insufficient space or surplus space)  

Internode Test 
(Parameters) (See 
note.)  

Test beginning and end, test destination node address, test destination 
network address, number of bytes sent, and response monitor timer 
values 

Internode Test 
(Results) (See note.)  

Test destination address, test destination network address, number of 
bytes sent, response monitor timer values, number of resend errors, 
number of non-responses, number of frame overruns, number of tests, 
number of errors, number of token timeouts, number of relay node 
routing failures, number of local node routing failures, routing error 
MRES, routing error node address, number of times local node failed to 
participate, number of times data did not match, number of times test 
destination node busy, routing error SRES, routing error network 
address, and test status 

Note: Supported for CVM1 and CV-series SYSMAC LINK Units only. 
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 CHAPTER 11 
Routing Tables 

Routing tables allow networked PLCs to be configured so that they can communicate with each other via gateways; 
across remote networks. The routing tables contain the network, unit number information required. It is only 
necessary to set up routing tables if the end connection PLC is not a direct connection, i.e. using another PLC as a 
gateway connection. The routing table is held within the PLC(s) which acts as the gateway device. Different types 
of PLC and networks have different capabilities for routing. 

PLC Network Routing Table 

C-series SYSMAC LINK N/A 
C-series SYSMAC NET C-SYSMAC NET 
C-series Controller Link FINS 
C-series Ethernet N/A 

CV-series SYSMAC LINK, SYSMAC NET, 
Ethernet or Controller Link 

FINS 

CS1-series SYSMAC LINK, Device Net, 
Controller Link or Ethernet 

FINS 

CJ1-series SYSMAC LINK, Device Net, 
Controller Link or Ethernet 

FINS 

 
The Routing Table menus are accessed from the PLC Network Configuration Tool dialog and contain options 
allowing the editing and setup of routing tables both offline and online. The routing tables which are being used in 
a network, can be viewed online. 

Different online Routing Table Setup dialogs are used, depending upon the protocol associated with the routing 
table. The way in which they are displayed and operate is similar in each case. 

The PLC Network Configuration Tool dialog, visually displays the structure of the routing table associated with the 
PLC (including the destination node and network gateway employed in directing data across the network). Initially 
the visual representation of the routing table is empty, or set to zero, until a routing table file has been opened. An 
overview of the routing table can also be viewed and edited in a graphical or tabular format. 

Opening an existing Routing Table 
Use the following procedure to open an existing routing table in a project. 

1, 2, 3… 1. Open the PLC Network Configuration Tool dialog from the Routing Table menu, 
select Editor, and then the type of table. 

 2. From the Routing Table File menu select Open Routing Table File. 

 3. From the list of possible files, select the file to be opened. 

The following procedure can also be used as a shortcut to opening an existing routing table. 

1, 2, 3… 1. Open the PLC Network Configuration Tool dialog and from the Project menu 
options select Open. 

 2. In the Open Project dialog select the File Type as All Files(*.*) 

 3. In the Open Project dialog select the appropriate device type and click the Open 
button. 

 4. From the list in the Project Devices window select the network to be opened. 

 5. From the Routing Table menu, select Editor and then the required network type. 

Note: Routing tables have an ‘.RT2’ (SYSMAC NET), ‘.RTG’ for FinsLocal or ‘.RT3’ 
(FINS) Network filename extension. 

Creating a new Routing Table 
Use the following procedure to create a new routing table within a project. 

1, 2, 3… 1. Open the PLC Network Configuration Tool dialog from the Project menu options 
and select New. 
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 2. In the Create Project dialog enter a file name for the new table, navigate to the 
folder where the file is to be saved and click the Save button. 

 3. From the PLC Network Configuration Tool Project menu select Add Device. 

 4. In the Add PLC dialog Enter a Device Name and select a Device Type and 
Network Type from the dropdown menu. And click OK. 

 5. From the PLC Network Configuration Tool click on the device name in the 
Project Device window. 

 6. From the Routing Table menu, select Editor and then the required network type. 

Adding a Local Network 
Use the following procedure to add a local network to a routing table. 

1, 2, 3… 1. Open the PLC Routing Table window and select the SIOU tab in the left hand 
pane and the Main View tab in the right hand pane. 

 

 
 

 2. Select the Unit from the SIOU list to which the local network is to be added then 
right click on the that unit and select the Insert CPU SIOU option. 

 3. From the Enter SIOU Details dialog enter the: 

 Local Network Number. This is the ID number that uniquely identifies the local 
network in the routing table. Each new network must be given a unique ID 
number in the range of 1 to 127. 
Local Network Type. Select the type of local network from the drop down 
menu. The network type selected will be displayed in the diagram. 

 4. Click OK to close the SIOU dialog and add the local network to the selected unit. 

Note: The serial port of the CPU Unit and the serial port of the Serial Communications Board/Unit 
(unit version 1.2 or later) are displayed in the Unit directory in the SIOU Tab on the left. 
Right-click and select Insert CPU SIOU to set the local network address in the serial port and 
register in the local network table.  
The serial port’s unit number as a CPU Bus Unit or Special I/O Unit are automatically allocated 
and cannot be changed. 
The Unit and the Unit’s serial port cannot be registered in the local network table at the same 
time. 
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Adding a Remote Network 
Use the following procedure to add a remote connection to a local network. 

1, 2, 3… 1. Open the PLC Routing Table dialog and select the SIOU tab in the left hand pane 
and the Main View tab in the right hand pane. 

 2. With the cursor positioned over the local network click the right mouse button. 

 

 

 3. From the pop up menu select the Add connection to Remote Network option. 
(selecting the Change Local Network option enables the local network number to 
be changed). 

 4. In the Enter Relay Node Details dialog enter the: 
 Relay node number. This is the ID number of the relay node. Relay Nodes can 

be given any ID number in the range 1 to 254. 
Remote Network number. This is the ID number that will uniquely identify the 
remote connection. Each new remote connection must be given a unique ID 
number in the range 1 to 127. 
Note that a remote network can not be given the same ID number as an existing 
Local Network. 

 5. Click OK. This will add the remote connection with the specified ID number 
(shown in red) to the Local Network. A maximum of 20 remote connections can 
be added to a network. 

 6. Finally from the Options menu check the table for Errors  
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Editing the Routing Table 
Open the appropriate routing table from the Network Configuration Tool dialog then use the following procedure 
to edit the table. 

1, 2, 3… 1. Local Network:  
 ♦  In the Routing Table dialog right click on the Unit to be edited and select the 

appropriate option from the pop up menu. 

♦  To save the changes select the Save option from the File menu 
 2. Relay Node: 
 ♦  Right click on the Relay node and select the appropriate option from the pop up 

menu. 
 3. Remote Network: 
 ♦  Right click on the remote network and select the appropriate option from the pop up 

menu. 

Error Checking 
Use the following procedure to view any validation errors. 

1, 2, 3… 1. Either: 
 ♦  Select Check routing table for errors from the Edit menu in the Routing Table 

Editor dialog box. 
 Or 
 ♦  Click the � in the toolbar. A message box will be displayed indicating success or 

failure. 

Additional Features 

The Network View Screen 
The Network tree view is used to display the nodes on the locally connected network and is only available when the 
local connection network is an OMRON proprietary network, such as a Controller Link, Sysmac link, Sysmac Net 
or SYSWAY. 
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 This icon is used to indicate that a node is present at this node number. 

 This icon is used to indicate that node is not present at this node number. 

 This icon is used to represent the currently selected node. 

 This icon is used to indicate that a node is present at this node number but there are 
errors reading the routing table. 

The Overview Screen 
Selecting the Overview tab will show all the routing tables in an graphical format. The relay node numbers are 
shown in the whites boxes and the remote network numbers in the red boxes. The numbers on the right are the Local 
Network numbers. 

Note that the tables can not be edited in this view. 

 

 

Table View Screen 
The Table View screen provides a method of setting the routing table by means of a tabular view. 
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The screen is comprised of two main sections: 

♦  The local settings (Left hand side) 
♦  The remote settings (right hand side) 
The local settings section allows a series of entries for the SIOU (Special Input/Output Unit) and it’s corresponding 
Local Network number. 

The remote settings section allows a series of entries for the Remote Network number, it’s corresponding Relay 
Network number and it’s corresponding Relay Node number. 

The slider control to the right of each section can be used to bring any more than the eight entries into view if so 
required. 

Each of the data entry fields have their own individual set of spin buttons, which when pressed will increment or 
decrement the value. The number can also be entered normally using the number keypad on the user keyboard. 

Three control buttons can be found at the bottom of the screen: 

♦  Ok button: Once all data entry has been completed, selecting the ‘Ok’ button will check the table entries for 
errors. If the check fails, an error description dialog will be displayed. If the check does not detect any errors 
the Main Screen will be displayed. 

♦  Restore button: If during data entry, the user wished to revert back to the table state that was in effect before 
the Table View was displayed; The user should select the Restore button. 

♦  Cancel button: This button will cancel any changes made whilst the Table View was being displayed and then 
display the Main View screen.  

Note:  For CS/CJ-series PLC of Ver. 2.0 or CP-series PLC or later with CX-Programmer Ver. 
4.0 or later, FINS commands can be used to access nodes up to eight network levels 
away, including the local network.  

Gateway Counter Settings 
Gateway Counter Framework 

When sending FINS commands or returning FINS responses in a FINS network, the GCT (Gateway 
counter: Permissible number of times a network bridge can be crossed) is set in the FINS header of the 
FINS command frame. When the FINS response is received, the GCT is automatically reduced by the 
number of network levels that were accessed. Therefore, the GCT setting corresponds to the number of 
network levels that can be accessed, as follows:  
•  GCT = 02 hex: Access to up to three network levels away. 
•  GCT = 07 hex: Access to up to eight network levels away (the network configuration, however, must 

use PLCs for which the Gateway counter (GCT) is set to 07 hex). 

Gateway Counter Setting 
When using CX-Programmer Ver.5.0 or later, the GCT (Gateway counter) value contained in the 
FINS header can be set under Set Gateway Counter in the Routing Table Dialog Box. 
Note: CX-Programmer Ver.4.0 or earlier do not provide the GCT (Gateway counter) setting option. 
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Setting the Gateway Counter Value for Each PLC 
The GCT value setting range depends on the CPU Unit being used, as follows:  

•  CS/CJ-series CPU Unit Ver. 3.0 or CP-series CPU Unit 
The GCT (Gateway counter) value can be set to 02 hex or 07 hex. 
Set the GCT value under Set Gateway Counter during routing table setup using the following 
procedure.  

1. Setting the Gateway Counter Offline: 

Open the PLC Routing Table window, select the Unit Tab in the directory list, and then right-click 
the icon for the local PLC node. 

 

 
Setting the Gateway Count Online: 

Open the PLC Routing Table window, select the Network Tab in the directory list, and then 
right-click the icon for a PLC node in the network.  

 

 
The following Gateway Counter Setting Dialog Box will be displayed. 

2. Select either Standard or Expand(7), and then click the OK Button. 
 

 

Standard: Communications across up to three network levels (GCT = 02 hex) 

Expand(7): Communications across up to eight network levels (GCT = 07 hex) 
The GCT value will be displayed in the Main View, Overview, and Table View Screens. 

Main View Overview Table View 

 

 

  

 
•  CS/CJ-series CPU Units with Unit Ver. 2.0 or CP-series CPU Units 

The GCT (Gateway counter) is always 07 hex. The number of network levels that can be accessed is 
always a maximum of eight network levels and cannot be set to a maximum of three network levels.  
When CX-Programmer (CX-Net) Ver.5.0 or later is used, the Standard and Expand(7) options in the 

Gateway Counter Setting Dialog Box in the Routing Table Setup are both ignored. When routing 
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tables are transferred to a CS/CJ-series CPU Unit with unit Ver. 2.0 or CP-series CPU Unit, the 
GCT (Gateway counter) is always 07 hex, and therefore uses the Expand mode. 

•  Pre-Ver. 2.0 CS/CJ-series CPU Units and CVM1/CV-series CPU Units  
The GCT (Gateway counter) is always 02 hex. Therefore, access to a maximum of three network levels 

away is possible.  
When CX-Programmer (CX-Net) Ver.5.0 or later is used, always select the Standard option in the 
Gateway Counter Setting Dialog Box during the routing table setup. If Expand(7) is selected, the 
routing tables cannot be transferred. 

 

Transferring a Routing Table to a PLC 
Once a routing table has been created or edited, the routing table may be transferred to the PLC using the following 
steps: 

1, 2, 3… 1. If the Network Configuration Tool is ‘on-line’ to a PLC, skip to 4. 
 2. Save the current routing table using the Routing Table Edit menu: File – Save 

Routing Table. (Add Author and comment if required). 
 3. Go ‘on-line’ to the PLC. See section 10 – The Network Configuration Tool for 

details of this operation. 
 4. From the CX-Net menu select: Routing Table - Setup 
 5. From the Routing Table menu select: File – Open Routing Table. 
 6. Select the previously created filename and select open. Or, alternatively the 

routing table can be created. 
 7. From the Routing Table Editor menu select: Options – Transfer to PLC. 

Transferring a Routing table from a PLC 
The routing table held within a PLC may be transferred from the PLC using the following steps: 

1, 2, 3… 1. Go ‘on-line’ to the PLC. See section 10 – The Network Configuration Tool for 
details of this operation. 

 2. From the CX-Net menu select: Routing Table - Setup 
 3. From the Routing Table Editor menu select: Options – Transfer from PLC. 
 4. The routing table may then be saved to file by: From the Routing Table menu 

select: File – Save Routing Table. 
 5. Enter a suitable filename and select Save.  
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 APPENDIX A 
Network Availability 

The following tables indicate the network available to each PLC device group. FinsGateway has no network 
availability and is not described 

Note: Modem connection is also available by Toolbus or SYSMAC WAY if a Modem device 
has been configured in Microsoft Windows. Any device supporting Toolbus or 
SYSMAC WAY also supports Modem connections. Refer to standard Microsoft 
Windows documentation for details on configuring a Modem device. 

Note: Where DeviceNet is indicated as an available network type for a given PLC, direct 
connection from a PC is not possible (No NSB support). Instead, connect via a Serial 
Port (COM1 etc.), or an another network type. 

C**H Device Group 
Device 
Type 

SYSMAC 
WAY 

Toolbus SYSMAC 
NET 

SYSMAC
LINK 

Controller
Link 

Ethernet Device 
Net 

C20H Yes - - - - - - 

C28H Yes - - - - - - 

C40H Yes - - - - - - 

C60H Yes - - - - - - 

C**K Device Group 
Device 
Type 

SYSMAC 
WAY 

Toolbus SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Device 
Net 

C20K Yes - - - - - - 

C28K Yes - - - - - - 

C40K Yes - - - - - - 

C60K Yes - - - - - - 

C**P Device Group 
Device 
Type 

SYSMAC 
WAY 

Toolbus SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Device 
Net 

C20P  Yes - - - - - - 

C28P Yes - - - - - - 

C40P Yes - - - - - - 

C60P Yes - - - - - - 
 

C1000H Device Group 
Device 
Type 

SYSMAC 
WAY 

Toolbus SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Device 
Net 

CPU01 Yes - Yes Yes - - - 
 

C20 Device Group 
Device 
Type 

SYSMAC 
WAY 

Toolbus SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Device 
Net 

C20 Yes - - - - - - 
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C2000H Device Group 
Device 
Type 

SYSMAC 
WAY 

Toolbus SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Device 
Net 

CPU01 Yes - Yes Yes - - - 

C2000 Yes - Yes - - - - 
 

C200H Device Group 
Device 
Type 

SYSMAC 
WAY 

Toolbus SYSMAC 
NET 

SYSMAC 
LINK 

Controller 
Link 

Ethernet Device 
Net 

CPU01 Yes - - - - - - 

CPU02 Yes - - - - - - 

CPU03 Yes - - - - - - 

CPU21 Yes - - - - - - 

CPU21 Yes - - - - - - 

CPU22 Yes - - - - - - 

CPU23 Yes - - - - - - 

CPU11 Yes - Yes Yes - - - 

CPU31 Yes - Yes Yes - - - 

C200HE Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU11 - Yes - - - - - 

CPU32 - Yes Yes Yes Yes Yes - 

CPU42 Yes Yes Yes Yes Yes Yes - 
 

C200HE-Z Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU11 Yes Yes - - - - - 

CPU32 Yes Yes Yes Yes Yes Yes - 

CPU42 Yes Yes Yes Yes Yes Yes - 
 

C200HG Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU33 Yes Yes Yes Yes Yes Yes - 

CPU43 Yes Yes Yes Yes Yes Yes - 

CPU53 Yes Yes Yes Yes Yes Yes - 

CPU63 Yes Yes Yes Yes Yes Yes - 
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C200HG-Z Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU33 Yes Yes Yes Yes Yes Yes - 

CPU43 Yes Yes Yes Yes Yes Yes - 

CPU53 Yes Yes Yes Yes Yes Yes - 

CPU63 Yes Yes Yes Yes Yes Yes - 
 

C200HS Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU01 Yes Yes - - - - - 

CPU03 Yes Yes - - - - - 

CPU11 Yes Yes Yes Yes - - - 

CPU13 Yes Yes Yes Yes - - - 
 

C200HX Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU34 - Yes Yes Yes Yes Yes - 

CPU44 Yes Yes Yes Yes Yes Yes - 

CPU54 - Yes Yes Yes Yes Yes - 

CPU64 Yes Yes Yes Yes Yes Yes - 
 

C200HX-Z Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU34 Yes Yes Yes Yes Yes Yes - 

CPU44 Yes Yes Yes Yes Yes Yes - 

CPU54 Yes Yes Yes Yes Yes Yes - 

CPU64 Yes Yes Yes Yes Yes Yes - 
 

C500 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

C500 Yes - Yes - - - - 

C250 Yes - - - - - - 

C120 Yes - - - - - - 

C50 Yes - - - - - - 
 

CJ1G Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU45 Yes Yes - - Yes Yes Yes 

CPU44 Yes Yes - - Yes Yes Yes 
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CJ1G-H Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU45 Yes Yes - - Yes Yes Yes 

CPU44 Yes Yes - - Yes Yes Yes 

CPU43 Yes Yes - - Yes Yes Yes 

CPU42 Yes Yes - - Yes Yes Yes 

CJ1H-H Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU66 Yes Yes - Yes Yes Yes Yes 

CPU65 Yes Yes - Yes Yes Yes Yes 

CJ1M Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU12 Yes Yes - - Yes Yes Yes 

CPU13 Yes Yes - - Yes Yes Yes 

CPU22 Yes Yes - - Yes Yes Yes 

CPU23 Yes Yes - - Yes Yes Yes 

NSJ Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

G5D Yes Yes - - Yes Yes Yes 

CPM1 (CPM1A/CPM2*) Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU10 Yes Yes - - - - - 

CPU20 Yes Yes - - - - - 

CPU30 Yes Yes - - - - - 

CPM2*-S* Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

N/A Yes Yes - - - - Yes 
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CQM1 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU11 Yes Yes - - - - - 

CPU21 Yes Yes - - - - - 

CPU41 Yes Yes - - - - - 

CPU42 Yes Yes - - - - - 

CPU43 Yes Yes - - - -  

CPU44 Yes Yes - - - -  
 

CQM1H Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU11 Yes Yes - - - - - 

CPU21 Yes Yes - - - - - 

CPU51 Yes Yes - - Yes - - 

CPU61 Yes Yes - - Yes - - 
 

CS1G/CS1G-H Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU45 Yes Yes - Yes Yes Yes Yes 

CPU44 Yes Yes - Yes Yes Yes Yes 

CPU43 Yes Yes - Yes Yes Yes Yes 

CPU42 Yes Yes - Yes Yes Yes Yes 

CS1H/CS1H-H Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU67 Yes Yes - Yes Yes Yes Yes 

CPU66 Yes Yes - Yes Yes Yes Yes 

CPU65 Yes Yes - Yes Yes Yes Yes 

CPU64 Yes Yes - Yes Yes Yes Yes 

CPU63 Yes Yes - Yes Yes Yes Yes 
 

IDSC Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

C01 Yes Yes - - - - - 

C02 Yes Yes - - - - - 
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SRM1 – SRM1 V2 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

C01 Yes Yes - - - - - 

C02 Yes Yes - - - - - 

CV1000 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU01 Yes Yes Yes Yes Yes Yes - 

CV2000 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU01 Yes Yes Yes Yes Yes Yes - 

CV500 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU01 Yes Yes Yes Yes Yes Yes - 

CVM1 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU01 Yes Yes Yes Yes Yes Yes - 

CPU11 Yes Yes Yes Yes Yes Yes - 

CVM1-V2 Device Group 
Device Type SYSMAC 

WAY 
Toolbus SYSMAC 

NET 
SYSMAC 

LINK 
Controller 

Link 
Ethernet Device 

Net 

CPU01 Yes Yes Yes Yes Yes Yes - 

CPU11 Yes Yes Yes Yes Yes Yes - 

CPU21 Yes Yes Yes Yes Yes Yes - 
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 APPENDIX B 
PLC Memory Areas 

The following tables provide memory area details for each device group. 

Some tables indicate special addresses. These can be as follows: 

♦  CLOCK. This allows reading/writing of a PLC's real-time clock. 
♦  BANKNO. This allows reading/writing of a PLC's extended memory bank number. 
♦  MODE. This allows reading/writing of a PLC's run-mode.  

C**H Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

TC 0 511 Present Value Status Yes F C 

DM 0 1999 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 252 Yes Yes Yes F C 

IR (opt) 253 255 (bit 7) Yes Yes No  

LR 0 63 Yes Yes Yes F C 

SR (opt) 247 252  Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  
 
Special addresses CLOCK, MODE. 

C**K Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

TC 0 47 Present Value Status Yes F C 

DM 0 63 Yes No Yes  

HR 0 9 Yes Yes Yes F C 

IR (opt) 0 18 (bit 7) Yes Yes Yes F C 

SR (opt) 18 (bit 8) 19 (bit 7) No Yes No  

TR 0 0 (bit 7) No Yes No  
 

C**P Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

TC 0 47 Present Value Status Yes F C 

DM 0 63 Yes No Yes  

HR 0 9 Yes Yes Yes F C 

IR (opt) 0 18 (bit 7) Yes Yes Yes F C 

SR (opt) 18 (bit 8) 19 (bit 7) No Yes No  

TR 0 0 (bit 7) No Yes No  
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C1000H Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

TC 0 511 Present Value Status Yes F C  

DM 0 4095 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 236 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 237  252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  
 
Special addresses: MODE. 

C20 Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

TC  0 47 Present Value Status Yes F C 

HR 0 9 Yes Yes Yes F C 

IR (opt) 0 18 (bit 7) Yes Yes Yes F C 

SR (opt) 18 (bit 8) 19 (bit 7) No Yes No  

TR 0 0 (bit 7) No Yes No  
 

C2000H Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

TC 0 511 Present Value Status Yes F C  

DM 0 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 236 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 237 252  Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  
 
Special addresses: MODE. 

C200H Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 1999 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252  Yes Yes Yes F C 
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Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 
 
Special addresses: CLOCK, MODE. 
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C200HE Device Group 

General Memory Areas 
Memory Areas for any CPU. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 4095 Yes No Yes  

DM 6000 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

IR (opt) 300 511 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252  Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

SR (opt) 256 299 Yes Yes Yes FC 

TR 0 0 (bit 7) No Yes No  

SR (opt) 256 299 Yes Yes Yes F C 

TC 0 511 Present Value Status Yes F C 
 

CPU 32/42 Memory Areas 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

DM 4096 5999 Yes No Yes  
 
Special addresses: CLOCK, MODE. 

C200HE-Z Device Group 

General Memory Areas 
Memory Areas for any CPU. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 4095 Yes No Yes  

DM 6000 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

IR (opt) 300 511 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252  Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

SR (opt) 256 299 Yes Yes Yes FC 

TR 0 0 (bit 7) No Yes No  

SR (opt) 256 299 Yes Yes Yes F C 

TC 0 511 Present Value Status Yes F C 
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CPU 32/42 Device Group 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

DM 4096 5999 Yes No Yes  
 
Special addresses: CLOCK, MODE. 

C200HG Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

IR (opt) 300 511 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

SR (opt) 256 299 Yes Yes Yes F C 

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 

EM 0 6143 * 1 Yes No Yes -n 
 
Special addresses: CLOCK, MODE, BANKNO. 

C200HG-Z Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

IR (opt) 300 511 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

SR (opt) 256 299 Yes Yes Yes F C 

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 

EM 0 6143 * 1 Yes No Yes -n 
 
Special addresses: CLOCK, MODE, BANKNO. 
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C200HS Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

IR (opt) 300 511 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

SR (opt) 256 299 Yes Yes Yes F C 

TC 0 511 Present Value Status Yes F C 

TR 0 0 (bit 7) No Yes No  
 
Special addresses: CLOCK, MODE. 

C200HX Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

IR (opt) 300 511 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252  Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

SR (opt) 256 299 Yes Yes Yes F C 

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 

EM 0 6143 * 3 Yes No Yes -n 
 
Special addresses: CLOCK, MODE, BANKNO. 

C200HX-Z Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 235 Yes Yes Yes F C 

IR (opt) 300 511 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 236 252  Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

SR (opt) 256 299 Yes Yes Yes F C 

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 
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Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

EM 0 6143 * 3 Yes No Yes -n 
 

CPU 65 Memory Areas 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

EM 0 6143 * 8 Yes No Yes -n 
 

CPU 85 Memory Areas 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

EM 0 6143 * 16 Yes No Yes -n 
 
Special addresses: CLOCK, MODE, BANKNO. 

 

C500 Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

TC 0 127 Present Value Status Yes F C 

DM 0 511 Yes No Yes  

HR 0 31 Yes Yes Yes F C 

IR (opt) 0 57 Yes Yes Yes F C 

LR 0 31 Yes Yes Yes F C 

SR (opt) 58 60 Yes Yes Yes F C 

SR (opt) 61 63 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  
 

CJ1G Device Group 

General Memory Areas 
General Memory Areas for all CPUs 44 and 45. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

IR 0 15 Yes (double) No Yes  

DR 0 15 Yes No Yes f c 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes f c 

H 0 511 Yes Yes Yes  

W 0 511 Yes Yes Yes  

CIO(opt) 0 6143 Yes Yes Yes f c 

T 0 4095 Present Value Status Yes F C 

C 0 4095 Present Value Status Yes F C 
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Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

D 0 32767 Yes No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  
   

CPU 44 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 1 Yes No Yes -n 
 

CPU 45 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 3  Yes No Yes -n 

Special addresses: (all CPUs):  
(CPU 44/45):   

CLOCK, MODE.
BANKNO. 

CJ1G-H Device Group 

General Memory Areas 
General Memory Areas for all CPUs 42, 43, 44 and 45. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

IR 0 15 Yes (double) No Yes  

DR 0 15 Yes No Yes f c 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes f c 

H 0 511 Yes Yes Yes  

W 0 511 Yes Yes Yes  

CIO(opt) 0 6143 Yes Yes Yes f c 

T 0 4095 Present Value Status Yes F C 

C 0 4095 Present Value Status Yes F C 

D 0 32767 Yes No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  
 

CPU 42 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 1 Yes No Yes -n 
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CPU 43 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 1 Yes No Yes -n 
  

CPU 44 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 1 Yes No Yes -n 
  

CPU 45 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 3  Yes No Yes -n 

Special addresses: (all CPUs):  
(CPU 44/45):   

CLOCK, MODE.
BANKNO. 

    

CJ1H-H Device Group 

General Memory Areas 
General Memory Areas for CPUs 65 and 66. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

CIO(opt) 0 6143 Yes Yes Yes fc 

DR 0 15 Yes No Yes fc 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes fc 

H 0 511 Yes Yes Yes fc 

W 0 511 Yes Yes Yes  

T 0 4095 Present Value Status Yes FC 

C 0 4095 Present Value Status Yes FC 

D 0 32767 Yes No Yes  

IR 0 15 Yes (double) No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  
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CPU 65 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*3 Yes No Yes -n 
 

CPU 66 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*7 Yes No Yes -n 
 

CJ1M and CP1H Device Group 

General Memory Areas 
General Memory Areas for all CPUs 12, 13, 22 and 23. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

IR 0 15 Yes (double) No Yes  

DR 0 15 Yes No Yes f c 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes f c 

H 0 511 Yes Yes Yes  

W 0 511 Yes Yes Yes  

CIO(opt) 0 6143 Yes Yes Yes f c 

T 0 4095 Present Value Status Yes F C 

C 0 4095 Present Value Status Yes F C 

D 0 32767 Yes No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  

CPM1 (CPM1A) Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 15 Yes Yes Yes F C 

DM 0 1023 Yes No Yes  

DM 6144 6655 Yes No Yes  

HR 0 19 Yes Yes Yes F C 

IR (opt) 0 19 Yes Yes Yes F C 

IR (opt) 200 231 Yes Yes Yes F C 

LR 0 15 Yes Yes Yes F C 

SR (opt) 232 252 Yes Yes Yes F C 

TR 0 0 (bit 7) No Yes No  

TC 0 127 Present Value Status Yes F C 
 
Special addresses: MODE. 
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CPM2*/CPM2*-S* Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 23 Yes Yes Yes F C 

DM 0 2047 Yes No Yes  

DM 6144 6599 Yes No Yes  

DM 6600 6655 Yes No No  

HR 0 19 Yes Yes Yes F C 

IR (opt) 0 49 Yes Yes Yes F C 

IR (opt) 200 227 Yes Yes Yes F C 

LR 0 15 Yes Yes Yes F C 

SR (opt) 228 252 Yes Yes Yes F C 

SR(opt) 253 255 Yes Yes No  

TR 0 0 (bit 7) No Yes No  

TC 0 127 Present Value Status Yes F C 
 
Special addresses: MODE. 

 

CQM1 Device Group 

Memory Areas 
Memory Areas for all CPUs. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 1023 Yes No Yes  

DM 6144 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 243 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 244 252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 

CPU 41/42/43/44/45 Memory Areas 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

DM 1024 6143 Yes No Yes  
 
Special addresses: CLOCK, MODE. 
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CQM1H Device Group 

Memory Areas 
Memory Areas for all CPUs. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 243 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 244 252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 
  

CPU 11/21 Memory Areas 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

DM 0 3071 Yes No Yes  

DM 6144 6655 Yes No Yes  
 
Special addresses: CLOCK, MODE. 

 

CPU 51 Memory Areas 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

DM 0 6655 Yes No Yes  
 
Special addresses: CLOCK, MODE. 

CPU 61 Memory Areas 
Memory Areas in addition to general memory areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

DM 0 6655 Yes No Yes  

EM 0 6143 * 1 Yes No Yes  
 
Special addresses: CLOCK, MODE. 

CS1G Device Group 

General Memory Areas 
General Memory Areas for all CPUs 42, 43, 44 and 45. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

IR 0 15 Yes (double) No Yes  
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Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

DR 0 15 Yes No Yes f c 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes f c 

H 0 511 Yes Yes Yes  

W 0 511 Yes Yes Yes  

CIO(opt) 0 6143 Yes Yes Yes f c 

T 0 4095 Present Value Status Yes F C 

C 0 4095 Present Value Status Yes F C 

D 0 32767 Yes No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  

CPU 44 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 1 Yes No Yes -n 
 

CPU 45 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 3  Yes No Yes -n 

Special addresses: (all CPUs):  
(CPU 44/45):   

CLOCK, MODE.
BANKNO. 

CS1G-H Device Group 

General Memory Areas 
General Memory Areas for all CPU 42, 42, 44 and 45 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

CIO(opt) 0 6143 Yes Yes Yes fc 

DR 0 15 Yes No Yes fc 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes f 

H 0 511 Yes Yes Yes FC 

W 0 511 Yes Yes Yes  

T 0 4095 Present Value Status Yes FC 

C 0 4095 Present Value Status Yes FC 

D 0 32767 Yes No Yes  

IR 0 15 Yes (double) No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  
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CPU 42 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*1 Yes No Yes -n 

CPU 43 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*1 Yes No Yes -n 

CPU 44 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*1 Yes No Yes -n 

CPU 45 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*3 Yes No Yes -n 

CS1H Device Group 

General Memory Areas  
General Memory Areas for all CPUs 63, 64, 65, 66 and 67. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

IR 0 15 Yes (double) No Yes  

DR 0 15  Yes No Yes f c 

TK 0 31 Status Yes No  

A 0 447  Yes Yes No  
A 448 959 Yes Yes Yes f c 

H 0 511 Yes Yes Yes  

W 0 511 Yes Yes Yes  

CIO(opt) 0 6143 Yes Yes Yes f c 

T 0 4095 Present Value Status Yes F C 

C 0 4095 Present Value Status Yes F C 

D 0 32767  Yes No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  
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CPU 64 Memory Areas  
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 1 Yes No Yes -n 

CPU 65 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 3  Yes No Yes -n 

CPU 66 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767 * 7 Yes No Yes -n 

CPU 67 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32765 * 13  Yes No Yes -n 

Special 
addresses: 

(all CPUs):  
(CPU 64/65/66/67):   

CLOCK, MODE.
BANKNO. 

 

CS1H-H Device Group 

General Memory Areas 
General Memory Areas for all CPU 63, 64, 65, 66 and 67 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

CIO(opt) 0 6143 Yes Yes Yes fc 

DR 0 15 Yes No Yes fc 

TK 0 31 Status Yes No  

A 0 447 Yes Yes No  

A 448 959 Yes Yes Yes fc 

H 0 511 Yes Yes Yes fc 

W 0 511 Yes Yes Yes  

T 0 4095 Present Value Status Yes FC 

C 0 4095 Present Value Status Yes FC 

D 0 32767 Yes No Yes  

IR 0 15 Yes (double) No Yes  

CF 0 11 No Yes No  

CF 100 104 No Yes No  

CF 113 114 No Yes No  
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CPU 63 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*1 Yes No Yes -n 
 

CPU 64 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*1 Yes No Yes -n 
 

CPU 65 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*3 Yes No Yes -n 
 

CPU 66 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*7 Yes No Yes -n 
 

CPU 67 Memory Areas 
Memory Areas in addition to General Memory Areas 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

E 0 32767*13 Yes No Yes -n 
 

IDSC Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 27 Yes Yes Yes F C 

DM 0 1023 Yes No Yes  

DM 6144 6655 Yes No Yes  

HR 0 99 Yes Yes Yes F C 

IR (opt) 0 243 Yes Yes Yes F C 

LR 0 63 Yes Yes Yes F C 

SR (opt) 244 252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  

TC 0 511 Present Value Status Yes F C 
 
Special addresses: CLOCK, MODE. 
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SRM1 Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 15 Yes Yes Yes F C 

DM 0 2047 Yes No Yes  

DM 6144 6655 Yes No Yes  

HR 0 19 Yes Yes Yes F C 

IR (opt) 0 23 Yes Yes Yes F C 

IR (opt) 200 252 Yes Yes Yes F C 

LR 0 15 Yes Yes Yes F C 

SR (opt) 232 252 Yes Yes Yes F C 

SR (opt) 253 255 (bit 7) Yes Yes No  

TR 0 0 (bit 7) No Yes No  

TC 0 127 Present Value Status Yes F C 
 
Special addresses: MODE. 

SRM1 V2 Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

AR 0 15 Yes Yes Yes F C 

C 0 127 Yes Yes Yes F C 

DM 0 2047 Yes No Yes  

DM 6144 6655 Yes No Yes  

HR 0 19 Yes Yes Yes F C 

IR  0 23 Yes Yes Yes F C 

IR  200 239 Yes Yes Yes F C 

LR 0 15 Yes Yes Yes F C 

SR  240 253 Yes Yes Yes F C 

SR  253 254  Yes Yes No  

SR 254 255 Yes Yes No  

TR 0 0 (bit 7) No Yes No  

TC 0 127 Present Value Status Yes F C 
 
Special addresses: MODE. 

CV1000 Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

A 0 255 Yes Yes Yes F C 
A 256 511 Yes Yes No  

AC 0 2047 No Yes No  
C 0 1023 Present Value Status Yes F C 

CIO (opt) 0 2555 Yes Yes Yes F C 
D 0 24575 Yes No Yes  

DR 0 2 Yes No Yes  
G 0 255 Yes Yes Yes F C 
IR 0 2 Yes No Yes  
ST 0 1023 Yes Yes Yes  
T 0 1023 Present Value Status Yes F C 
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Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

TN 0 1023 No Yes Yes F C 
TR 0 0 (bit 7) No Yes Yes F C 
E 0 32765 * 2/4/8 Yes No Yes - n 

 
Special addresses: BANKNO, CLOCK, MODE. 

CV2000 Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

A 0 255 Yes Yes Yes F C 
A 256 511 Yes Yes No  

AC 0 2047 No Yes No  
C 0 1023 Present Value Status Yes F C 

CIO (opt) 0 2555 Yes Yes Yes F C 
D 0 24575 Yes No Yes  

DR 0 2 Yes No Yes  
G 0 255 Yes Yes Yes F C 
IR 0 2 Yes No Yes  
ST 0 1023 Yes Yes Yes  
T 0 1023 Present Value Status Yes F C 

TN 0 1023 No Yes Yes F C 
TR 0 0 (bit 7) No Yes Yes F C 
E 0 32765 * 2/4/8 Yes No Yes - n 

 
Special addresses: BANKNO, CLOCK, MODE. 

CV500 Device Group 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

A 0 255 Yes Yes Yes F C 

A 256 511 Yes Yes No  

AC 0 1023 No Yes No  

C 0 511 Present Value Status Yes F C 

CIO (opt) 0 2555 Yes Yes Yes F C 

D 0 8191 Yes No Yes  

DR 0 2 Yes No Yes  

G 0 255 Yes Yes Yes F C 

IR 0 2 Yes No Yes  

ST 0 511 Yes Yes Yes F C 

T 0 511 Present Value Status Yes F C 

TN 0 511 No Yes Yes F C 

TR 0 0 (bit 7) No Yes Yes F C 
 
Special addresses: MODE, CLOCK 
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CVM1 Device Group 

General Memory Areas 
Memory Areas for any CPU. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

A 0 255 Yes Yes Yes F C  

A 256 511 Yes Yes No  

DR 0 2 Yes No Yes  

CIO (opt) 0 2555 Yes Yes Yes F C 

G 0 255 Yes Yes Yes F C 

IR 0 2 Yes No Yes  

TR 0 0 (bit 7) No Yes Yes F C 
 

CPU 01 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

C 0 511 Present Value Status Yes F C 

D 0 8191 Yes No Yes  

T 0 511 Present Value Status Yes F C 
 

CPU 11 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

C 0 1023 Present Value Status Yes F C 

D 0 24575 Yes No Yes  

T 0 1023 Present Value Status Yes F C 
 
Special addresses: (all CPUs): CLOCK, MODE. 

CVM1-V2 Device Group 

General Memory Areas 
Memory Areas for any CPU. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

A 0 255 Yes Yes Yes F C  

A 256 511 Yes Yes No  

DR 0 2 Yes No Yes  

CIO (opt) 0 2555 Yes Yes Yes F C 

G 0 255 Yes Yes Yes F C 

IR 0 2 Yes No Yes  

TR 0 0 (bit 7) No Yes Yes F C 
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CPU 01 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

C 0 511 Present Value Status Yes F C 

D 0 8191 Yes No Yes  

T 0 511 Present Value Status Yes F C 
 

CPU 11 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

C 0 1023 Present Value Status Yes F C 

D 0 24575 Yes No Yes  

T 0 1023 Present Value Status Yes F C 
 

CPU 21 Memory Areas 
Memory Areas in addition to General Memory Areas. 

Prefix Start 
Channel 

End Channel Word 
Addressing 

Bit 
Addressing 

Read 
Write 

Modifiers 

C 0 1023 Present Value Status Yes F C 

D 0 24575 Yes No Yes  

T 0 1023 Present Value Status Yes F C 

E 0 32765 * 2/4/8 Yes No Yes -n 

Special 
addresses: 

(all CPUs): 
(CPU 21): 

CLOCK, 
MODE. 

BANKNO. 
 

FinsGateway CPU Unit 
Prefix Start 

Channel 
End Channel Word 

Addressing 
Bit 

Addressing 
Read 
Write 

Modifiers 

CIO(opt) 0 32767 Yes Yes Yes  

D 0 32767 Yes No Yes  
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 APPENDIX C 
Toolbars and Keyboard Shortcuts 

The following tables summarise the toolbars and keyboard shortcuts available from each component and tool. The 
F1 function key is common across all components and tools and provides context help. 

Toolbars 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

Open 

Open File 

Save in Project 

Print 

Print Preview 

Cut 

Copy 

Past 

 

 

 

 

Fill Data Area 

Clear Data Area 

Transfer to PLC 

Transfer from PLC 

Compare with PLC 

Monitor 

 

 

 

 

Binary 

Binary Coded Decimal 

Decimal 

Signed Decimal 

Floating Point 

Hexadecimal 

Text 

LReal 

Double Word 

Quad Word 

Resize Column 

Zoom Out 

Restore Zoom 

Zoom In  

 

 

Set Value 

Force On 

Force Off 

Clear Force Statusl 

Keyboard Shortcuts 
    
Ctrl+O………. Open Alt+B……… Binary 
Ctrl+S………. Save in Project Alt+C……… Binary Coded Decimal 
Ctrl+P………. Print Alt+D……… Decimal 
Ctrl+X………. Cut Alt+S……… Signed Decimal 
Ctrl+C………. Copy Alt+O……… Double Word 
Ctrl+V………. Paste Alt+Q……… Quad Word 
Ctrl+PgUp….. Zoom In Alt+P……… Floating Point 
Ctrl+PgDn….. Zoom Out Alt+H……… Hexadecimal 
  Alt+T……… Text 
  Alt+L……… Real 
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Data Trace/Time Chart Monitor Component 

Toolbars      Keyboard Shortcuts 

 

Open 

Save 

Configure Trace/Time Chart 

Zoom Out 

Restore Zoom 

Zoom In 

Scale Out 

Restore Scale 

Scale In 

Stop Trace/Time Chart 

Trigger the Trace/Time Chart 

Execute Trace/Time Chart 

Read Trace/Time Chart 

About 

Help 

 

 
Ctrl+O............. Open 
Ctrl+PgUp....... Zoom In 
Ctrl+PgDn....... Zoom Out 
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Memory Card Component 

Toolbars      Keyboard Shortcuts 

 

Cut 

Copy 

Paste 

Delete 

Rename 

Properties 

Large Icons 

Small Icons 

List 

Details 

 
Ctrl+X ............. Cut 
Ctrl+C............. Copy 
Ctrl+V ............. Paste 
Ctrl+A ............. Select All 
F5 ................... Refresh device 

CX-Net Network Configuration Tool 

Toolbars      Keyboard Shortcuts 

 

Open Project 

Edit Project 

Open/Close Project Device PLC 

Display PLC Information 

Set PLC Operating Mode 

Display PLC Error Status 

Show Unit Status 

Configure PLC System Settings 

Configure IO Table 

Configure C-Series Comms. Units 

Online Edit Routing Table 

Online Edit Data Link 

Echo Back Test 

Broadcast Test 

Ping Test 

About 

 
Ctrl+N............. New 
Ctrl+O............. Open 
Ctrl+S ............. Save 
Return ............ Edit Item 
Insert .............. Insert Item 
Delete............. Delete Item 
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Import/Export Tool 

Toolbars      Keyboard shortcuts 

 

New 

Open 

Edit Project 

Import CVSS 

Import LSS 

Import Text 

Import Tagged Database 

Export Text 

Export to FinsServer TagDB 

Clear Screen 

Print Screen 

About 

 
Ctrl+N............. New 
Ctrl+O............. Open 
Ctrl+E ............. Edit Project 
Ctrl+C............. Import CVSS 
Ctrl+L ............. Import LSS 
Ctrl+T ............. Import Text 
Ctrl+V ............. Import from FinsGateway 
Alt+T............... Export Text 
Alt+V .............. Export to FinsGateway TagDB 
Ctrl+R............. Clear screen 
Ctrl+P ............. Print screen 
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Data Link Editor 

Toolbars      Keyboard Shortcuts 

 

New 

Show All Network Nodes 

Open 

Save 

Toggle Network/Single Node operation 

Transfer to PLC 

Transfer from PLC 

Delete 

Verify Node 

Status 

Automatic Datalink Setup 

Validate Table 

Wizard 

Add source link 

Add Destination 

Set properties 

Delete link destination service area 

Zoom in 

Zoom out 

Zoom original 

Print 

About Datalink Component 

 
Ctrl+N............. New 
Ctrl+O............. Open 
Ctrl+S ............. Save 
Ctrl+P ............. Print 
Ctrl+<space.... Change Window 
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Routing Table Editor 

Toolbars       Keyboard Shortcuts 

 

New 

Open 

Save 

Print 

Print Preview 

Always on top 

Transfer to PLC 

Transfer from PLC 

Check routing table 

Activate C-Series Control Link 
routing Table 

 
Ctrl+P.............  Print 
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 GLOSSARY OF TERMS 
Actual IO Table The real hardware configuration of the PLC units and slots on power-up. 
Address A location in memory where data or programs are stored. It can also identify a location 

of a node on a network. 
Application A software program that accomplishes a specific task. Examples of applications are 

CX-Server, CX-Programmer, CX-Protocol and Microsoft Excel.  
ASCII American Standard Code for Information Interchange. 
Auxiliary Area An area of PLC memory which normally contains transmission Counters, flags and 

control bits. It also retains the status of the device during power failure. 
Baud rate The speed of data transmission in terms of the number of bits per second that are being 

sent. 
BCD Binary Coded Decimal. 
Binary Coded Decimal A data format supported by CX-Server. 
Binary A data format supported by CX-Server. A number system format to the base 2, i.e. 

employing the digits 0 and 1. 
Bit A digit used in binary notation which can take the value 0 or 1. The value of a bit, or 

combination of bits, can represent the status of a device or can be used in programming. 
Boolean A type of point or symbol where the value can be one of two states. Essentially the two 

states are ‘0’ and ‘1’, but these states can be assigned a meaningful designation.  
Bridge A device connecting local area networks of similar architectures together. 
Broadcast address An address held in common by all nodes on a network to which the same data is 

transmitted simultaneously. 
Bus A communications path along which data can be transmitted or received between the 

units connected to it. 
Central Processing Unit The part of the PLC which can store programs and data, execute the instructions in 

program, and process input and output signals in order to communicate with other, 
external, devices. 

Clipboard An area within the windows environment where data can be stored temporarily or 
transferred between applications. 

Command modifier An optional part of an address string indicating the modification to be performed on the 
data at that address (within PLC memory) when it is accessed. 

Common link parameter The common words used by all PLCs in a Data Link (within a SYSMAC LINK system). 
Compact Flash A type of memory card fitted to a PLC. 
Components CX-Server is made up of six components accessible from an invoking application. 
Control bit A bit assigned a controlling role in the functioning of a device; its status is set via a 

program to achieve this function. 
Controller Link A network that can send and receive large data packets flexibly and easily among the 

OMRON PLCs. 
Counter area An area of PLC memory containing program counters and their related completion 

flags. 
Counter An area of memory reserved for the purposes of counting the number of times an event 

has occurred. 
CPU bus link area An area of PLC memory allocated to the CPU bus unit. 
CPU type The type of CPU available to a specific device, the amount of memory available to a 

PLC varies according to the CPU involved. 
CPU Central Processing Unit. 
CS-series Indicates either a CS1G-H, CS1H-H, CS1D-S, or CS1D-H. 
CJ-series Indicates either a CJ1G-H, CJ1H-H, or CJ1M.  
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C-Series Indicates any one of the following types of PLC: C2000H, C200H, C200HE, 
C200HE-Z, C200HG, C200HE-Z, C200HS, C200HX, C200HX-Z, C1000H, C**H, 
C**K, C**P, CQM1, C500, C120, C20, CPM1 (CPM1A/CPM2*). 

CV-Series Indicates any one of the following types of PLC: CVM1, CVM1-V2, CV500, CV1000 
or CV2000. When using SYSMAC NET, CV series PLCs can operate in either CV 
mode (where the datagrams contain FINS commands) or C mode (where the datagrams 
contain C SYSNET commands). 

CVSS A file format supported by the CX-Server Import tool. CVSS has several file types 
which have different information contained in them. 

CX-Net Network Configuration tool 
This CX-Server tool consists of a suite of programs allowing the management of 
Routing Tables and Data Link Tables in OMRON PLCs. 

CX-Server An advanced communications management system for OMRON PLCs providing 
facilities for software to maintain PLC device and address information and to 
communicate with OMRON PLCs and their supported network types. 

CX-Server Project A definition of an OMRON PLC network configuration. It identifies all devices and 
networks within a particular configuration including the areas of PLC memory (points) 
that can be read from or written to. 

Cycle time The time interval between read/write cycles at a network node. 
Data area An area of PLC memory allocated to the storage of data (not programs). 
Data bits Bits representing each character to be transmitted. 
Data link A software connection establishing common data areas between PLCs on a network 

allowing data to be between these devices. 
Data Link Editor The data Link Editor allows a PLC to be configured so that it can participate in one, or 

more automatic data sharing schemes, over Sysmac Link and Controller Link networks, 
without the need for special programming. 

Data link table A table of the common data memory areas used by the PLCs in a Data Link. 
Data location An area of memory identified by an address. 
Data memory An area of PLC memory holding only word data. 
Data Trace/Time Chart Monitor component 

This CX-Server component displays data obtained from the PLC’s memory areas during 
program execution. 

Datagram A packet of information which can be transmitted across a network containing routing 
information plus data. 

DDE Dynamic Data Exchange. A channel through which correctly prepared programs can 
actively exchange data and control other applications within Microsoft Windows. 
CX-Server, through the use of the DDE Manager tool, allows extensive use of DDE 
functionality. 

 See also Item, Server, server application and Topic. 
DDE management library A dynamic link library within Windows which allows dynamic data exchange to be 

employed. 
DDE Manager tool A CX-Server tool for transferring data between PLCs and a client application using 

DDE, for example Microsoft Excel. 
DDEML Dynamic Data Exchange Management Library. 
Debug mode A mode of PLC operation during which any errors arising from the currently active 

program will be flagged. For CV-series PLC only. 
Decimal A data format supported by CX-Server. 
Default A value automatically set by a program in the absence of user input or on initial entry to 

an application; such values can be overwritten. 
Destination network address The address of the network to which data is directed. 
Destination node number The number identifying the destination node. 
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Destination node The node (and therefore device) where transmitted data is to be placed. 
Device group A class of devices which share similar properties, each group can be sub-divided into 

device types. 
Device type A type of OMRON PLC. 
Device A type of OMRON automation device, either a PLC, Temperature Controller, Memory 

Card Writer or PROM Writer. 
Dialog A window asking for some form of response from the user, usually in the form of either 

entering requested information, selecting displayed data, or confirming an operation. 
DLL Dynamic Link Library. A program file that although cannot be run stand-alone as an 

executable, can be utilised by one or more applications or programs as a common 
service. DLL files have a *.DLL extension. DLL’s comprise a number of stand-alone 
functions.  

Double Floating Point Double Floating Point (LREAL) type is as the IEEE754 Double precision (1.7E 
+308/-307) as defined by Microsoft®. 

Download Refer to Transfer to PLC. 
Drag The act of moving an item on the screen by selecting it with the mouse, and keeping the 

mouse button depressed, moving the mouse until the item has reached the required 
location. The mouse button is then released. 

Driver The software which controls the communications between a computer and PLC, 
translating any information passed between them into a format that the receiving Device 
can understand. 

Dynamic Data Exchange The method of transferring data (and possibly instructions) between applications via the 
establishment of reference links between them. 

Echo test The reflection of a signal along a communications channel in order to check the 
accuracy of data transmission by comparing the received data against the original data at 
the sending end. 

EEPROM Electrically Erasable Programmable Read Only Memory. 
Elements The number of address units which start at a specified data location. 
End Connection The final communication link between computer and PLC, or in the case of a Network 

configuration, gateway PLC to PLC. 
End network address The address of the destination network to which communications are directed. 
Error status An indication of an error condition found in a system. 
Ethernet A 10 MB baseband local area network with each Device attached to the network having 

equal status and therefore the ability to transmit as, and when, required (provided the 
line isn’t busy). 

Even parity The number of 1s in a data transmission is even. 
Event frame A structure, predetermined by a protocol, containing specific fields for the transmission 

of data. 
Exclusive mode PLC mode which allows an application exclusive access to the Device. 
Expansion memory The memory available to a CPU in addition to conventional memory. 
File memory An area of CPU memory allocated to the storage of data. 
File Transfer Protocol Protocol for transferring files between host computers. 
FINS Factory Intelligent Network Service. 
FinsGateway An OMRON communication type supported by CX-Server. 
Flag An indicator representing the condition of a process, data area or Device. 
Floating Point A data format supported by CX-Server. 
Folder A structure which organises the files in computer memory or on disk. Also known as a 

‘directory’. 
Frame length The waiting time before data is transmitted across the network 
FTP File Protocol Transfer. 
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Gateway device A Device connecting two networks of different architectures together. 
Gateway network address The address of a network acting as a gateway. 
Gateway PLC A PLC which acts as a link to another network.  
Group A sub-directory within a CX-Server project hierarchy which contains points and/or 

further (subsidiary) groups. 
GUI Graphical User Interface. Part of a program that interacts with the user and takes full 

advantage of the graphics displays of computers. A GUI employs pull-down menus and 
dialog boxes for ease of use. Like all Microsoft Windows based applications, 
CX-Server has a GUI for each component and tool. 

Hard disk A disk permanently mounted on its drive. 
Hexadecimal A data format supported by CX-Server. 
Hierarchy The structure of a CX-Server project from the root directory down through any 

sub-directories (groups) to individual points contained within those groups. 
High Link A network driver. 
Host computer A computer responsible for data management and for overall control of the system. 

Programs and data are downloaded to a PLC from the host computer. 
Host link system A system comprising one or more host computers connected to one or more PLCs by 

host link units; these units facilitate the transfer of data between the PLC(s) and the host 
computer. 

Host link unit The interface between a PLC and a host computer. 
Icon Pictorial representations of computer resources and functions. Many icons are used by 

CX-Server components and tools as part of the GUI. 
IDSC device type An OMRON PLC device supported by CX-Server. 
Import tool This CX-Server tool is used for addresses and PLCs defined using the CVSS and LSS 

products. 
Input bit data area An area of PLC memory containing the status of an input Device. 
Input bit The location within memory indicating the status of an input. 
Input device A Device which sends signals to a PLC. 
Input The signal sent to a PLC from an external device. 
Instruction A statement indicating an operation to be performed and identifies any data involved in 

this operation. 
Intel Hex A PLC device also known as a PROM Writer. 
Interface Hardware or software employed to link the elements within a system, including 

networks, programs and computers. 
Internal data type The format of the data held at an address in PLC memory; for example, bit or signed 

character binary.  
Internode test An echo test performed to check the condition of a PLC on a network node. 
Invoking application An application such as CX-Programmer and CX-Protocol that utilises components and 

tools belonging to CX-Server. 
IO bit A bit which can hold data entered into, or received from, the system. 
IO Table component This CX-Server component retrieves configured PLCs rack and address data. 
IO type Input /Output type. An attribute of a point or symbol that defines the origin and 

destination of the data for that point or symbol. The data can originate (be input from) 
and is destined (is output to) to the internal computer memory, PLC or DDE target 
application. 

IO Input /Output. 
IP address table A table containing the IP addresses for all the devices on the Ethernet. 
IP address An address for a device on the Ethernet. 
IP router table A table containing the addresses for each interface on a network.  
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IP Internet Protocol. 
Item A unique name for a data item within a topic. 
LAN Local Area Network. 
Link Relay Area A common data area allowing the transfer of data between PLCs connected by a Data 

Link; the information held in this area in the memory of each PLC is identical. 
Link system A system that links PLCs together. 
Link unit A unit which connects a device to the network. 
Link A connection between two units established either by software or a hardware device. 
Load Placing a program or data into an area of computer or PLC memory. 
Local area network A network located within a limited area (normally the user’s premises). 
Local network address The address of the network to which a PLC is connected. 
Local network number The number of the unit connecting the PLC to the network. 
Local table A table containing the details of the networks to which a PLC belongs. 
LREAL LREAL (Double Floating Point) type is as the IEEE754 Double precision (1.7E 

+308/-307) as defined by Microsoft®. 
LSS A file format supported by the CX-Server Import tool. 
Mailbox A communications protocol. 
Mark parity The parity bit is always set to 1. 
Master A controlling device which sends data and/or instructions to a slave device. 
Mb Megabytes – A means of defining computer memory size. 
Memory area Addressable area of storage space in a device. 
Memory Card component This CX-Server component manages the file storage to and from PLC memory cards. 
Memory Card Writer A device which writes data to a memory card. 
Memory card A data storage medium which can hold both programs and data. 
MHz Megahertz. 
Micro host link A link to a ‘micro’ device acting as a host. 
Microsoft Excel A spreadsheet application. 
Microsoft Windows Explorer A file handling application part of the Microsoft Windows suite. 
Microsoft Windows A windowing environment that is noted for its GUI, and for features such as multiple 

typefaces, desk accessories (such as a clock, calculator, calendar and notepad), and the 
capability of moving text and graphics from one application to another via a clipboard. 

 CX-Server runs only under Microsoft Windows. DDE functions communicating with 
other applications supported by CX-Server use Microsoft Windows as a basis. 

Modem A device with the ability to convert digital data from a computer into analogue form and 
transmit it over a telecommunications line and also to convert received analogue signals 
into digital form. 

Monitor mode A PLC operational mode which allows the device, during normal execution, to review 
the condition of the Data Link (including the PLCs/nodes on that link). 

n A variable number. 
Native data format The format in which data is handled by a communications protocol; for example, ASCII 

or binary. 
Network bridge A unit that connects two or more networks together. 
Network parameters Network settings including information such as the maximum number of nodes 

permitted on a network and the waiting times between transmissions. 
Network Service Board An interface which connects devices (not PLCs) to the network. 
Network 1. Part of the PLC configuration, based on the device type. The number of Networks 

available is dependant on the device type. 
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 2. A number of computers linked together with a central processing point known as a 
Server which is accessible to all computers. Networks affect CX-Server in that 
further Network associated options are available if the computer is Network 
connected. 

Node number Number identifying the device located at a particular node on the network. The number 
can be between 1 and 126, the maximum number of nodes available on an OMRON 
network. 

Node A position at which a device can be located on the network, consisting of a link unit 
mounted to a device or PLC which in turn interfaces with a peripheral device or a 
computer.  

NSB Network Service Board. 
Odd parity The number of 1s in a data transmission is odd. 
Offline The status of a device when it is not being controlled by a computer (although it may be 

physically connected to it). 
OLE Object Linking and Embedding. Used to transfer and share information between 

Microsoft Windows based applications and accessories.  
Online The status of a device when it is under the direct control of a computer. 
Output Bit data area An area of PLC memory reserved for output bits. 
Output bit The location within memory indicating the status of an output device. 
Output device A device which receives signals from a PLC. 
Output The signal sent from a PLC to an external device. 
Packet A unit of information transmitted across the network containing source and destination 

address information together with the actual data. 
Parity bit A bit transmitted with a packet of data indicating the type of parity check to be 

performed. 
Parity A type of validation check performed on transmitted information; data can be tested for 

either even, odd, none, mark or space parity. The type of parity check involved is 
indicated by the status of the parity bit. 

Path The location of a file including the drive, directory name plus any subdirectories and the 
file name together with its associated extension. 

Peripheral A device which aids system operation rather than being central to its functioning. 
Performance Monitor tool A CX-Server tool for monitoring communications throughput and for displaying 

CX-Server’s current performance level (i.e. a check to see if CX-Server is becoming 
overloaded). 

Ping test A standard Ethenet communications test. 
PLC Programmable Logic Controller. 
PLC Clock tool The PLC Clock Tool provides a facility to monitor and set the PLC clock and 

synchronise the PLC clock to the PC clock. 
PLC Error component This CX-Server component displays and manages PLC errors. 
PLC Memory component This CX-Server component allows the user to view, edit and monitor either channels 

(words) or individual bits in areas of the PLC. 
PLC Setup component This CX-Server component permits the configuration of PLC settings. 
Point A point is used to hold a value of a predefined type - Boolean, Integer, Text, etc. The 

contents of a point may be controlled by an object or I/O mechanism such as DDE. The 
contents of a point may control the action or appearance of an object, or be used for 
output via an I/O mechanism. 

Polling Interrogating a device to check its operational status or whether it is ready to send or 
receive data. 

Port A device connection point allowing data entry and exit. 
Program A set of instructions which are performed by a computer or PLC. 
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Program memory An area of PLC memory reserved for the storage of programs. 
Program mode PLC mode of operation during which the device can be programmed. 
Programmable Read Only Memory 

An area of memory which can be updated with programs and data only once after 
manufacture; once this area has been written to, it can only be read, not modified. 

Project OMRON configuration file inherited from the invoking application. 
 Refer also to CX-Server Project. 
PROM writer A device which writes the programs and data into PROM. 
PROM Programmable Read Only Memory. 
Protocol A set of rules governing the transmission of data. 
PSTN Public Switched Telephone Network. 
Public Switched Telephone Network 

A communications network carrying voice and data communications over switched 
lines. 

Rack The apparatus to which a unit is fixed. 
RAM Random Access Memory. 
Read mode PLC mode which allows data from the PLC to be read but not modified. 
Read/write mode PLC mode which allows data to be read from and written to the device. 
Refresh parameter table A table identifying the words in a Data Link to be refreshed for an individual PLC. 
Registered IO Table The internal PLC table: this is the one used by the PLC when running, regardless of the 

state of the actual hardware. It can be read and, for CV-series PLCs, written to by the 
CX-Server software.  

Relay network address The end network address which a PLC communicates. 
Relay node number The number of the network node through which a transmission must pass to reach 

another network. 
Relay table A table containing the relay network addresses, node numbers and end network 

addresses used within a FINS system. 
Remote network A network beyond the LAN to which access must be gained through a gateway or 

bridge. 
Remote Terminals Further units that can be supported by CX-Server via the Sysmac-Bus Master unit 
Reset Turning a bit or signal OFF or changing it to its set value or to zero. 
Root The highest level of a directory. 
Root group The highest level group in a CX-Server project. 
Rotary switch Indicates the method of calling a device by generating a series of pulses. 
Routing table A table containing the information necessary to allow communications between 

different networks including local and gateway network address details. 
Routing The direction of data across a network from its source to its destination. 
RS232 Industrial interface standard for serial communications. 
RS422 Industrial interface standard for serial communications employing balanced line 

circuits. 
RTs Remote Terminals. 
Run Mode PLC mode of operation during which device information is typically read-only. 
Serial Connection A direct connection between computer and PLC. 
Server application An application that can be used to view or interact with. 
 Refer also to DDE and OLE. 
Server 1. Server is used in DDE functions to contain a link to an outside application. Using 

DDE functions, CX-Server allows the manipulation of an outside application as 
specified as the Server. 
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  Refer also to Server application.  
 2. A Server is the central processing point of a Network which is accessible to all 

computers. Networks affect CX-Server in that further associated options are 
available if the computer Network is connected. 

Signed Decimal A data format supported by CX-Server. 
SIOU Special Input /Output Unit. 
Slave A device which receives data or instructions from a master device. 
Slots Free areas within a rack to which units can be fixed. 
Software switches Areas of memory employed by an SIO unit used to set operating parameters (similar in 

manner to a hardware switch). 
Space parity The parity bit is always set to 0. 
Special Input /Output Unit A unit designed for a specific purpose. 
SRM1 device type An OMRON PLC device supported by CX-Server. 
Step Area An area of PLC memory containing a flag indicating the status of steps used within a 

program. 
Stop bits Bits indicating the end of transmission of each set of data bits; normally one or two bits, 

they indicate the delay time between sending successive characters down the line. 
Symbol An address that has been given a name to make the address information more flexible. 

Symbols are inherited by CX-Server by the invoking application. 
SYSMAC LINK OMRON high speed industrial network (either co-axial or fibre optic). 
SYSMAC NET OMRON high speed optical LAN which can be of type C SYSMAC NET or CV 

SYSMAC NET. 
SYSMAC WAY OMRON network. 
System area An area of memory used for controlling and managing a unit. 
System configuration An arrangement of units, for example network, computers and PLCs. 
Tagged database A file format supported by the CX-Server Import tool. The Tagged database is also an 

export format of the CX-Server Import tool. 
TAPI Telephony Application Programming Interface. 
Target PLC The PLC to which information or instructions are directed. 
Taskbar An integral part of Microsoft Windows which allows Microsoft Windows based 

applications to be started. CX-Server tools are run from the Taskbar. 
TCP/IP Transmission Control Protocol/Internet Protocol. 
Temperature Controller An OMRON device. 
Temporary Relay Area An area of PLC memory containing instructions which can be loaded at a later point for 

use with other instructions. 
Text 1. A file format supported by the CX-Server Import tool. The Text is also an export 

format of the CX-Server Import tool.  
 2. A data format supported by CX-Server. 
Timer area An area of PLC memory containing program timers and their related completion flags. 
Toolbus A network, either C-Toolbus or CV-Toolbus, allowing communications with a device 

via the serial COM port of a personal computer (in a similar manner to SYSMAC 
WAY). Data is transmitted along the network in binary format. 

Tools CX-Server is made up of four tools. 
Topic The name of an aspect of a service application which identifies where a reference link is 

to be incorporated; for example, within Excel the topic would be the name of the 
worksheet to be used. 

Transceiver A device which can receive and transmit data. 
Transfer from PLC The transfer of a program or data to a host (either a computer or a programming device) 

from a lower-level (or slave) device. 
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Transfer to PLC The transfer of a program or data from a host (either a computer or a programming 
device) to a lower-level (or slave) device. 

Transition Area Contains flags indicating when a transition is ON or OFF 
Transmitter A device which sends out signals. 
UDP User Datagram Protocol. 
Unit number A number identifying an individual component of an OMRON PLC system 

configuration. 
Units A component of an OMRON PLC system configuration. 
Unknown The operating mode of a PLC that cannot be connected to. 
Upload See Transfer from PLC. 
User Datagram Protocol Protocol which directs information across a network to port numbers rather than to IP 

addresses. 
Word A 16 bit unit of data memory. 
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